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| ntroduction

Welcome ~ Welcometo IBM® Sterling Gentran: Server® Microsoft Windows Forms Integration
subsystem, an Electronic Data Interchange (EDI) form-generation software for the
Microsoft Windows operating system. Sterling Gentran: Server provides you with thetools
that you need to design forms to facilitate the keying and printing of EDI documents.
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What’sin this M anual

Introduction This manual provides step-by-step instructions to assist you in performing the various
tasks associated with the Forms Integration subsystem. This approach isintended to
answer any questions you may have about Forms Integration.

Intended audience  Thismanual isintended for the following users:

» Technical users— userswith adetailed knowledge of the Microsoft Windows
operating system, networking, databases, and communications.

» Novice-to-average experienced users—users who are new to Sterling Gentran: Server
for Microsoft Windows, EDI, or both.

» EDI Coordinators—usersresponsiblefor creating and maintaining the transfer of EDI
data between Trading Partners.

Prerequisite  The audience using this software should be familiar with:
knowledge »  PC and Microsoft® Microsoft Windows functions

» EDI concepts

» EDI standard structure

» theinternal application format

» datamapping concepts

» Sterling Gentran:Server product

Forms Integration User Guide Sterling Gentran:Server — May 2011



Description of Contents

Introduction The IBM® Serling Gentran: Server® Forms Integration User Guide contains the tasks
associated with using the Forms Integration subsystem.

Organization of  The IBM® Serling Gentran: Server® Forms Integration User Guide is organized into the
chapters  following chapters.

About This Guide explains the guide’s content and organization. This chapter also
introduces the online Help system and how to get technical support.

Forms Integration Basics, chapter 1, explains basic Form Integration terms and
concepts.

Designing Your Forms, chapter 2, explains how to perform basic Form Integration
functions, including: setting global display options, creating a new form; modifying
form components; working with groups, segments, composites, and elements; and
completing the form.

Modifying Form Components, chapter 3, describes how to modify form components,
including the EDI File Format, groups, segments, composites, and elements.

Completing Your Form, chapter 4, describes how to complete your form, which
includes compiling the translation object and printing a report.

Using Standard Rules, chapter 5, explains how to use the Sterling Gentran: Server
standard rules. This chapter also provides example scenarios of when to use certain
standard rules.

Using Extended Rules, chapter 6, defines what extended rules are, when they are
used, and the proprietary programming language syntax.

Customizing Screen Entry and Print Forms, chapter 7, describes how to customize
Screen Entry and Print Translation Object attributes. Topics include: Customizing
Field Labels, Hiding Field Labels, and Storing EDI Code Value Descriptions.

Formatting Screen Entry and Print Forms, chapter 7, explains how to format,
organize, and size translation object fields.

Error Messages, Appendix A, describes Compile and Sterling Gentran: Server error
messages and corrective actions.

User Exits, Appendix B, describes how to use extended rules to take advantage of
Sterling Gentran: Server user exit functionality.

Using the Translator Command Line Interface, Appendix C, describes how to use the
command line to invoke the services of the TXDE.EXE trandator to perform
trand ation outside Sterling Gentran: Server.

The Glossary describes Sterling Gentran: Server and Forms I ntegration terminology
and concepts.
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OnlineHelp

Introduction The majority of the Sterling Gentran:Server Forms Integration documentation found in
this manual is also contained in the online Help system. Thisincludes all dialog box
element definitions, detailed processing information, and how-to information.

Field-level Help  To view field-level descriptions for the Forms Integration subsystem, navigate to the
component for which you want field-level descriptions. Press F1 to display a parts and
functions table.

Forms Integration User Guide Sterling Gentran:Server — May 2011



How To Get Help

IBM® Sterling Customer Center provides awealth of online resources that are
available around the clock to enrich your business experience with IBM® Sterling
Gentran®. By using Sterling Customer Center, you gain access to many self-
support tools, including a Knowledge-Base, Documentation, Education, and Case
Management. Access this site at: Sterling Customer Center. (http://
customer.sterlingcommerce.com)

Oncelogged in, select Support Center from the top navigation menu, and then
locate Sterling Gentran product-specific support information from the left
navigation menu.

Additionally, our Customer Support Reference Guide outlines our support hours,
contact information, and key information that will enhance your support
experience with us. For detailed information about Customer Support, pleaserefer
to the Customer Support Reference Guide accessible from the login page. (http://
customer.sterlingcommerce.com)
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Introduction Form Integration Basics

| ntroduction

Inthischapter  Thischapter describes basic concepts and functionality associated with Forms Integration.
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Form Integration Basics

Introducing Forms I ntegration

I ntroduction

Introducing Forms Integration

The Sterling Gentran: Server Forms I ntegration subsystem enables you to design formsto
facilitate the keying (screen entry) and printing (print) of EDI documents that you receive
inbound or send outbound.

What isaform? A formisaset of instructions that you define in the Forms Integration subsystem to

indicate how the system should format data. When you compile the form, Sterling
Gentran: Server generates atranslation object. After you register the translation object with
Sterling Gentran: Server and associate the tranglation object with apartner relationship, the

system uses the translation object to format EDI documents.

Types of Forms

This table describes the two types of forms that you can create using Forms Integration.

Form

Description

Print translation object

Organizes and formats the printout of EDI documents
that are received from or sent to the trading partners for
which you have established atrading relationship
(inbound or outbound) that utilizes that print translation
object. The print translation object enables you to view
the EDI document in an easily readable format.

Screen entry trandation
object

Provides a standardized format for keying an EDI
document into the Document Editor, for translation and
transmission to your trading partners, for which you
have established an outbound trading relationship that
utilizes that screen entry translation object. The screen
entry tranglation object ensures that your users key all
the data necessary to create the required EDI document.

Forms Integration User Guide
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Forms Integration Subsystem

Forms | ntegration Subsystem

Form Integration Basics

Introduction The Forms Integration subsystem contains two windows: The EDI File Format Window
(Ieft side of the screen) and the Layout Window (right side of the screen).

When you click a segment or group in the EDI File Format Window, the corresponding
frame is displayed in the Layout Window. When you click an element in the EDI File
Format Window, the corresponding layout component is highlighted in the Layout

Window.

Main Window  Thisillustration shows the Forms Integration Subsystem Main Window.

2 Gentran Forms Integration - [petordp._stp]

1 F 3 *

=

¥ 051004 - C - String 10 -Printed
¥ 0B 1225 - C - String 3 -Printed-
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@ 0812258 DESC - C - Sting 30 -

FCIDTM - M - 1 DATE/TIME/PERID

L% 0507 - M - —

-

-

FCIIMD - C - 11TEM DESCRIPTION

FCIFTH - C- SFREE TEXT

) (MO0_RFF-C- 1

) 0200_NAD -C- 20

= -
I 5

-
ORDEER NUMEEER:

Payment Termzs Type
Termz Of Payment Id
Terms Cf Payment |:

SJection Identificat

For Help, presz F1

[

—

N

Partsand Function This table describes the Forms Integration Main Window parts and their functions.

Window

Description

Title Bar

Displays the title of the open form.

Main Menu Bar

Contains drop-down menus of Form
Integration commands.

Main Toolbar

Provides short-cut options to common
Form Integration components.

The EDI File Format Window (left side of
the Forms Integration subsystem main
window)

Contains the EDI file format.

Sterling Gentran:Server — May 2011
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Form Integration Basics

Forms Integration Subsystem

Window

Description

Title Bar

Displays the title of the open form.

Main Menu Bar

Contains drop-down menus of Form
Integration commands.

Main Toolbar

Provides short-cut options to common
Form Integration components.

The Layout Window (right side of the
Forms Integration subsystem main
window)

Contains the actual format of the
translation object.

EDI File Format Thisillustration shows the EDI File Format Window.

Window

= Gentran Forms Integration - [petordp.stp]
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| |
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Forms Integration Subsystem Form Integration Basics

EDI FileFormat  Thistable describes the parts of the EDI File Format window and their functions.
Window Parts and
Functions

Icon Description

= A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repesat is
exhausted.

Groups are defined by the EDI standards. A group that is subordinate
to another group is a subgroup (this corresponds to a nested looping
structure — aloop within aloop).

| A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times.

gy A compositeis a data element that contains two or more component
data elements or subelements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

A repeating compositeis arelated group of EDI subelements that
have the ability to loop as a whole (occur more than once) within a
particular EDI segment. To allow a composite to repeat multiple times
within a segment, each occurrence of the composite must be separated
by a specia delimiter, known as the repeating element delimiter.

Example

Your delimiters are set as follows:
Segment ~

Element *

Tag *

Sub Element

Repeating Ele »

Then, if aBGM segment contains a repeating composite that occurs 3
timeswithin the datafollowed by 1 regular element, and the composite
contains 2 subelements, the segment isin the following form:

BGW SubA- 1: SubB- 1" SubA- 2: SubB- 2" SubA- 3: SubB-
3*Fi el d2~

Sterling Gentran:Server — May 2011 Forms Integration User Guide
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(Contd)
Icon Description
] An element isthe smallest piece of information defined by the EDI

standards. An individual element can have different meanings
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments.

An element isthe EDI map component that is mapped (linked) to a
corresponding application field to move data to and from the EDI file.

A repeating element isan EDI elementswith the ability to loop (occur
more than once) within a particular EDI segment. To allow asingle
element to repeat multiple times within a segment, each element must
be separated by a special delimiter, known as the repeating element
delimiter. The use of this delimiter prevents the system from mistaking
the repeating elements for normal elements.

Example

Your delimiters are set as follows:
Segment ~

Element *

Tag *

Sub Element

Repeating Ele »

Then, if aBGM segment contains 3 elements and the second element is
arepeating element that occurs 4 times, the segment isin the following
form:

BGW Fi el d1*Fi el d2. 1"Fi el d2. 2"Fi el d2. 3"Fi el d2. 4*Fi el d3~

Forms Integration User Guide Sterling Gentran:Server — May 2011



Forms Integration Subsystem Form Integration Basics

Layout Window  Thisillustration shows the Layout Window.

& Gentran Forms Integration - [peteordp.stp]
% File Edit Functions Yiew Display Options ‘“window Help _Iﬁllﬁl

1= s = e el = = s e e =1 ==
1 2 =] + & 5 7 2 £] 10 1
! EDIFACT 92.1 Purchf;
| Pet Zone
|
Order Number: j: _
Order Type: I
|
| |
1 L
T
|
|
| -
4] | I
For Help, press F1 [ NOM [ s

Layout Window  Thistable describes the parts of the Layout window and their functions.

Parts and
Functions Part Function
Horizontal and Vertical Ruler Enables you to manipulate the length, width, and
alignment of your form.
Field Label Definesthe field in which a user enters
information.
Note
In the Layout Window

illustration, Order Number: is an
example of afield label.

Field Text box associated with afield label in which a
user can enter information. For print translation
objects, groups, repeating segments, and elements
are always formatted as fields.

Frame Used to format the EDI file for the trandlation
object. Each frame contains the groups, repesting
segments, and elements at that level (single
segments are not represented on the frame).

Alignment Lines Vertical or horizontal grid lines that enable you
align the components of the Layout Window.

Sterling Gentran:Server — May 2011 Forms Integration User Guide
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List formats  For screen entry translation objects, groups (with a maximum usage greater than one) and
repeating segments are formatted as lists. Elements are formatted as edit boxes (fields) or
lists on the frame. Elements are typically formatted as fields, but are formatted as alist if
you apply a standard rule that allows a selection of multiple items. Each group and
repeating segment also has a corresponding frame that contains all of the groups (with a
maximum usage greater than one), repeating segments, and elements at that level.

Forms Integration User Guide Sterling Gentran:Server — May 2011



Building a Form with Forms Integration Form Integration Basics

Building a Form with Forms I ntegration

Introduction This section defines how to proceed with building aform using the Sterling
Gentran: Server Forms Integration subsystem.

Sagesof building  Thistable describes the process to build a form using Forms I ntegration.
aform

Sage Description

1 Prepare and Analyze how you want your form to look and what
components your form will need.

Reference
See Preparation and Analysis on page 2 - 3 for more information.

2 Set Global Defaults (first time only).

Reference
See Global Default Preference Settings on page 2 - 6 for more
information.

3 Create, Save, and Name a New Form.

Reference
See the Creating a Form and Defining Form Details on page 2 - 23 for
more information.

4 Activate the Appropriate EDI Groups, Segments, and Elements.

Reference
Please see Activating Form Components on page 2 - 28 for more
information.

5 Define the Layout of the Form.

Reference

See Modifying an EDI File Format on page 3 - 3 for more information
on customizing your EDI file, including setting the EDI delimiters.

See Using Standard Rules, chapter 5, of this guide for more information.

See Using Extended Rules, chapter 6, of this guide for more information.

6 Compile the Trandation Object.

Reference

See Compiling a Trandlation Object on page 4 - 3 for more information
on compiling the trandlation object and translation object naming
conventions.
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Form Integration Basics Building a Form with Forms Integration

(Contd)
Sage Description

7 Print the Report.

Reference
See Printing a Report on page 4 - 6 for more information.

8 Register the Translation Object with Sterling Gentran: Server.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information about registering translation objects.

9 Create the Appropriate Trading Relationship.
Establish the appropriate trading relationship in Sterling Gentran: Server
for your trading partners.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information about creating trading relationships.

10 Validate the Trandation Object.

For a screen entry translation object, create a new document in
Document Editor, using that translation object. For a print translation
object, print the document. Verify that the output is correct.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information about creating a new document in the
Document Editor using that translation object.
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| ntroduction

Inthischapter  This chapter describes how to design your form.
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Getting Started
Preparation and Analysis

Introduction Before you begin to create aform, work with your trading partner to:
» determine necessary form fields and labels
» obtainalayout of how you want the completed form to look
» determine how your layout corresponds with the EDI standard you use
» determine the operations that you need perform to generate the required layout
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Setting Global Defaults
Overview

Introduction  This section describes Forms Integration Global default Preference and Date/Time
settings.

Preference  The Preferences dialog box is a property sheet that enables you to set global Form
Defaults  Integration defaults. This table describes the customizable global preference options that
you can define on the Preferences dialog box to control the look of your form display

Note
Form display options can be set or changed at any time.

Customizable Items Description

Tree settings (Global Enables you to display group, record, and field descriptions.

option)

You can also access:

» Colours(Global option) - Enables you to select foreground
and background colours to visually define form
components. The use of colour is optional.

» Fonts(Global option)- Enables you to globally change how
fontsdisplay. Thisincludesthetypeface, style, and size. The
default font that Sterling Gentran: Server usesis a Sans Serif
9 point.

Standard Formats Displaysthe default date to use when elements are read from the

Standards database.

Valid options are:
»  Six-character dates
» Eight-character dates.

Positional Defaults Defines default field formats.

Files Defines how Forms Integration works with files.

Layout Defines the look of the layout window.

Confirmations Controls when you receive a confirmation prompt.

Version Controls how and when the system increments aform’s version
number.
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Date/TimeFormat  The Default Date formats dialog box, available from the Options menu, enables you to
Control the default date and time formats that are used when elements are read from the
standards database.
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Global Default Preference Settings

Introduction Global defaults are defined on the Preferences dialog box. This section describes each tab
of that dialog box.

Preferencesdialog  Thisillustration describes the Tree tab of the Preferences dialog box.
box
(Treetab)

Preferences

Tree |Standard Folmatsl PositionalDefauItsI Files I Layoutl Confirmationsl Versionl

These zettings customize the look of the file format tree.

Colours. .. |

¥ Show record descriptions Fant...

V' Show field descriptions

Ok I Cancel Help

Partsand This table describes the parts and functions of the Tree tab on the Preferences dialog box.
Functions

Part Function

Descriptions check boxes Defines what form details that you want to display in
the file format tree.

Options are;

»  Show group descriptions
»  Show record descriptions
»  Show field descriptions

Colours Accesses the Colours dialog box, which enables you to
select foreground and background coloursto visually
define form items and/or attributes. The use of colour is
optional.
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Preferencesdialog
box
(Standard Formats
tab)

Partsand
Functions

Global Default Preference Settings

Part Function

Fonts Accesses the Fonts dial og box, which enables you to
globally change how fonts display. Customizable font
optionsinclude the typeface, style, and size. The default
font that Sterling Gentran:Server usesis a Sans Serif 9
point.

OK Saves changes; exits the dialog box.

Cancd Cancels changes; exits the dialog box.

Help Launches the Forms Integration online Help system.

This Thisillustration describes the Standard Formats tab of the Preferences dialog box.

Preferences

Tree  Standard Formats I PositionalDefaultsI Files I Layoutl Confirmationsl Versionl

These zettings control the default data formats used when elements are read from the

standards database.

Sis-character dates

Eight character dates

™ Always dizplay and print numerics uzing decimal pointz [ format)

IWMMDD 'l
IYYYYMMDD 'l

Cancel Help

This table describes the parts and functions of the Standard Format tab on the Preferences

dialog box.

Part

Function

Datelists

Controls the default date formats that are used when the
element is read from the Standards database.

Customizable items include:
» Six-character dates
» Eight-character dates

Forms Integration User Guide

Sterling Gentran:Server — May 2011



Global Default Preference Settings Designing Y our Form

Part Function

Always display and print Specifies that Sterling Gentran: Server should display

numerics using decimal and print all numeric-format elements using decimal

points check box points (formatted as real). This default dataformat is
used when elements are read from the standards
database.

OK Saves changes; exits the dialog box.

Cancd Cancels changes; exits the dialog box.

Help Launches the Forms Integration online Help system.

Preferencesdialog  Thisillustration describes the Positional Defaults tab of the Preferences dialog box.

box
(Positional Default ki
tab) Tiee I Standard Formats  Positional Defaults IFiIes I Layoutl Eonfirmationsl Versionl
Field Farmatting

Data Type IString 'l Pad Character ISF'

Alignment
’V ¢ Left ¢ Centre ¢ Right

Cancel Help

Parts and This table describes the parts and functions of the Positional Defaults tab on the
Functions  Preferencesdialog box.

Part Function

Field Formatting Data Type | Describes the default data type. Valid options are:

» String
» Number
» Dt/Tm
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Global Default Preference Settings

Part Function
Pad character Specifies whether you want characters padded by
default.
Alignment Specifies field formatting alignment. Valid options are:

» Left

» Centre
» Right
OK Saves changes; exits the dialog box.
Cancel Cancels changes; exits the dialog box.
Help Launches the Forms Integration online Help system.

Preferencesdialog  Thisillustration describes the Files tab of the Preferences diaog box.

box
(Filestab)

Preferences

Tree I Standand Folmatsl Positional Defaults  Files |La_l,l0ut| Eonfirmationsl Versionl

These settings contral how Gentran:Server - Farms Integration works with files.

v Backup Forms to BAK files before saving:

Wwihen browszing for Forms, start in this folder :

When compiling a Translation Object, start in this folder :

Ok I Cancel Help

Partsand  Thistable describesthe parts and functions of the Files tab on the Preferences dialog box.

Functions

Part

Function

Backup formsto .BAK files before saving | A selected check box indicates that you

want to create backup Forms Integration
files.

Forms Integration User Guide
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Preferencesdialog
box
(Layout tab)

Designing Y our Form

Part

Function

When browsing to Forms, start at this
folder

Specifies the path and folder where you
want the system to begin browsing for the
Forms Integration subsystem. The default
location is CA\GENSRVNT\Forms.

When compiling atranglation object, start
at this folder

Specifies the path and folder where you
want the system to start the trandation
object compilation process.

OK Saves changes; exits the dialog box.
Cancel Cancels changes; exits the dialog box.
Help Launches the Forms Integration online

Help system.

Tree I Standard Formatsl Poszitional Defaultsl Files

These zettings customize the look of the lapout window.

™ Laock labels ta figlds during selection and move operations

™ Show alignment grid

[&rid spacitg (5 Eirels

= | Sriap contrals toithe slignmert and

Thisillustration describes the Layout tab of the Preferences dialog box.

Layout | Eonfirmationsl Versionl

Cancel Help
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Parts and This table describes the parts and functions of the Layout tab on the Preferences dialog
Functions  box.

Part Function

Lock labelsto field during Groups the field label with the field in the Layout

selection and move Window.

operations check box

Show alignment grid Displays Layout Window grid lines for alignment
purposes.

Grid spacing in Pixels Defines default grid line spacing in Pixels.

Snap controlsto the Alignsafield label and field on the nearest alignment

alignment grid. grid setting.

OK Saves changes; exits the dialog box.

Cancel Cancels changes; exits the dialog box.

Help Launches the Forms Integration online Help system.

Preferencesdialog  Thisillustration describes the Confirmations tab of the Preferences dialog box.

box
. . Preferences
(Confirmations | | | |
T Standard F Positional Defaults | Fil L
tab) ee tandard Formats | Fositional Defaults | Files ayout ;|

These zettings allow you ta contral when Gentran: S erver - Forms Integration wil
prompt you to confirm an action.

W Confirmn everything

[Eatifitrm et

I | clelete At ahiest

¥ | delete amandaton ohisct

| | chianme aimand et ab eesbe e EariarE, o ey e
I | Grmiate e split St epE At (eEa o o e

¥ | chanae thekeyfield or & record

I¥ | chanae the famiat or datatpe ot & feld

¥ | chanae thekupe ot & eld's standard e

I | link chiects at diferert evels

¥ | change aconditionsl relatiorskin

I¥ | delete atobjest that contains inked chiects

I | delete At abiesthatis teed elewhers

I¥ | chanae a sinaletar araup’s pramete records b parent setting
J# | delete amadelist

I i ehiests Wit diterents masmumusages:

Ok I Cancel Help
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Parts and This table describes the parts and functions of the Confirmations tab on the Preferences
Functions  dialog box.

Part Function
Confirm everything Specifies that you want to receive a prompt to confirm
all actions.
Confirmwhen ... Specifies specific instances in which you want to

receive a prompt to confirm an action. Valid options are;
» Deletean object
» Delete amandatory object

» Change amandatory object to be conditional or
viceversa

» Promote or split arepeating record or group
» Changethe keyfield on arecord

» Changethe format or datatype of afield

» Changethetype of afield’'s standard rule

» Link objects at different levels

» Change aconditional relationship

» Delete an object that contains linked objects

Confirmwhen I... » Deletean object that is used elsewhere

(contd) » Changeasingle group’s promote record to parent
setting
» Deleteacodelist

» Link objectswith different maximum usages.

OK Saves changes; exits the dialog.
Cancel Cancels changes; exits the dialog.
Help Launches the Forms Integration online Help system.
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Global Default Preference Settings

Preferencesdialog  Thisillustration describes the Version tab of the Preferences dialog box.

box
(Vers-on tab) Preferences

Tiee I Standard Formatsl PositionalDefaultsI Files

“When should a form's versioh number be incremented ?

@ [Only when manually changed

= gk whether bo increment when saving a form
= gk whether bo increment when compiling a form
€ Always increment when saving a form

 Always increment when compiling a form

I Layout I Confirmations

0K I Cancel Help

Parts and This table describes the parts and functions of the Version tab on the Preferences dialog

Functions  box.

Part Function
When should aform’s Options are:
;’g?gegggger be » Only when manually changed - specifies that you

want the system to increment the form’s version
number when you manually make a change.

Ask whether to increment when saving aform -
specifies that, upon saving aform, you want the
system to display a prompt asking whether you
want the form’s version number to increment.

Ask whether to increment when compiling aform -
specifiesthat, upon compiling aform, you want the
system to display a prompt asking whether you
want the form'’s version number to increment.
Always increment when saving aform - specifies

that, upon saving aform, you want the system to
automatically increment the version number.

Forms Integration User Guide
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Part Function
When should aform’s » Alwaysincrement when compiling aform -
version number be specifiesthat, upon compiling aform, you want the
incremented? system to automatically increment the version
(contd) number.
OK Saves changes; exits the dialog box.
Cancd Cancels changes; exits the dialog box.
Help Launches the Forms Integration online Help system.
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Customizing Display, Colours and Fonts

Introduction This section describes how to customize global (for al forms) display options, colours,
and fonts.

How to customize  Usethis procedure to customize global display options.
global display
options Sep Action

1 Select Preferences from the Options menu.

System Response
The system displays the Tree tab of the Preferences dialog box.

2 By default, the options to show group record and field descriptions are
selected. Do you want to clear any of these options?

» Ifyes, click the check box associated with the option that you do not
want to display. Proceed to the next step.

» If no, proceed to the next step.

Note

Typicaly, you want to have all the descriptions displayed for reference.
However, depending on the size of your monitor, it may be easier to see
the entire form if the descriptions are not displayed.

You may want to experiment with shrinking the size of the font for the
form before you turn off the display of descriptions.

Reference
See How to customize global fonts on page 2 - 17 for more information.

3 Click OK to save changes and exit the Preferences dialog box.

How to customize  Usethis procedure to customize global colours.
global colours

Sep Action

1 Select Preferences from the Options menu.

System Response
The system displays the Tree tab of the Preferences dialog box.
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Designing Y our Form

(Contd)
Sep

Action

2

Click Coloursto display the Colours dialog box.

Colours

Hecorda’Segmer
Composzite LI e

Attributes

Active, Canditional
Active, Mandatory
Inactive, Conditional
Inactive, Mandatory

- Sample Text -

Fareground colaur

Backimund colour

E|
En

Select the form component type from the Item list (Group, Record/

Segment, Composite, Field/Element).

Do you want to further define the form component type?

» If yes, choose whether the form component

conditiona or mandatory from the Attributeslist. Valid selections are:

— Active, Conditional
— Active, Mandatory
— Inactive, Conditional
— Inactive, Mandatory

» If no, proceed to the next step.

is active or inactive and

Repeat Step 3 and Sep 4 for each combination of Items and Attributesfor

which you want to define colours.

Click OK to globally define the selected colours for all forms.

Click OK to save changes and to exit the Preferences dialog box.
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How to customize  Usethis procedure to customize global fonts.
global fonts

Sep Action

1 Select Preferences from the Options menu.

System Response
The system displays the Tree tab of the Preferences dialog box.

2 Click Font to display the Font dialog box.
Font EHE
Faont gtyle: Size:
IHegulal ] QK. I
' 8 -
Italc B 10 I |
Bold 12
Buld Italic 14
18
24
Y
—Sample
I AaBbyysz
Script:
IWestern LI
3 Select the type of font from the Font list. The default is M S Sans Serif.
4 Select the style from the Font Style list. The default is Regular.
5 Select the point size from the Size list. The default is 9.
6 You can preview the changes to the font in the Sample box. Click OK to

make the global font changeto all forms.

7 Click OK to save changes and exit the Preferences dialog box.
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Customizing Display of EDI File Format and L ayout
Windows

Introduction  Sterling Gentran:Server enables you to choose how you want the EDI File Format and
Layout Windows to display. These options, which are accessible from the View menu of
the Main Menu bar, include:

» Maximize Tree - maximizes the EDI File Format Window.
» Maximize Layout - maximizes the Layout Window.

» Rearrangetogglesthe display of the EDI File Format Window and the Layout
Window from left/right to above/bel ow.

Additionally, Sterling Gentran: Server enables you to customize the measurement system
that the vertical and horizontal rulersin the Layout Window use. The default measurement
system isinches, but you can toggle the display to centimeters by double-clicking the
yellow sguare where the vertical and horizontal rulers meet.
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Working With the Default Date Format

Working With the Default Date For mat

I ntroduction

Setting a default
date format

Adding,
rearranging, or
deleting date
formats

How to set the
default Date/Time
format

Forms Integration User Guide

This section describes how to set, rearrange, add, or delete a date format.

You typically establish the date format for all date elements one time only. This default
date format is used when EDI documents areinitially loaded from the standard. The
format can be overridden on the validation tab of the Element Properties dialog box.

Note

This global option changes the default date format for all new forms. The format of the
existing date elements does not change.

The Date/Time Format dialog box lists valid date formats. Using that dialog box, you can
add, delete date formats, or rearrange the order in which date formats appear in the six-
and eight-character date listsin the Standards Format tab of the Preferences dialog box.

Use this procedure to establish the default Date/Time format.

Sep Action
1 Select Preferences from the Options menu.
System Response
The system displays the Tree tab of the Preferences dialog box.
2 Click the Sandard Formats tab.
3 Do you want to accept the default date formats for Six- and Eight-

character dates?

» Ifyes, click OK to save your changes and to exit the Preferences
dialog box.

» If no, select the appropriate date formats from the Six-character dates
and Eight-character dateslists. Click OK to save your changes and to
exit the Preferences dialog box.
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How torearrange  Usethisprocedure to rearrange the order of Date/Time formats that appear in the Six- and
order of Date/Time Eight-character date lists on the Standard Format tab of the Preferences dialog box.
formats

Sep Action

1 Select Date For mats from the Options menu.

System Response
The system displays the Date/Time Formats dialog box.

2 Select the Date/Time format that you want to move up or move down in
the list order.

3 Use thistable to determine your next step.

4 | F you want to move THEN...
thedateformat....
Up Press Up until the date format isin the desired

list position. Proceed to the next step.

Down Press Down until the date format isin the
desired list position. Proceed to the next step.

5 Click OK to save your changes and to exit the dialog box.

How to add Use this procedure to add a new Date/Time format to the Six- or Eight-character date lists
anew  onthe Standard Format tab of the Preferences dialog box.

Date/Time

format

Sep Action

1 Select Date Formats from the Options menu.

System Response
The system displays the Date/Time Formats dialog box.

2 Click New.

3 In the Name box, enter the name of the new date format that you want to
create.

4 In the Picture box, enter how you want the date format to display.

5 Click OK to save your changes and to exit the Date/Time Formats dialog
box.

Sterling Gentran:Server — May 2011 Forms Integration User Guide



Designing Y our Form

Working With the Default Date Format

Howtodeletea  Usethisprocedureto delete anew Date/Time format from the Six- or Eight-character date
date/time format lists on the Standard Format tab of the Preferences dialog box.

Step

Action

1

Select Date For mats from the Options menu.

System Response
The system displays the Date/Time Formats dial og box.

Select the Date/Time format that you want to delete.

Press Delete.

System Response

The system displays awarning dialog that specifies that you must
manually correct formats for fields that use that date format that you want
to delete.

Gentran Forms Integration B2

WARMNIMG : IF pou delete a date format pou will hawve to manually correct the formats of
any fields wahich uzed it

Are you sure you want bo delete this date format ?

If pou select YES, you can recover it by choosing CAMCEL from the D ate Format list.

Verify that you want to delete the date/time format, and click Yes.

System Response
You return to the Date/Time Format dialog box.

Note
To recover the Date/Time format that you just deleted, click the Cancel
button on the Date/Time Format dialog box.

Click OK to save your changes and to exit the Date/Time Formats dialog
box.

Forms Integration User Guide
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Creating aNew Form
Overview

Introduction  You can create two different types of forms:
» Screen Entry - for keying documents in Document Editor
» Print - for printing documents

Defining  After you create anew form, it isimportant to define and save the form details. Form
Form Components  componentsinclude the standard, version, transaction set (document) selected, groups,
segments, composites, and elements that your company requires. The specific form
components that you use depend on the type of form that you create.

After you select your form components, Sterling Gentran:Server generates an EDI file
format for you.

Recommendation
We recommend that you determine which form components you are using before
generating or defining an EDI file format.
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Creating a Form and Defining Form Details

I ntroduction This section describes how to create a new form and define form details.

How tocreatea  Usethisprocedure to create a new form.
new form

Sep Action

1 Select New from the File menu.

System Response
The system displays the New Form Wizard dialog.

Mew Form Wizard

What kind of form are you creating 7
| =
What iz the name of the form 7
|
What iz pour name 7
IYourUserID
< Blach Cancel I Help |
2 From the What kind of Form are you creating list, select the type of form.
Valid values are “ Screen entry” or “Print.”
3 Enter the name of the form in the What is the name of the form box.

Recommendation

We recommend that you use the following identifying characteristics: the
partner that this form is used for, the standard, the version, the type of
transaction this form uses, and the type of form.

Example

For example, “MWT X 3030 850 Print” isthe description of aprint
translation object used to print documents for partner MWT, for an ANSI
X.12 version 003030 Purchase Order (850).

4 Verify that the system displays your User ID in the What is your name box.

5 Click Next.
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(Contd)
Sep

Action

6

In the How would you like to define the data format section, use the
following table to determine your next step.

IF... THEN...

If you want to create anew dataformat | Proceed to Sep 7.
using Delimited, Positional, or ClI
syntax,

If you want to load the data format Proceed to Step 22.
from a previoudly saved file definition,

Click the Create a new data format using this syntax radio button.

From the list, select a syntax option.

Use this table to determine your next step.

| F the syntax you selected is... THEN...

Delimited EDI Proceed to the next step.

Cll Proceed to the next step.

Positional Click Next. Click Finish to begin
editing your form.
You have completed this procedure.

10

Click Customize.

System Response
The system displays the Wizard for the syntax that you selected.

11

Click Next.

12

Select the ODBC data source that you want to use from thelist. The defaultis
Sterling Gentran Standards.

13

Click Next.

14

Select the standards agency that you want to use from the list.

15

Select the version of the standard from the Version list. The versions that are
available depend on which standard you selected.

Sterling Gentran:Server — May 2011
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(Contd)
Sep

Action

16

Select the transaction set (document or message) from the Transaction list.
The transactionsthat are available depend on which standard and version you
selected.

Note

For TRADACOMS only, select the release number of the version that you
are using from the Release list. The releases that are available depend on
which standard, version, and transaction you selected.

17

Click Next.

18

Areyou using Cll syntax?
» If yes, select aMulti-Detail Header option.
» If no, proceed to the next step.

19

Click Finish to load the transaction set.

System Response
You return to the New Form Wizard.

20

Click Next.

21

Click Finish to begin editing your form.

You have completed this procedure.

22

Click the Load the data format from a saved definition radio button.

23

Type the path and file name that you want to load or click Browse.

System Response
The system displays the Open File Definition dialog.

24

The Look inlist should reflect the drive\folder where Sterling Gentran: Server
Forms Integration isinstalled. The default is GentranNT\Bin. If the current
folder is not the correct one, select the appropriate folder.

25

Select the type of file that you want to display from the Files of typelist. The
default file extension is.IFD or .DDF.

26

Select the file definition that you want to load into the system from the list.
Double-click the filename or click Open to load the selected file format
definition.

System Response
You return to the New Form Wizard.

27

Click Next.

Forms Integration User Guide
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(Contd)
Sep

Action

28

Click Finish.

System response
The system finishes your form and displays the EDI file format in the
Sterling Gentran: Server - Forms Integration Window.

How to define  Usethis procedure to define form details.

form details

Step

Action

Open the form.

Click Details from the Edit menu.

System Response
The system displays the Translation Object Details dialog box.

Do you want to designate thisform as a system translation object (one that
isused internally by the system)?

» If yes, under the Flags section, click the System check box. Proceed
to the next step.

WARNING

Be certain that you want to define this translation object as a system
translation object. Once atranslation object is registered with Sterling
Gentran:Server, it cannot be deleted.

» If no, proceed to the next step.

Do you want to designate a version number for this translation object?

» If yes, under Version Control, enter the version number in the Maor
box and the rel ease number in the Minor box. Proceed to the next
step.

» If no, proceed to the next step.
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(Contd)
Sep Action
5 The Input and Output boxes (Agency, Version, Transaction, Release, and F
Group) contain the EDI format. Do you want to change the information in
these boxes?
» If yes, make the desired changes, and proceed to the next step.
Note
You can change the information in these boxes, but it will not alter the
content of the form. You may wish to alter these boxes if, for
example, you want the form to reflect a standards version that is not
loaded on your system. You can change the version on this dialog box,
and then alter the form to be compliant with that version.
» If no, proceed to the next step.
6 Click OK.
System Response
The system displays the Save As dialog box.
Recommendation
We recommend that you store forms in the translation object folder where
Sterling Gentran:Server isinstalled.
7 Type the name of the form (one to eight characters) in the File name box.
The default file extension is .STP.
8 Click Saveto savethe form.

Forms Integration User Guide
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Activating Form Components

I ntroduction

Activating
componentsfor
trandation

Procedure

When Sterling Gentran: Server generates the form, the system includes all the groups,
segments, composites, and elements that are defined by the standard agency for the
version of the document you selected. The system activates al the groups, segments,
composites, and elements that are defined as “mandatory” (must be present) by the
standard. The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

When tranglating data, the system does not process groups, segments, composites, and
elements that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in the form.

Use this procedure to activate groups, segments, composites, and elements.

Sep Action
1 Click the Activate icon on the Main Toolbar.
2 Double-click to open each group that contains groups or segments that

you want to activate.

Note

Asan alternative to opening each form component (Steps 2, 5, and 7), you
can select Expand All from the View menu to open every form
component. You can also select aform component and select Expand
Branch from the View menu to open that form component.

3 Click each inactive group that you want to activate.

Note

If you activate a group, segment, composite, or element by mistake, click
the item with the right mouse button to access the shortcut menu. Select
Deactivate from the shortcut menu.

4 Click each inactive segment that you want to activate.

5 Double-click to open each segment that contains composites or elements
that you want to activate.

6 Click each inactive composite that you want to activate.
7 Double-click to open each composite that contains elements that you want
to activate.
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(Contd)
Sep Action

8 Click each inactive element that you want to activate.

Note

When you activate an element for a print translation object, the word
“Printed” displays before that element’s name. When you activate an
element for a screen entry translation object, the words “ Edit Box” or
“Drop Down” display before that element’s name. “Edit Box” indicates
that the element is formatted as afield. “Drop Down” indicates that the
element isformatted as a list because you applied a standard rule that
alows a selection of multiple items.

9 Verify that all groups, segments, and composites and elements that you
need are activated.

10 Click the Activate icon on the Main Toolbar to turn activation mode off.
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Introduction Modifying Form Components

| ntroduction

Inthischapter  This chapter describes how to modify form components.
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Working with the EDI File Format
Modifying an EDI File Format

Introduction You can modify the system-generated EDI file format by modifying the modifying form
component properties and by using the promote, split, copy, cut, and paste functions.

Reference
See Creating a Form and Defining Form Details on page 2 - 23 for more information.

Defining an EDI If you want to use a specialized version of an EDI standard that is not available in the
file format Sterling Gentran Standards database, it may be appropriate for you to define the EDI file
format yourself.
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Promoting Groups and Repeating Segments

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment. It
also sets the promote flag and places the active elementsin the parent frame.

Note
The Promote function is only availableif agroup or repeating segment is selected.

Promotevs. Copy  You can use the Copy and Paste functions (and change the number in the maximum usage
and Paste  box) to accomplish the same task. However, Promote is a specialized function that
guarantees the integrity of your EDI structure.

Related topics  See Splitting Groups and Repeating Segments on page 3 - 5 for more information and
Using Cut, Copy, and Paste on page 3 - 6 for more information.

Procedure  Usethis procedure to promote a group or repeating segment.

Sep Action
1 Highlight the group or repeating segment from which you want to extract
one iteration.
2 Click the Promote icon the Main Toolbar. This extracts one iteration
(instance) of the looping structure.
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Splitting Groups and Repeating Segments

Splitting Groups and Repeating Segments

I ntroduction

When to use

Split vs. Copy and
Paste

Procedure

The Split function enables you to break a group or repeating segment into two loops.

You typically use this function when you need more than one instance of the same form
component that still occurs multiple times. You can also use the Split function to split one
instance of a group without setting the promote flag (the Split function never setsthe

promote flag).

Note

The Split function is only available if a group or repeating segment is selected.

You can use the Copy and Paste functions (and change the number in the maximum usage
box) to accomplish the same task. However, Split is a specialized function that guarantees
the integrity of your EDI structure.

Use this procedure to split a group or repeating segment.

Sep Action

1 Highlight the group or repeating segment from which you want to extract
oneiteration.

2 Click the Split icon on the Main Toolbar.
System Response
The system displays the Split dialog box.

Split
Firzt Loop Entries ID
Cancel |

3 In the First Loop Entries box, type the number that indicates the sequential
number of iterations where you want the group or repeating segment split.
Note
The number you enter in the First Loop Entries box must be greater than
zero and less than the maximum number of iterations of the loop.
Example
For example, if the X loop repeats a maximum number of 5 times, and you
type“2" inthe First Loop Entries box, the resulting split generates one X
loop that repeats a maximum of 2 times and asecond X loop that repeats a
maximum of 3 times.

4 Click OK to exit the Split dialog box.

Forms Integration User Guide
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Modifying Form Components

Using Cut, Copy, and Paste

Introduction The Copy, Cut, and Paste functions are typically used to move EDI information in the
form. You can cut or copy a single form component (loop, segment, composite, element,
record, or field) and paste it in another location in the form. Copied form components
retain al the information of the original form component. If the copied form component
contains subordinate form components (like a segment contains subordinate el ements), the
subordinate form components are al so copied. You can aso cut, copy, and paste aform
component from one form to another.

Whentouse  Youmay need to use Cut, Copy, or Pasteif you are using an EDI standard differently, or if
you heed to create nested looping structures.

Procedure  Usethis procedure to cut, copy, and paste a form component.

Step

Action

1

Select the form component or text that you want to cut or copy.

Click the Cut or Copy icon on the Main Toolbar.

Areyou are pasting the form component or text into another form?
» If yes, openthat form, if it isnot already open.
» If no, proceed to the next step.

Position the cursor where you want the cut or copied sel ection pasted
after.

Click Paste on the Main Toolbar to paste the contents of the Clipboard.

Are you pasting aform component?
» If yes, proceed to the next step.
» If no, you have completed this procedure.

Is the form component part of a group?

» If yes, Sterling Gentran:Server prompts you to specify whether you
want the contents of the Clipboard pasted as a child (subordinate) of
the group or pasted at the same level as the group. Select the
appropriate option, and click OK.

» If no, you have completed this procedure.
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Verifying EDI Delimiters

I ntroduction

What isa
Delimiter ?

Procedure

If you are using an EDI standard that contains composite elements or sub-elements, you
must verify that Sterling Gentran: Server is specifying the correct delimiters.

Delimiters are flags that you define to the system as separating specific EDI components.
Delimiters are necessary for all variable field-length standards, because the dataiis
compressed (and the leading zeroes and trailing blanks are removed). Sincethefields vary
in length, the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

Recommendation

Although verifying EDI delimitersin Sterling Gentran:Server is mandatory only if you are
using a standard with composite elements or sub-elements, we recommend that perform
this task regardless of which standard you use.

Use this procedure to verify EDI delimiters.

Sep Action

1 Click the EDI fileicon with the right mouse button.

System Response
The system displays the shortcut menu.

2 Select Properties from the shortcut menu.

System Response
The system displays the File Format Properties dialog box.

3 Click the Delimiter s tab.

System Response
The system displays the Delimiters tab of File Format Properties dialog
box.

4 Do the required delimiters for the EDI standard you are using differ from
the default Delimiter tab settings?

» If yes, typeeither the character or the hexadecimal valuein the correct
box. Proceed to the next step.

» If no, proceed to the next step.

5 Click OK to exit the File Format Properties dialog box.
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Saving a File Definition

Introduction Sterling Gentran: Server enablesyou to save an individual file format definition so that you
can use it asaguide in future forms. This provides you with a quick way to build aform.

Procedure  Usethis procedure to save an individual file format definition.

Sep Action
1 Open the form.
2 Right-click the EDI fileicon.

System Response
The system displays the shortcut menu.

3 Select Save File Definition As from the shortcut menu.

System Response
The system displays the Save File Definition dialog box.

Save File Definition

Save in: Ia Bin

File name: |E921_DHD.IFD

Save as lpe: IFiIe Drefinitions [* IFD) j Cancel |

The Savein list should reflect the drive\folder where Sterling
Gentran:Server isinstaled. The default is GENSRVNT.

4 If the current folder is not the correct one, select the appropriate folder.

5 Select the file definition from the list or type the name of thefile definition
in the File name box. The default file extension is.IFD or .DDF.

6 Click Save to save the file definition.
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Creating a Group

Working with Groups

Creating a Group

Introduction A group contains related segments and/or groups that repeat in sequence until either the
data ends or the maximum number of times that the [oop is allowed to repeat is exhausted.
If you create a group that is subordinate to another group, this corresponds to a nested
looping structure (aloop within aloop).

Procedure  Usethis procedure to create a group.

Sep Action
1 Use this table to determine your next step.
| F you want to... THEN...
Createagroupthatis |» highlight the form component and select
at the same level asa Insert from the Edit menu. Select Group
selected form from the cascading menu.
component, System Response
The system displays the Group Properties
dialog box with the Name tab showing.
» Proceed to the next step.
Createagroup thatis |» highlight the form component and select
subordinate to a Create Sub from the Edit menu. Select
selected form Group from the cascading menu.
component, System Response
The system displays the Group Properties
dialog box with the Name tab showing.
» Proceed to the next step.
2 In thefirst box on the Name tab, type the group name.
Note
Do not use spaces or dashes (-) in the Name box. You can use the
underscore (_) to separate words.
3 In the second box on the Name tab, type the loop description. This box is

used to provide a brief explanation of the loop.

Forms Integration User Guide
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Modifying Form Components

(Contd)
Sep

Action

4

Use this table to determine your next step.

IF thisformisa... THEN...

Screen entry form, click the Display tab to access display options.
Proceed to the next step.
Reference

See Customizing Screen Entry and Print Forms,
chapter 7 in this guide, for more information
about display options.

Print form, click the Print tab to access print options.
Proceed to the next step.

Reference

See Customizing Screen Entry and Print Forms,
chapter 7 in this guide, for more information
about print options.

Click the L ooping tab to access looping options.

In the Min Usage box, type the minimum number of times the loop must
be repeated.

Note
Mop, the minimum usage should be“1” or greater.

In the Max Usage box, type the maximum number of timesthe loop can be
repeated.

Click the L oop Extended Rulestab only if you want to specify an
extended rule for this group.

Reference
See the Using Extended Rules, chapter 6 in this guide, for more
information.

Click OK to create the group.

Related Topic  See the Modifying Group Properties on page 3 - 11 section in the this chapter for
information on modifying group properties.
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Modifying Group Properties

Introduction A group contains related segments and/or groups that repeat in sequence until either the
group data ends or the maximum number of times that the loop is allowed to repeat is
exhausted. If you create agroup that is subordinate to another group, this correspondsto a
nested |ooping structure (aloop within aloop).

Procedure  Usethis procedure to modify the properties of a group.

Sep Action

1 Right-click the group you want to modify, and select Properties from the
shortcut menu.

System Response
The system displays the Group Properties dialog box.
Group Properties
M arne I Displa_l,ll Loopingl Loop Extended Hulesl

Flease enter the name of this field :
|22DD_LIN

Fleaze enter a short description of this field :

Cancel Lol Help
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(Contd)
Sep Action
2 Use this table to determine your next step.
I F you want to THEN...
modify the...
group name, type the group name in the first box on the
Name tab. Proceed to the next step.
Note
Do not use spaces or dashes (-) in the Name box.
You can use the underscore 0" to separate
words.
Note
If agroup occurs more than onceinaformitis
identified by its name <ID>. The second and
subsequent occurrences are identified by
<ID>:n, where “n” isthe number of the
occurrence in the form.
group description, type the new description in the second box on
the Name tab. Thisbox is used to provide abrief
explanation of the loop. Proceed to the next step.
3 Use this table to determine your next step.
IFthisisa... AND you want to... THEN...
Screen entry form, change display click the Display tab.
options,
Reference
See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about
display options.
Print form, print options, click the Print tab.
Reference
See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about
print options.
4 Click the L ooping tab to access looping options.
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(Contd)
Sep

Action

5

In the Min Usage box, type the minimum number of times the loop must
be repeated.

Note
For a conditional loop, the minimum usage should always be “0” (zero).
For a mandatory loop, the minimum usage should be “1” or greater.

In the Max Usage box, type the maximum number of times the loop can
be repeated.

Do you want to specify an extended rule for this group?

» Ifyes, click the Loop Extended Rulestab. Define the minimum and
maximum usage. Proceed to the next step.

» If no, proceed to the next step.

Reference
See Using Extended Rules, chapter 6 in this guide, for more information.

Click OK to save the changes to the group.

Forms Integration User Guide
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Working with Segments
M odifying Segment Properties

Introduction You can modify the properties of any segment, including the minimum and maximum
number of times the segment can repeat, whether the segment is mandatory or conditional,
and whether it is aloop start or loop end segment.

Reference
See Using the LS and LE Segments on page 3 - 18 for more information.

Procedure  Use this procedure to modify the properties of a segment.

Sep Action

1 Right-click the segment you want to modify, and select Properties from
the shortcut menu.

System Response
The system displays the Segment Properties dialog box.

Segment Properties 1]

Hame |Spec:ia|| Kep Fieldl PFrint I Loopingl

Please enter the name of this figld :
IB EG

Fleaze enter a short description of thiz field :

BEGIMMIMG SEGMEMT FOR PLURCHASE ORDER

Cancel I e[ | Help
2 Do you want to modify the name of the segment?
» If yes, type the segment name in the first box on the Name tab.
Proceed to the next step.
Note

If a segment occurs more than oncein aform it isidentified by its
name <ID>. The second and subsequent occurrences are identified by
<ID>:n, where “n” isthe number of the occurrence in the form.

» If no, proceed to the next step.
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(Contd)
Sep Action

3 Do you want to modify the description of the segment?

» If yes, type anew description in the second box on the Name tab.
Proceed to the next step.

Note
Thisbox is used to provide a brief explanation of the segment that
allowsyou to differentiate it from similar segments.

» If no, proceed to the next step.

4 Do you want to flag this segment as containing the binary data?
» If yes, click the Special tab. Proceed to the next step.
» If no, proceed to the next step.

Note

If you select “Binary,” you must define an element of data-type “Bin
Length” and another element of data-type “Bin Data.” The “Bin Length”
element must precede the “Bin Data’ element.

Reference
See Modifying Element Properties on page 3 - 46 for more information
about defining an element data-type.

5 Do you want to use akey field?

Note

The key field function enables you to specify a second qualification in
selecting a segment (the segment name is the first qualification). Data
must be provided in the order designated through the use of key fields.

» Ifyes, click the Key Field tab. Proceed to the next step.
» If no, proceed to the next step.
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(Contd)
Sep

Action

6

Use this table to determine your next step.

IF thisisa...

AND you want to...

THEN...

screen entry form,

you want to change
display options,

click the Display tab.

Reference

See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about

display options.

print form,

change print options,

click the Print tab.

Reference

See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about
print options.

Isthis segment is alooping structure?

» If yes, click the Looping tab. Proceed to the next step.

» If no, accept the defaults. Proceed to the next step.

In the Min Usage box, type the minimum amount of times the segment

must repeat.

Note

If the Min Usage box containsa“0” (zero), the segment is “conditional .”
If the Min Usage box containsa“1” or greater, the segment is

“mandatory.”

Do you want the segment to repeat (loop)?

» If yes, type the maximum amount of timesit can repeat in the Max
Usage box. Proceed to the next step.

» If no, proceed to the next step.
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(Contd)
Sep Action
10 Do you want to indicate that the segment is the beginning of aloop (Loop
Start) or the end of aloop (Loop End)?
» If yes, select the appropriate options.
» If no, accept the default of Normal for the Normal/Loop Start/Loop
End options. These options are defined as follows:
— Normal - This segment isin the loop but is not the beginning or
ending segment.
— Loop Start - This segment marks the beginning of the loop.
— Loop End - This segment marks the end of the loop.
11 Do you want to specify an extended rule for this group?
» Ifyes, click the Loop Extended Rulestab.
» If no, proceed to the next step.
Reference
See Defining a Form Component Extended Rule on page 6 - 11 for more
information.
12 Click OK to save the changes to the segment.

Forms Integration User Guide
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Using the LS and LE Segments

Introduction  Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LSand LE
segments specify the explicit start and end of loops.

How todefinea  Usethis procedure to define an LS segment for aform.
Loop Start

Sep Action

1 Right-click the L S segment to access the shortcut menu. Select
Properties from the shortcut menu.

System Response
The system displays the Segment Properties dialog box (Name tab).
M ame ISpeciaIl Key FieIdI Frint I Loopingl

Please enter the name :
ILS

Fleaze enter a short description :
LOOP HEADER

Cancel | Lol I Help
2 Click the L ooping tab to access the loop options.
3 Verify that the Loop Start option on the Looping tab is selected.
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(Contd)
Sep

Action

4

Click the Key Field tab to access the key field options.

Segment Properties

M ame I Special  Key Field | Displayl Loopingl

Fieldl | =l

[ atehitg rules

7 e constant I vl Edlit,.. |
L e I VI Bl |

= ifatchirecarditen keyidaes ret rmatst

Cancel | Lol I Help |

From the Field list, select the L oop I dentifier Code.

Note
Thislist contains all the elements that are contained in the segment.

Thislist gives you the ability to define the Loop Start segment definition,
by specifying that the loop identifier code must have the value you specify
in the Matching rules section.

The Matching Rules section enables you to access all the literal constants
and code lists currently defined for this form. Click the Use constant
option.

Forms Integration User Guide
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(Contd)
Sep Action
7 Click Edit (at the right of the Use constant list) to access the Map
Constants dialog box.
Inanslatinn (Whpret Lonszlanls
Io Ty Waie
Closst
8 Click New to access the Edit Constant dialog box.
Lol U'oryslanl
9 Inthe ID box, type the literal constant identifier.
10 From the Type list, select Sring. Thisisthe category of thisliteral
constant.
11 In the Vaue box, type the value of the literal constant.
For a screen entry form, thisisthe loop identifier code that you expect to
receive from your trading partner.
12 Click OK to add the constant to the system.
13 Select the constant you created from the list. The system matches the
selected constant against the loop identifier code.
14 Click OK to exit the Segment Properties dialog box.
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Using the LS and LE Segments

How todefinea  Usethis procedure to define an LE segment for aform.

Loop End

Step

Action

Right-click the L E segment to access the shortcut menu. Select
Properties from the shortcut menu.

System Response
The system displays the Segment Properties dialog box (Name tab).

Segment Properties E

Marne |Special| Key Fieldl Displayl Loopingl

Flease enter the name of this field :
ILE

Pleaze enter a short description of this field :
LOOP TRAILER

Cancel | Lpply | Help

Click the L ooping tab to access the loop options.

Verify that the L oop End option on the Looping tab is selected.

Click the Key Field tab to access the key field options.

Segment Properties

Mame I Special  Fey Field I Displa_l,ll Loopingl

Fieldl | =l

&tk e

1 se constart I vl Edif... |
) e codelist I vl Edit... |

= Wateh record when key does notmateh

Cancel Sl Help
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(Contd)
Sep Action

5 From the Field list, select the Loop Identifier Code. Thislist containsall
the elements that are contained in the segment.

Thislist gives you the ability to define the Loop Start segment definition,
by specifying that the loop identifier code must have the value you specify
in the Matching rules section.

6 The Matching Rules section enables you to access all the literal constants
and code lists currently defined for this form. Select the constant you
created for the LS segment from the Use Constant list. The system
matches the selected constant against the loop identifier code.

7 Click OK to exit the Segment Properties dialog box.
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Modifying Composite Properties

Working with Composites

Modifying Composite Properties

Introduction A compositeis a data element that contains two or more component data elements or
subelements. You can modify the composite name and description, and whether or not it is

mandatory.

Procedure  Usethis procedure to modify composite properties.

Step

Action

Right-click the composite you want to modify, and select Propertiesfrom
the shortcut menu.

System Response
The system displays the Composite Properties dialog box

Composite Properties E

Name | Validation |

Please enter the name of this field :
|c002

Pleaze enter a short description of this field :

Cancel | Lopni Help

Do you want to change the composite name?

» If yes, typethe data element identification number in the first box on
the Name tab. Proceed to the next step.

» If no, proceed to the next step.

Note

If acomposite occurs more than once in aform it isidentified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where “n” is the number of the occurrence in the form.
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(Contd)
Sep

Action

3

Do you want to change the composite description?

» If yes, typethe new description in the second box on the Name tab.
Proceed to the next step.

» If no, proceed to the next step.

Do you want to specify the composite as mandatory?

» Ifyes, click the Validation tab. Select the check box on the Validation
tab. Proceed to the next step.

» If no, proceed to the next step.

Click OK to save the changes to the composite.
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Working with Elements
Overview

Introduction ~ When you define or modify an element, you must specify the type and format. Available
element format options depend on which element type you select (string, number, or Date/
Time).
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Formatting Numbers

I ntroduction

“R” typenumbers

“N” type numbers

Choosing a
number-type
format

Valid number
formats

A number-type element contains either an integer or areal number. If afield isanumber
type, you must specify the format (either “R” or “N") and the number of decimal places.

Number formats beginning with “R” represent numbers with an explicit decimal point.
Trailing zeros are truncated. For example, if the format you select is R2, then numbers are
formatted with two places to the right of the decimal point (e.g., “2.01").

Number formats beginning with “N” represent numbers with an implicit decimal point.
Thedecimal point isnot displayed, but the system still processes the number correctly. For
example, if the format you select is N2, then numbers are formatted with two placesto the
right of an implicit decimal point.

The number type format that you choose depends on your requirements. Regardl ess of
whether you use the “N” or “R” format, you must a so indicate the number of decimal
placesin the field.

You can format numbers in various numeric formats.

This table describes valid number formats.

Number Format Description

RO Number formatted with an explicit decimal point
and no decimal places

R1 Number formatted with an explicit decimal point
up to 1 decimal place

R2 Number formatted with an explicit decimal point
up to 2 decimal places

R3 Number formatted with an explicit decimal point
up to 3 decimal places

R4 Number formatted with an explicit decimal point
up to 4 decimal places

R5 Number formatted with an explicit decimal point
up to 5 decimal places

R6 Number formatted with an explicit decimal point
up to 6 decimal places
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Number Format Description

R7 Number formatted with an explicit decimal point
up to 7 decimal places

R8 Number formatted with an explicit decimal point
up to 8 decimal places

R9 Number formatted with an explicit decimal point
up to 9 decimal places

NO Number formatted with an implicit decimal point
and no decimal places

N1 Number formatted with an implicit decimal point
up to 1 decimal place

N2 Number formatted with an implicit decimal point
up to 2 decimal places

N3 Number formatted with an implicit decimal point
up to 3 decimal places

N4 Number formatted with an implicit decimal point
up to 4 decimal places

N5 Number formatted with an implicit decimal point
up to 5 decimal places

N6 Number formatted with an implicit decimal point
up to 6 decimal places

N7 Number formatted with an implicit decimal point
up to 7 decimal places

N8 Number formatted with an implicit decimal point
up to 8 decimal places

N9 Number formatted with an implicit decimal point
up to 9 decimal places
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Procedure  Usethis procedure to format numbersin ascreen entry or print form.

Step

Action

1

Double-click an existing element.

System Response
The system displays the Element Properties dialog box (Name tab).

Click the Validation tab to access validation options.

From the data-typelist, select Number. Thisindicates that the elementisa
numeric or real number that can be mathematically manipul ated.

From the form format list, select the format for the number.

Note

Usually, the number formats in the form format list and in the file format
list are the same. However, if thereisan “N” format selected in the form
format list, you might want to select an“R” format in the file format list so
that the decimal point in the numbersis displayed.

Verify that the number format selected in the file format list is the correct
format that is written to the EDI file.

Note
A number format must be designated for number-type elementsin the file
format list, even for hidden fields.

Click OK to exit the Element Properties dialog box.
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Formatting Dates and Times

Introduction A date/time-type element contains either adate or atime. If an element is adate/time type,
you must designate how the date or time is formatted in the screen entry form. You can
format dates and times that are written to an EDI filein various formats.

Valid Date/Time  Thistablelists Valid Date/Time formats.

Formats
Format Description

YYMMDD Two-digit year, two-digit month, two-digit day

MMDDYY Two-digit month, two-digit day, last two digits of year (example:
121599)

YYYYMMDD Four-digit year, two-digit month, two-digit day (example:
19991215)

DDMMYYYY Two-digit day, two-digit month, four-digit year (example:
15121999)

MMDDYYYY Two-digit month, two-digit day, four-digit year (example:
12151999)

DDMMYY Two-digit day, two-digit month, last two digits of year (example:
151299)

YYMMMDD Last two digits of year, three-letter abbreviation of the month,

two-digit day (example: 99JANO2)

DDMMMYY Two-digit day, three-letter abbreviation of the month, last two
digits of year (example: 02JAN99)

MMMDDYY Three-letter abbreviation of the month, two-digit day, last two
digits of year (example: JAN0299)

YYYYMMMDD | Four-digit year, three-letter abbreviation of the month, two-digit
day (example: 2003JUL04)

DDMMMYYYY | Two-digit day, three-letter abbreviation of the month, four-digit
year (example: 04JUL2003)

MMMDDYYYY | Three-letter abbreviation of the month, two-digit day, four-digit
year (example: JUL042003)

YYDDD Last two digits of year, three-digit Julian day (example: 99349 for
the 349th day of 1999)

DDDYY Three-digit Julian day, last two digits of year (example: 34999)
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Format Description

YYYYDDD Four-digit year, three-digit Julian day (example: 1999349)

DDDYYYY Three-digit Julian day, four-digit year (example: 3491999)

YY/MM/DD Last two digits of year, separator, two-digit month, separator, two-
digit day (example: 99/12/05)

DD/MM/YY Two-digit day, separator, two-digit month, separator, last two
digits of year (example: 05/12/99)

MM/DD/YY Two-digit month, separator, two-digit day, separator, last two
digits of year (example: 12/15/99)

YYYY/MM/DD Four-digit year, separator, two-digit month, separator, two-digit
day (example: 1999/12/15)

DD/MM/YYYY Two-digit day, separator, two-digit month, separator, four-digit
year (example: 15/12/1999)

MM/DD/YYYY Two-digit month, separator, two-digit day, separator, four-digit
year (example: 12/15/1999)

YY/MMM/DD Two-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 99/JUL/20)

DD/MMM/YY Two-digit day, separator, three-letter abbreviation of the month,
separator, two-digit year (example: 20/JUL/99)

MMM/DD/YY Three-letter abbreviation of the month, separator, two-digit day,
separator, two-digit year (example: JUL/20/99)

YYYY/MMM/DD | Four-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 2003/JUL/25)

DD/MMM/YYYY | Two-digit day, separator, three-letter abbreviation of the month,
separator, four-digit year (example: 25/JUL/2003)

MMM/DD/YYYY | Three-letter abbreviation of the month, separator, two-digit day,
separator, four-digit year (example: JUL/25/2003)

YY/DDD Last two digits of year, separator, three-digit Julian day (example:
99/349)

DDD/YY Three-digit Julian day, separator, last two digits of year (example:
349/99)

YYYY/DDD Four-digit year, separator, three-digit Julian day (example: 1999/
349)

DDD/YYYY Three-digit Julian day, separator, four-digit year (example: 349/

1999)
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Format Description

MONTH Month (example: December)

DAY Day of the week (example: Friday)

HHMM Two-digit hour, two-digit minutes (example: 0330 for 30 minutes
past 3 o'clock)

HHMMSS Two-digit hour, two-digit minutes, two-digit seconds (example:
033045 for 30 minutes and 45 seconds past 3 0’ clock)

HH:MM Two-digit hour, separator, two-digit minutes (example: 03:30)

HH:MM:SS Two-digit hour, separator, two-digit minutes, separator, two-digit
seconds (example: 03:30:45)

|SO-8601 YYYYMMDDTHHMMSS.mmmZ format: Four-digit year, two-
digit month, two-digit day, T (time) indicator, two-digit hour,
two-digit minutes, two-digit secondsin Universal Time (also
called Zulu Time or Greenwich Mean Time), Z (Zulu time)
indicator (example: 20031209T123000.0002)

YYYYMMDDZ SO-8601 date format: Four-digit year, two-digit month, two-digit
day, Z (Zulu time) indicator (example: 200312097)

MM/DD/YY Two-digit month, separator, two-digit day, separator, last two

HH:MM:SS digits of year, two-digit hour, separator, two-digit minutes,
separator, two-digit seconds (example: 12/15/99 03:30:45)

YYMMDD Last two digits of year, two-digit month, two-digit day, two-digit

HHMMSS hour, two-digit minutes, two-digit seconds (example: 991025
033045)

YYYY-MM- Four-digit year, separator, two-digit month, separator, two-digit

DDTHH:MM:SS | day, T represents ablank separator, two-digit hour, separator, two-
digit minutes, separator, two-digit seconds (example: 2002-02-02
03:30:45)

YYYY-MM-DD Four-digit year, separator, two-digit month, separator, two-digit
day (example: 2002-02-02)

YYYY-MM Four-digit year, separator, two-digit month (example: 2002-02)

YYYY Four-digit year (example: 2002)

--MM-DD Two dashes, two-digit month, separator, two-digit day (example: -
-12-02)

---DD Three dashes, two-digit day (example: ---02)
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Procedure  Usethis procedure to format dates and times in a screen entry or print form.

Step

Action

1

Double-click an existing element.

System Response
The system displays the Element Properties dialog box (Name tab).

Click the Validation tab to access validation options.

If the minimum allowed field length is longer than the length in the
Maximum box, type a new maximum field length in the Maximum box.
Thisvalue should be the maximum number of digits, including separators,
that you expect for the date or time.

Note

The value in the Maximum box should be the same as the value in the
maximum charactersto be displayed box on the screen entry form Display
tab or Print form Print tab.

Verify that Date/Timeis selected in the data-type list, indicating that the
field value must be a date or atime.

From the form format list, select the format for how you want the date or
time to be formatted in the screen entry transl ation object.

Verify that the date or time format selected in the file format list isthe
correct format that iswritten to the EDI file.

Note
A Date/Time format must be designated for Date/Time-type elementsin
the file format list, even for hidden fields.

Click OK to exit the Element Properties dialog box.
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Formatting Srings

Introduction A string-type field or element contains one or more printable characters. If you specify
that an element is a string type, you must designate the format by specifying a syntax
token.

Procedure  Usethis procedure to format stringsin a screen entry or print form.

Sep Action

1 Double-click an existing element.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Click the Validation tab to access validation options.

3 From the data-type list, select Sring. This indicates that the element
contains characters.

4 From the form format list, select a predefined syntax token to denote that

this element must be formatted as the specified syntax token dictates.

Note

When you installed Sterling Gentran: Server, you assigned a default format
to the string fields. Thisformat serves asthe basisfor character validation.
Most U.S. users use adefault format that corresponds to ASCI| characters
(for example, the X syntax token). Most users of Asian or European
languages and encoded character sets should use the Free Format (0x01-
OxFF).

5 From the file format list, verify that the string format selected is the
correct format that is written to the EDI file.

Note
A string format must be designated for string-type elementsin the file
format list, even for those that you hide.

6 Click OK to exit the Element Properties dialog box.

Related topic  You can create syntax tokens to define ranges of characters and/or numbersthat are
allowed to be used for a string-type field or element.
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Creating a Syntax Token (Western European languages)

Introduction Syntax tokens enable you to designate a“token” that defines ranges of characters and/or
numbersthat are allowed to be used for a string-type element. You can then use the syntax
tokensin the Format lists located on the Validation tab of the Element Properties dialog
box. This enables you to define what type of characters should be used while compliance
checking each element (i.e., al phanumeric within a certain range, numeric within acertain

range, etc.).

Note

When you set up atoken, it applies only to that form. You may need to set one up for each
form that you create.

Procedure  Usethis procedure to create a syntax token.

Step

Action

Select Syntax Tokens from the Edit menu.

System Response
The system displays the Syntax Tokens dialog box.

Syntax Tokens E3
Token  Allowed character ranges
& AZaz

M 09, --++

® AZaz09. e ([ RS R
Mew... |
Change... |
Delete |
4 I I _,I [WBIES: . |

The Token column contains the value designated as the syntax token for
each existing syntax token. The Token contains arange of characters that,
when applied to an element, dictate the way that element must be
formatted. If the element is not formatted as specified, the system
generates a compliance error.

The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of a
pair of characters that define the start and end characters.

Note
The DBCS button is only available if you are executing a double-byte
version of Microsoft Windows.
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(Contd)
Sep Action
2 Click New.
System Response
The system displays the Edit Syntax Token dialog box.
13 I
— Character Ranges el |
Start End
Mew... |
Change... |
Delete |
3 In the Token box, type the unique one-character alphanumeric value that

the system recogni zes as containing the allowed range of characters you
designate.

Note
The Token can only be one unique character, upper- or lower-case
alphabetic or numeric “1" - “9”.

The Character Ranges list contains the character range or ranges that you
define for this token. You can define more than one character range for
each token. For example, you can define the token “A” as alowing the
character range “A” through “Z” and the character range “a’ through “z”.
Thisindicates that token “A” only allows upper-case and lower-case
alphabetics.

Forms Integration User Guide
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(Contd)
Sep

Action

4

Click the New button on the Edit Syntax Tokens dialog box.

System Response
The system displays the Edit Character Range dialog box. This dialog box
enables you to create a character range.

Edit Character Bange E
Start character I
End character I Cancel |

Note

Sterling Gentran: Server uses the ANSI Character Set when determining
the start-end range.

For Western European languages, consult the ANSI character chart (1252
Microsoft Windows Latin 1). This chart also displays ranges so that you
can enter appropriate ranges for the charactersin your language.

If no chart is available, use the following guidelines:

To include all the accented charactersin the major languages of Western
Europe, add the following ranges:

Start End

0xCO 0xD6
0xD8 OxF6
OxF8 OxFC

Scandinavian users should also add the following in order to include E
and e

Start End
0x8C 0x8C
0x9C 0x9C
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(Contd)
Sep

Action

5

In the Start character box, type the character that begins the allowed token
range.

Note
The Start character and End character can only be one (1) character,
upper- or lower-case a phabetic or numeric“1” - “9.”

Example

For example, if the character range you want to defineis“B” through “D,”
type “B” in the Start character box. If you type a character, such as &, that
is not accepted, you need to enter it in hex code. To enter hex characters,
“0(zero)x” or “0X,” followed by the hex code. For example, the hex
equivaent of éis OxE9.

In the End Character box, type the character that terminates the allowed
token range.

Note
The End character can only be one (1) character, upper- or lower-case
alphabetic or numeric “1” - “9.”

Click OK.

System Response
You return to the Edit Syntax Tokens dialog box.

Do you want to add additional character ranges to the syntax token?

» I yes, repeat Step 4 through Step 7 as many times as necessary.
Proceed to the next step.

» If no, proceed to the next step.

Click OK.

System Response
You save the syntax token and return to the Syntax Tokens dial og box.

10

Click Close.

System Response
You exit the Syntax Tokens dialog box.
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Creating a Syntax Token (Far Easter n languages)

I ntroduction

The DBCS syntax token function enables you to create aform that accepts double-byte

characters. If you are running Sterling Gentran: Server on a Chinese, Japanese, or Korean
version of Microsoft Windows, the DBSC button on the Syntax Tokens dialog box is

available.

DBCS tokens are displayed only in the DBCS Syntax Tokens dialog box, not in the list in
the Syntax Tokens dialog box.

Note

When you set up aDBCS token, it applies only to that form. You may need to set one up
for each form that you create.

Procedure

Use this procedure to create a DBCS syntax token.

Sep Action
1 Select Syntax Tokens from the Edit menu.
System Response
The system displays the Syntax Tokens dialog box.
Syntax Tokens E2
Token  Allowed character ranges
A ASaz
i 09, -++
s PIoE = DR | SPT AR IR 5 H
Mew...
Change... |
Delete |
« | ¥ |__DBGS. |
2 Click DCBS.

System Response

The system displays the DCBS Syntax Token dialog box.

Taken

Change.. |
[e(=te |
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(Contd)

Sep Action

3 Click New.
System Response
The system displays the Edit DBCS Syntax Token dialog box.
Edit DBC
Lead-Eyte oo hd Cancel |
Trail-Bytes

0001102103 (0405104 O |09 04 |06 (0C 0D 0F |0F

N AN RN AN BN AN | (AN AN AN BN AR BN AN |
BN BN R RE R BN 1 RN nnnn
20 N HNEEAE - /
a0l0l1({2183{A51a]7189 ] -]:1<]=1]>]%
All@ | AJBICIDIEIF]GEIHIT IR [MIMN]O
S0P @ RISITIUNWVIWIXIY[ZI[[$]]]”
gl " lalblcldlelflalbl{ililklllmlnla
Mlplalr{s{tluly w vz {11711
o R/ nn'nnna L Ain/n n/nnn
o p/N NN LN nnnn
A0 Tl s F e ol {alplala]y
BO[- [Fl4 (DT (AR [=[F{H|T[H]>[A]E[Y
col Al g sk {F{] 22 N]E]I[A|m[Y
ool |AlATEIF (23U LIO 2] ]"
SN AN BN AN BN BN AN | (AN AN AN BN AR BN AN |
FOR/F R Hnnn P RN nnnn
Note
Double-byte characters are composed of alead byte and atrail byte. Inthe
above example, the character A is code point 0041.

4 In the Token box, type the unique one-character al phanumeric value that
the system recogni zes as containing the allowed range of characters you
designate.

5 Do you want to include all charactersin the Trail-Bytes section of the
dialog box?

» If yes, continue with step.
» If no, continue with step.

6 Use the Lead-Byte list to view other charactersin the code page on your
system. To exclude individual characters or groups of characters from the
token, select them (grey them out).

7 Click Close to save the syntax token and return to the Syntax Tokens
dialog box.

8 Click Close to exit the Syntax Tokens dialog box.
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Editing a Syntax Token

Procedure  Usethis procedure to edit a syntax token.

Sep Action

1 Select Syntax Tokens from the Edit menu.

System Response
The system displays the Syntax Tokens dialog box.

Syntax Tokens E3
Token  Allowed character ranges

AZaz Cloze
(9. -++

Ew
Change...

Delete

el

[NEIES

3

The Token column contains the value designated as the syntax token, for
each existing syntax token. The Token contains arange of charactersthat,
when applied to an element, dictate the way that element must be
formatted. If the element is not formatted as specified, the system
generates a compliance error.

The Allowed character ranges column contains the ranges of characters
that are permitted for each existing syntax token. Each range consists of a
pair of charactersthat define the start and end characters.

2 Select a syntax token and click Change to access the Edit Syntax Token
dialog box.
Edit Syntax Token

Token IX_ Ok |

r— Character Fanges

Start End

Delete |
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Sep

Action

3

Do you want to change the token value?

» If yes, type the unique one-character al phanumeric value that the
system recognizes as containing the allowed range of characters you
designate in the Token box. Proceed to the next step.

» If no, proceed to the next step.

Select the character range you want to modify and click Change on the
Edit Syntax Tokens dialog box.

System Response
The system displays the Edit Character Range dial og box.

Edit Character Bange E
Start character ID
End character |9 Cancel |

In the Start character box, type the character that begins the allowed token
range.

Note
The Start character and End character can only be one (1) character,
upper- or lower-case alphabetic or numeric “1” - “9.”

In the End Character box, type the character that terminates the allowed
token range.

Click OK to return to the Edit Syntax Tokens dialog box.

To edit additional character rangesfor this syntax token, repeat steps4 - 7
as many times as necessary.

Click OK to save the syntax token and return to the Syntax Tokens dialog
box.

10

Click Closeto exit the Syntax Tokens dialog box.
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Deleting a Syntax Token

Introduction You can delete a syntax token from the system. You can also delete a specific character

range from a syntax token.

Procedure  Usethis procedure to delete a syntax token.

Sep

Action

1

Select Syntax Tokens from the Edit menu.

System Response
The system displays the Syntax Tokens dialog box.

Syntax Tokens E3
Token  Allowed character ranges

AZaz Cloze
(9. -++

[

Mew...
Change...

Delete

il

[NEIES

3

Highlight the token that you want to delete and click Delete.

WARNING

THE SELECTED ENTRY ISDELETED WITHOUT

FURTHER WARNING.
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Deleting a character range from a syntax token

Procedure  Usethis procedure to delete a character range from a syntax token.

Step

Action

1

Select Syntax Tokens from the Edit menu.

System Response
The system displays the Syntax Tokens dialog box.

Select a syntax token and click Change.

System Response
The system displays the Edit Syntax Token dialog box.

Edit Syntax Token

Token IX_ ok

— Character Ranges

Stark End

di

Cancel

Mew...

Change...

i

Delete

Highlight the character range that you want to delete, and click Delete.
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Using Syntax Tokens

Introduction You can use syntax tokensin the Format lists located on the Validation tab of the Element
Properties dialog box. This enables you to designate a “token” that defines ranges of
characters and/or numbersthat are allowed to be used for a string-type element. The use of
a syntax token enables you to define what characters should be used while compliance
checking this element (i.e., alphanumeric within a certain range, numeric within a certain
range, etc.).

Procedure  Usethis procedure to use syntax tokens.

Sep Action

1 Double-click an existing element.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Click the Validation tab to access validation options.
Element Properties E2
Mame “Walidation | Dizplay I Help I Extended Fule I Standard Fule I Conditions I
Check here if thiz field is mandatorw: [
Fleaze zet the allowed lengths of this field :
Mirirnm : I'I M awirnim : I'I 0
Flzaze choose the data-type of thiz field : ISt[ing j
Fleaze chooze the format of the data in the form IX ﬂ
Flease chooze the format of the data in the fils : |>< j
[ Datais readfwritten as raw bytes s I j
£ wze ittle-endian byte ardening
) Use big-endian byte arderng
Cancel | i | Help |
3 From the data-type list, select String. This indicates that the element

contains characters.
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(Contd)
Sep

Action

4

From the form format list, select a predefined syntax token to denote that
this element must be formatted as the specified syntax token dictates.

Note

When you installed Sterling Gentran: Server, you assigned a default format
tothe string fields. Thisformat serves as the basisfor character validation.
Most U.S. users use adefault format that correspondsto ASCII characters
(for example, the X syntax token). Most users of Asian or European
languages and encoded character sets should use the Free Format (0x01-
OXFF).

Reference

See Creating a Syntax Token (Western European languages) on
page 3 - 34 or Creating a Syntax Token (Far Eastern languages) on
page 3 - 38 for more information.

Click OK to exit the Element Properties dialog box.
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Modifying Element Properties

Introduction Each segment or composite contains agroup of logically-related elements. These elements
define the structure of the EDI data that your system needs to process the document.

Procedure  Usethis procedure to modify the properties of an element.

Step

Action

Double-click the element you want to modify.

System Response
The system displays the Element Properties dialog box.
Element Properties
Name IVaIidationl Displayl Help | Extended Flulel Standard Hulel Conditionsl

Pleaze enter the name of this field :
|1 004

Pleaze enter a short description of thiz field :

DOCUMENTMESSAGE NUMBER

Cancel | Lol | Help

Do you want to change the name of the element?

» If yes, typethe new namein the first box on the Name tab. The name
istypically the element sequence number. Proceed to the next step.

Note

Do not use spaces or dashes (-) in the Name box. You can use the

underscore (_) to separate words.

» If no, proceed to the next step.

Do you want to change the description of the element?

» If yes, typethe new description in the second box on the Name tab.
The description is used to provide a brief explanation of the element
that allows you to differentiate it from similar elements. Proceed to
the next step.

» If no, proceed to the next step.
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(Contd)
Sep Action
4 Click the Validation tab to access validation options.
5 Do you want to designate the element as “ mandatory” (must be present)?
» If yes, select thefirst check box on the Validation tab.
» If no, proceed to the next step.
6 Do you want to change the minimum length of the element?
» If yes, type the minimum length in the Minimum box. Proceed to the
next step.
Note
If the datais |ess than the minimum length, a compliance error is
generated when trand ation occurs.
» If no, proceed to the next step.
7 Do you want to change the maximum length of the element?
» If yes, type the maximum length in the Maximum box. Proceed to the
next step.
» If no, proceed to the next step.
8 From the data-type list, select the type of the element.

Valid values are:

» String = aphaelement

» Number = numeric or real element

» Date/Time = date or time element

» BinData = binary data(only availableif you select “Binary” on
the Special tab of the EDI Segment Properties
dialog box)

» BinLength = length of binary data (only available if you select
“Binary” on the Specia tab of the EDI Segment
Properties dialog box)

Reference

See Modifying Segment Properties on page 3 - 14 for more information
about selecting “Binary” on the Special tab.
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(Contd)
Sep Action

9 From the form format list, select how the data el ement is formatted on the
form.

Note

The choices for thislist depend on the type of the element you selected
from the data-type list. If you choose Number or Date/Time in the data-
type list, you can select the data format from the dataformat list. If you
selected String from the data-type list, you can select a syntax token to
denote that this element must be formatted as the specified syntax token
dictates (the default syntax tokenis“X").

When you installed Sterling Gentran: Server, you assigned a default format
tothe string fields. Thisformat serves asthe basisfor character validation.
Most U.S. users use adefault format that corresponds to ASCII characters
(for example, the X syntax token). Most users of Asian or European
languages and encoded character sets should use the Free Format (0x01-
OxFF).

Reference

See Creating a Syntax Token (Western European languages) on
page 3 - 34 or Creating a Syntax Token (Far Eastern languages) on
page 3 - 38 for more information.

10 From the file format list, select how the data el ement is formatted in the
EDI file.

Note
The choices for thislist depend on the type of the element you selected
from the data-type list.
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Modifying Element Properties

(Contd)
Sep Action
11 Use this table to determine your next step.
IF thisisa... AND you want to... THEN...
screen entry form, you want to change click the Display tab.
display options, Proceed to the next
step.
Reference
See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about
display options.
print form, you want to change click the Print tab.
print options, Proceed to the next
step.
Reference
See Customizing
Screen Entry and Print
Forms, chapter 7 in
this guide, for more
information about
print options.
12 Isthe element in a repeating group or segment?
» If yes, do you want to change the summary list options?
— If yes, click the Summary List tab. Proceed to the next step.
— If no, proceed to the next step.
Note
See Creating Definitionsfor a List Box on page 7 - 9 for more information
about lists.
» If no, proceed to the next step.
13 Click OK to save the changes to the element.
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Soring EDI Code Value Descriptions

Introduction Sterling Gentran: Server enables you to store code val ue descriptions in code storage
fields. Thisfeature is useful for elements that contain an EDI code, and for which you
want to print the description of the code instead of or in addition to the code itself. You set
up a standard rule to direct the system to look up an EDI code value, find the description
for that value, and to display the description in another field.

Whentouse  You might usethisfeatureif, for example, you have a code list that contains given names
and you want the corresponding last names |oaded in the descriptive element.

Procedure  Usethis procedure to store an EDI code value description in a code storage field.

Sep Action

1 Double-click the element for which you need to load a code value
description.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Click the Sandard Rule tab to access standard rule options.

3 From the standard rule list, select Use Code.

System Response
Your dialog box should ook like this.

Element Properties E2
Hame I Walidation | Dizplay | Summary List | Help
Extended Rule Standard Rulz | Conditions
Fleaze select the standard rule to use IUse Code j

Please select the code lizt o uge

| = Ed... |

" Raise a compliance ermor if the code is nat found in the list

If wou would ke the description of the code to be stored i a figld, pleaze
select that field below :

| =

T Cancel oply Help
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Storing EDI Code Vaue Descriptions

(Contd)
Sep

Action

4

From the code list, select the code list table that the data in this element
will be validated against. If the Tables list is empty, you need to load a
code table.

Reference
Please see Loading a Code List Table from the Sandard on page 5 - 98 for
more information.

If you need to specify that, for compliance reasons, the element must
contain one of the codes from the specified table (nothing else isvalid for
that field), select the compliance error check box.

From the store description list, the element to which you want the
description of the code item (that is used) to be mapped to when the
selection is made.

For example, if the code you used is“BPR” it would be useful to view the
description of the code (“Buyer's Part Number”). If you selected element
“0350" from the Store Field list, the description for the BP code is mapped
to element “0350.”

Click OK to add this standard rule to the element.

Related topic ~ Now that you have set up the EDI code value description, and directed the system to
display the description of the EDI code valuein an element, you can format and customize

that element.

Reference

See Hiding Fields on page 7 - 3 for information about how to hide the EDI code value

field.

See Loading a Code List Table from the Sandard on page 5 - 98 for information about
using code list tables and using code item descriptions.
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Defining Relational Conditions

Introduction You can use relational conditions to connect elements together for syntax or compliance
reasons. You can also view the conditional relationships between elements, as provided by
the standard.

Example

Element A isinvalid unless Element B is present. Therefore, if you set up a condition that
pairs Elements A and B, the system generates a compliance error if one of those elements
is not present.

WARNING

THE SYSTEM ENABLESYOU TO EDIT EDI CONDITIONAL
RELATIONSHIPS, BUT IF YOU DO, YOU MAY ALTER THE
COMPLIANCE CHECKING CRITERIA. WE RECOMMEND THAT YOU
VIEW EDI CONDITIONS ONLY.

Procedure  Usethis procedure to define, modify, and view element relational conditions.

Sep Action

1 Double-click the element you want to modify.

System Response
The system displays the Element Properties dialog box (Name tab).
Element Froperties

Hame |Validation| Pritt I Exrtended Hulel Standard Hulel Eonditionsl

Please enter the name of this field :
|0235

Flease enter a short description of this figld :
FRODUCT /SERYICE 1D QUALIFIER

Cancel Al Help
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Defining Relational Conditions

(Contd)
Sep

Action

2

Click the Conditions tab.

System Response

The system displays the relational condition property sheet.

Element Properties

M ame I Validationl Frint I Evtended Hulel Standard Rule  Conditions |

Fleaze choose the type of relationship to use

I Conditional 4 l

Please select the condition figld :

|D235 FRODUCT/SERVICE ID QUALIFIER

Aueailable fields :

0350 ASSIGHNED IDENTIFIC
0330 QUANTITY ORDERE

0212 UNIT FRICE
0E39 BASIS OF LUMIT PRICE

N2 PRONLICT ASFERVIT
4 I I

0355 UNIT OF BASIS FDHd Add-» |
0235:2 PRODUCTASERVICE <~ Remove |
DI

|

Fields uzed in relationzhip :
0234 PRODUCT/SERWICE 1D

Cancel | Appli | Help |

Thistab enables you to view, modify, or define field relational conditions.
Continue with the following steps to define or modify conditions.

Select the field connection condition from the type of relationship list.

Valid values are;

» Paired/Multiple—if any of the specified elements are present then all

elements must be present.

» Required —at least one of the specified elements must be present.
» Exclusion —no more than one of the specified elements may be

present.

» Conditional —if thefirst Condition element is present, the rest of the
elements must also be present.

» List Conditional —if the first Condition element is present, at |least
one of the specified elements must also be present.

Select the first element from the condition field list. Thisisthe element on
which the conditional relationship hingesif you chose “Conditional” or
“List Conditional” from the type of relationship list.

System Response

The condition field list is only active if you chose either “ Conditional” or
“List Conditiona” from the type of relationship list.

Forms Integration User Guide
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(Contd)
Sep Action

5 The Available fields list contains al the elements in the translation object
that are valid to be used in a condition at this point. Highlight an element
or elements in the Available fields list and click the ADD--> button to
move the elements to the Fields used in relationship list, to include the
elements as a part of the conditional relationship.

To highlight ablock of adjacent items, click the first item and then press
the SHIFT key and click the last item. To highlight several itemsthat are
not adjacent to each other, pressthe CTRL key and click the items.

6 The Fields used in relationship list contains the elements that you selected
to be a part of the conditional relationship. To remove the elements from
the conditional relationship, highlight an element or elementsin the Fields
used in relationship list and click the Remove button to move the elements
back to the Availablefieldslist.

7 Click OK to add the conditional relationship to the element.
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Overview

Inthischapter  Thischapter describes how to complete your form.
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Compiling a Tranglation Object

Compiling a Translation Object

Introduction You use the Compile function after the form is completed and saved. The Compile
function compilesthe form and creates a translation object. The form that you create using
Sterling Gentran: Server isasource form. When that source form is compiled, theresult is
acompiled trandation object.

Note
The trandlation object must be registered with the Sterling Gentran: Server system before

you can use it.

Procedure  Usethis procedure to compile aform and to generate atranslation object.

Sep

Action

Select Compile from the File menu.

System Response
The system displays the Run-Time Translation Object Name dial og.

Run-Time Translation Object Hame [ 2]

Save it Ia TransObj j gl E....

File hame: IPET_EDHD.TF‘L

Save as lype: ITransIation Objects [ TFL] j Cancel |

The system defaults the name of the translation object (. TPL file) with the
same filename (one to eight characters long) as you named the form (.STP
file). Preserving the same filename (with different file extensions) means
that the relationship between the source form and the compiled translation
object will remain evident. For example, if the source form nameis

MWT _850.STP, the compiled transl ation object nameis MWT_850.TPL.

WARNING

DO NOT TO OVERLAY THE SOURCE FORM WITH THE
COMPILED TRANSLATION OBJECT. USE THE .TPL
FILEEXTENSIONTO DISTINGUISH THE TRANSLATION
OBJECT.

Forms Integration User Guide
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(Contd)
Sep Action

2 From the Savein list, change the drive\folder where the compiled
tranglation object is stored, if necessary.

WARNING

DO NOT STORE THE COMPILED TRANSLATION
OBJECT IN THE GENSRVNT\REGTRANSOBJ FOLDER.
THISFOLDER ISRESERVED FOR STORING A COPY OF
EACH TRANSLATION OBJECT YOU REGISTER WITH
STERLING GENTRAN:SERVER.

3 Click Save.

System Response

The system compiles the form and creates a trand ation object. The
Compile Errors dialog displays. it indicate errors or warnings that
occurred during the compile process.

4 Does the Compile Errors dialog note any errors or warnings that occurred
during processing?
» Ifyes, click OK to exit the Compile Errors dialog. Correct the

problems and repeat Step 1 through Step 3 to recompile the
tranglation object. Proceed to the next step.

» Ifno,click OK to exit the Compile Errors dialog. Proceed to the next
step.
Note

The date that the translation object was compiled on is automatically
loaded into the Compiled on box on the Trandlation Object Details dial og.

Translation Object Details %]
Summary
Author Dezcription Tranzlation Object Function
[5teriing [Prirt 850 Pet Zone | Print =l Cancel |
Flag: =
’]- Supatem = (Use Eanfiguratle Trmmite) v g:%?ﬂ:;ﬁg:gﬂx:sgﬂ;n ‘

—Wersion Control
Major version |1 Minor version IEI Compiled on I

— EDI &ssociation

Input Output
Agency [ [x12 [<[[x12
Wersion |003040 | [ANSIX12VERSIO | | 002040 | | ANSIX 12 VERSIO
Transaction  [850 | PURCHASE DRDE | | [850 | PURCHASE ORDE
Releasze IU_ IU_
F Group ] f PO f
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Related topic

Forms Integration User Guide

Compiling a Tranglation Object

(Contd)
Sep

Action

5

Select Save from the File menu.

System Response
You save the source form with the Compiled on date.

This trandation object must be registered with the Sterling Gentran: Server system before

you can use it.

Reference

See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for
information on registering a translation object.
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Printing a Report

Introduction The Print function available from the File menu enables you to print a customized report
in either hard copy or file format. Using the Print option, you can select the following
options:

» Branching diagram
» Record Details

» Extended Rules

» Codelists
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Registering a Tranglation Object

Introduction  After you have compiled your translation object, it must be registered with the Sterling
Gentran: Server system before you can useit.

Reference

See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for
information on registering a transl ation object.
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Creating a Trading Partnership

Introduction  After you have registered your translation object with the Sterling Gentran: Server system,
you must associate it with atrading partner.

Reference
See the Using Partners chapter of the IBM®Sterling Gentran: Server® for Microsoft
Windows User Guide for information.
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Validating a Trandation Object

Introduction For a screen entry trandation object, create a new document in Document Editor, using
that translation object. For a print translation object, print a document. Verify that the
output is correct.

Reference
See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for
information on using the Document Editor.
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Using Standard Rules Introduction

| ntroduction

Sandard Rules  Sterling Gentran:Server provides you with standard rules that you can apply to elements.
Standard rules give you access to functions that are necessary for operations that are less
involved than extended rules.

Each standard rule is mutually exclusive (you can use only one on a particular el ement).
This chapter defines the standard rules and provides examples (where appropriate) of
when you may use them.

Note
When an element contains a standard rule a black asterisk appears to the right of the
element icon.

Related Topic  Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any operation you require. See Using Extended Rules,
chapter 6 in this guide, for more information.
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Using the Sdect Standard Rule
Overview

Introduction The Select function enables you to select entries from alocation table, cross-reference
table, partner table, or lookup table (al tables created in the Sterling Gentran: Server
Partner Editor). You can then map the elementsin those tables to one or more elementsin
the data. The Select function uses the value of the current element to perform the
selection. The results of the select can be displayed on the screen or printed on areport.

Using partner The Forms Integration subsystem allows you to use information from the Sterling
related Gentran: Server Partner Editor in your forms via standard rules. You can map information
information in from your partner's profile in the Partner Editor to a selected element in the form. You can
forms  asomap information from the Internal System Partner. The definition information and
location tables that you define for the internal system partner can be used for al partners.
The information that you can use includes:

» Partner or Internal System Partner Definition (Name, EDI Code, Application Code)
» Partner or Internal System Partner Location Table Fields

» Lookup Table Fields

» Cross-Reference Table Fields
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Standard Ruletab
(Select)

Partsand
Functions

Thisillustration describes the Select function.

Element Properties E3

Mame I \-"alidationl Frint I Extended Rule  Standard Rule |E0nditinns|

Overview

Flease select the standard rule bo uze ; ISeIect

Fleaze chooze the table and key [or group] to uze when selecting data
T |

Elease ententhie mame of the sub-table touse (i apprepniate]

=

[ Raise a compliance enor if matching data iz not found

Y'ou can map the data that was selected. Click on data in the left list then click the
fieldz in the right list that you would like it to be mapped to. Repeat to map more data,

[ o |

Cancel |

Eppli | Help |

This table describes the parts and functions of the Select Standard Rule.

Part

Function

Please select astandard rule to use list

| dentifies standard rule options.

Please choose atable and key to use when
selecting data list

Lists available tables in the Partner Editor
from which to select data.

Please enter the name of a sub-tableto use
box

Defines what sub-table information to use.

Compliance error check box

Determines whether a compliance error is
generated if no matching datais found.

Datalist (Ieft-side list box)

Identifies data that can be mapped.

Map to list (right-side list box)

| dentifies where the data can be mapped.

OK Saves changes; exits the dialog box.
Cancel Cancels changes; exits the dialog box.
Apply Unavailable.

Help Launches the Forms Integration online

Help system.

Forms Integration User Guide

Sterling Gentran:Server — May 2011



Using Select in aForm

Using Standard Rules

Using Select ina Form

Procedure

Use this procedure to access the Select function.

Sep

Action

Double-click an existing element, or create a new element.

System Response

The system displays the Element Properties dialog box (Name tab).

Element Properties E2

Name I\u‘alidationl Displayl Help I Extended Flulel Standard Hulel Condilionsl

Please enter the name of this field :
|3035

Please enter a short description of this figld |
PARTY MAME

Cancel | Sl | Help |

Click the Sandard Rule tab to access standard rule options.
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(Contd)
Sep Action
3 From the standard rule list, choose Select.
Element Properties
Mame | W alidation | Dizplay | Help | Extended Rule  Standard Rule I Condilionsl
Please select the standard rule to uge : ISeIect j
Pleaze chaoze the table and key [or group] to uze when selecting data
Flease enter thename of the sub:-table touse [if appropriste] :
™ Raise a compliance enor if matching data is not found
You cat map the data that was selected. Click on data in the left list then click the
fields in the: right list that pou would like it to be mapped to. Repeat to map more data.
Cancel | Aol | Help |
4 From the table drop-down list, select atable or table and key to use when

selecting data. Valid values are:

» Partner by EDI codeindicatesthat the key isthe partner's EDI Code
and enables you to map from one of three fields for this partner
(Name, EDI Code, Alternate Code) from the partner table. You
entered these fields on the Partner Definition dialog box of the Partner
Editor.

» Partner by alternate code indicates that the key is the partner's
Application Code and enables you to map from one of threefields for
this partner (Name, EDI Code, Alternate Code) from the partner table.
You entered these fields on the Partner Definition dialog box of the
Partner Editor.

» Partner by partner key indicates that the key isthe partner's Profile
ID enablesyou to map from one of three fields for this partner (Name,
EDI Code, Alternate Code) from the partner table. You entered these
fields on the Partner Definition dialog box of the Partner Editor.

» Partner location by nameindicates that the name on the Locations
dialog box (for the current partner) of the Partner Editor isthe key and
enables you to map from any field in that table. You entered these
fields on the Location Entry dialog box of the Partner Editor.
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(Contd)
Sep Action
4 » Partner location by nameindicates that the name on the L ocations
(cont.) dialog box (for the current partner) of the Partner Editor isthe key and

enables you to map from any field in that table. You entered these
fields on the Location Entry dialog box of the Partner Editor.

» Partner location primary ref codeindicates that the Reference Code
1 field on the Locations dialog box (for the current partner) of the
Partner Editor isthe key and enables you to map from any field on
that dialog box.

» Partner location by secondary ref code indicatesthat the Reference
Code 2 field on the Locations dialog box (for the current partner) of
the Partner Editor isthe key and enables you to map from any field on
that dialog box.

» Partner lookup (activates Sub Tablefield) indicates that the key is
the partner lookup table name for this partner and enables you to map
from any field in that table. You entered these fields on the Lookup
Entry dialog box of the Partner Editor.

» Partner crossreference by my item (activates Sub Table field)
indicates that the key is the your item (value) on the partner cross-
reference table for this partner and enables you to map from any field
in that table. You entered these fields on the CrossRef Entry dialog
box of the Partner Editor.

» Partner cross-reference by partner item (activates Sub Table
field) indicates that the key is the your partner's item (value) on the
partner cross-reference table for this partner and enables you to map
from any field in that table. You entered these fields on the CrossRef
Entry dialog box of the Partner Editor.

» Division enables you to map from one of threefields (Name, EDI
Code, Alternate Code) for the <Internal System User> (system
partner) in that table. You entered these fields on the Partner
Locations dialog box of the Partner Editor.

» Division location by name indicates that the key is the name on the
Locations dialog box of the Partner Editor for the <Internal System
User> and enables you to map from any field in that table. You
entered these fields on the L ocations dialog box of the Partner Editor.

» Division lookup (activates Sub Table field) indicates that the key is
the partner lookup table name for the <Internal System User> partner
and enables you to map from any field in that table. You entered these
fields on the Lookup Entry dialog box of the Partner Editor.

» Division location by by primary ref code indicates that the key is
the Reference Code 1 on the Locations dialog box of the Partner
Editor for the <Internal System User> and enables you to map from
any field on the Locations dialog box.
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(Contd)
Sep Action
4 » Division location by by secondary ref code indicates that the key is
(cont.) the Reference Code 2 on the Locations dialog box of the Partner
Editor for the <Internal System User> and enables you to map from
any field on the Locations dialog box.

» Division cross-reference by my item (activates Sub Table field)
indicates that the key is the your item (value) on the partner cross-
reference table for the <Internal System User> partner and enables
you to map from any field in that table. You entered these fields on the
CrossRef Entry dialog box of the Partner Editor.

» Division cross-reference by partner item (activates Sub Table
field) indicates that the key is the your partner's item (value) on the
partner cross-reference table for the <Internal System User> partner
and enables you to map from any field in that table. You entered these
fields on the CrossRef Entry dialog box of the Partner Editor.

» Document record enables you to map from any of the fields within
the current document record.

» Generic envelope segment enablesyou to map from any of thefields
within the current envelope information,

» regardless of the EDI standard used. This function is normally not
used unless you are familiar with the generic envel ope table structure
for agiven standard.

» Interchange enables you to map from any of the fields within the
current interchange record.

» Group enablesyou to map from any of the fields within the current
group record.

5 In the Sub Table text box, enter the sub table name (if appropriate) to use.

Note

The sub table box isonly active if you select Partner Lookup, Partner

cross-reference by my item, Partner xref by partner item, Division lookup,

Division cross-reference by my item, or Division cross-reference by

partner item from the table and key list.

6 Do you want the system to generate an error if the Select does not find a
valid table entry?

» If yes, select the compliance error check box. Proceed to the next step.

» If no, verify that the check box is clear. Proceed to the next step.

Note

The default is do not generate an error if the Select is not successful.
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(Contd)
Sep Action

7 From the data list displayed on the left-hand side of the dialog box, select
the element from the specified table entry from which you want to map the
contents.

Note
Entries are displayed in the map from list only after you select atable and

key.

8 From the list on the right, choose the element to which you want to map
the contents of the map from box. Each element isdisplayed in thislist. A
total of eight elements can be mapped using one Select rule. Proceed to the
next step.

Note

Entries are displayed in the map to list only after you select atable and
key, and these entries are activated only after you highlight an entry in the
map from box.

9 Click OK to save your changes.
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Using Information from the Partner Definition

Using Information from the Partner Definition

I ntroduction

Procedure

Forms Integration User Guide

This function enables you to load information from the Partner or Internal System Partner
Definition into a screen entry or print trand ation object. For a screen entry trandation
object, the system displays alist which allows you to select the entry from the table. For a
print tranglation object, the system prints the information on the report.

Use this procedure to load information from the Partner or Internal System Partner
Definition into a screen entry or print translation object.

Sep Action

1 Double-click the element to which the standard rule is applied.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties

Hame |Validation| Displa_l,ll Help I E utetded Hulel Standard Hulel Eonditionsl

Please enter the name of this field :
|3035

Fleaze enter a short description of this field :
FARTY MAME

Cancel i Help

2 Click the Sandard Rule tab.

System Response
You access the standard rule options.
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(Contd)
Sep Action

3 From the standard rule list, choose Select.

Element Properties E

Hame I Validationl Displa_l,ll Help I Extended Rule  Standard Rule | Eonditionsl

Pleaze select the standard mile to uze ISeIect j

Please choose the table and key [or group) bo use when selecting data ;

| =

Flease ententhe name of the sub-tatle m use (i apprapnate]

[” Raise a compliance armor if matching data is not found

“V'ou can map the data that was selected. Click on data in the left lizt then click the
fields in the right list that pou would like it to be mapped to. Repeat to map more data.

Cancel | Sl | Help |

4 From the table list, select the key from which the system looks up the
trading partner. Valid selections are:

» Partner by EDI codeindicatesthat the key isthe partner's EDI Code
and enables you to map from one of three fields for this partner
(Name, EDI Code, Alternate Code) on the Partner Definition dialog
box of the Partner Editor.

» Partner by alternate code indicates that the key isthe partner's
Application Code and enables you to map from one of threefieldsfor
this partner (Name, EDI Code, Alternate Code) on the Partner
Definition dialog box of the Partner Editor.

» Partner by partner key indicates that the key isthe partner's Profile
ID and enables you to map from one of three fields for this partner
(Name, EDI Code, Alternate Code) on the Partner Definition dialog
box of the Partner Editor.

» Division enables you to map from one of three fields (Name, EDI
Code, Alternate Code) for the <Internal System User> (system
partner) on the Partner Definition dialog box of the Partner Editor.

5 Do you want the system to generate an error if the lookup fails?

» If yes, select the compliance error check box. Proceed to the next
step.
» If no, proceed to the next step.

6 From the map from list, select the field (Name, EDI Code, Application
Code) from which you want the contents mapped.
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Using Information from the Partner Definition

(Contd)
Sep Action
7 From the map to list, select the element to which the information from the
Partner Editor is mapped.
8 Click OK to add the standard rule.

Forms Integration User Guide
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Using Information from L ocation Tables

Introduction Each Partner Profile and the Internal System Partner Profile can have many associated
location tables. The location table can be used to contain address-related information
about the partner. You can store your partner’s store addresses, warehouse addresses, or
“invoice to” addresses. For a screen entry trandlation object, the system displays alist
which alows you to select the entry from the table. For a print tranglation object, the
system prints the information on the report.

To use information from alocation table, you must have created that table already in the
Partner Editor.

Reference
See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for more
information on creating a Partner location table.

Procedure  Usethis procedure to load information from a Location Table into a screen entry or print
tranglation object.

Sep Action

1 Double-click the element to which the standard rule is applied.

System Response

The system displays the Element Properties dialog box (Name tab).

Element Properties E
Harne I\-"alidationl Displa_l,ll Help | Extended Hulel Standard Hulel Conditionsl

Please enter the name of this fisld :
|3035

Pleasze enter a short description of this figld ©
PARTY NAME

T Cancel Aol Help

2 Click the Sandard Rule tab.

System Response
You access standard rule options.
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Using Information from Location Tables

(Contd)
Sep Action
3 From the standard rule list, choose Select.
4 From the table list, select the key that is used to look up the Partner

L ocation entry. You are allowed to map from any box on the Locations

dialog box. Valid selections are:

» Partner location by name indicates that the name on the Locations
dialog box (for the current partner) of the Partner Editor isthe key
and enables you to map from any field on that dialog box.

» Division location by name indicates that the key isthe name on the
Locations dialog box of the Partner Editor for the <Internal System
User> and enables you to map from any field on the Locations dialog
box.

5 Do you want the system to generate an error if the lookup fails?

» If yes, select the compliance error check box. Proceed to the next
step.

» If no, proceed to the next step.

6 From the map from list, select the field from which the contents are
mapped. You can select from the following fields:

» Name, Address 1

» Address2, Address3

» City

» State

» Zip

» Country

» Telephone Number

» Fax Number

» Contact Name

» Primary Reference

» Secondary Reference.

7 From the map to list, select the element to which the information from the

Partner Editor is mapped.

8 Click OK to add the standard rule.

Forms Integration User Guide
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Using Information from Lookup Tables

Introduction A lookup tableis used to select information related to avalue in inbound or outbound data.
Each Partner Profile and the Internal System Partner Profile can have many lookup tables
associated with it. For a screen entry trand ation object, the system displays alist which
allowsyou to select the entry from the table. For a print translation object, the system
prints the information on the report.

To use information from alookup table, you must have created that table already in the
Partner Editor.

Reference

See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for more
information on creating Partner lookup tables.

Procedure  Usethis procedure to load information from a Lookup Table into a screen entry or print
tranglation object.

Sep Action

1 Double-click the element to which the standard ruleis applied.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E
Harmne | Walidation | Dizplay I Help I Extended Rule I Standard Rule | Conditions |
Flease enter the name of this fisld :
|3035
Pleaze enter a short description of this fisld ;
PARTY HAME
Cancel | Al | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, choose Select.
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Using Information from Lookup Tables

(Contd)
Sep Action
4 From the table list, select the key from which the system looks up the
trading partner. Valid selections are:

» Partner lookup (activates Sub Table box) indicates that the key is
the partner lookup table name for this partner and enables you to map
from any box on the Lookup Entry dialog box of the Partner Editor.

» Division lookup (activates Sub Table box) indicates that the key is
the partner lookup table name for the <Internal System User> partner
and enables you to map from any box on the Lookup Entry dialog box
of the Partner Editor.

5 In the sub table box, type the name of the lookup table.

6 If you want the system to generate an error if the lookup fails, select the
compliance error check box.

7 From the map from list, select the field (Item, Description, Text 1, Text 2,

Text 3, Text 4) from which the contents are mapped.

8 From the map to list, select the element to which the information from the

Partner Editor is mapped.

9 Click OK to add the standard rule.

Forms Integration User Guide
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Using Information from Cross-Reference Tables

Introduction Cross-reference tables are used to convert your values to your trading partner's values
during outbound processing, or your partner's values to your values during inbound
processing. Each Partner Profile and the Internal System Partner Profile can have many
lookup tables associated with it. For a screen entry trandlation object, the system displays
alist which alows you to select the entry from the table. For a print translation object, the
system prints the information on the report.

To use information from a cross-reference (XREF) table, you must have created that table
already in the Sterling Gentran:Server Partner Editor.

Reference
See the IBM®Serling Gentran: Server® for Microsoft Windows User Guide for more
information on creating Partner cross-reference tables.

Procedure  Usethis procedure to load information from a Cross-Reference (XREF) Tableinto a
screen entry or print translation object.

Sep Action

1 Double-click the element to which the standard rule is applied.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E
Harne | Walidation | Display | Help | Extended Rule | Standard Rule I Conditionz I
Please enter the name of this fisld :
|3035
Pleasze enter a short description of this figld ©
PARTY NAME
Cancel | Anpl | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, choose Select.
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Using Information from Cross-Reference Tables

(Contd)
Sep

Action

4

From the table list, select the key from which the system performs the
look up. For Cross-Reference Tables, valid selections are;

Partner crossreference by my item indicates that the key is your
item (value) on the partner cross-reference table for this partner and
enables you to map from any box on the CrossRef Entry dialog box of
the Partner Editor.

Partner cross-reference by partner indicates that the key is your
partner'sitem (value) on the partner cross-reference table for this
partner and enables you to map from any box on the CrossRef Entry
dialog box of the Partner Editor.

Division cross-reference by my item (activates Sub Table box)
indicates that the key is your item (value) on the partner cross-
reference table for the <Internal System User> partner and enables
you to map from any box on the CrossRef Entry dialog box of the
Partner Editor.

Division cross-reference by partner item (activates Sub Table
box) indicates that the key is your partner's item (value) on the
partner cross-reference table for the <Interna System User> partner
and enables you to map from any box on the CrossRef Entry dialog
box of the Partner Editor.

In the sub table box, type the name of the cross-reference table.

If you want the system to generate an error if the look up fails, select the
compliance error check box.

From the map from list, select the field (My Item, Partner Item,
Description, Text 1, Text 2, Text 3, Text 4) from which the contents are
mapped.

From the map to list, select the element to which the information from the
Partner Editor is mapped.

Click OK to add the standard rule.

Forms Integration User Guide
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Using the Update Standard Rule
Overview

Introduction The Update function enables you to update a specific field in adocument record, envelope
segment, interchange, group, current partner, or document, with the contents of the
element.

WARNING

PLEASE NOTE THAT THISFUNCTION UPDATESTHE INTERNAL
STERLING GENTRAN:SERVER DATABASE TABLES. WE
RECOMMEND THAT YOU USE THISFUNCTION ONLY IF YOU ARE
SURE YOU REALLY WANT TO UPDATE THE INTERNAL DATABASE
TABLES.

TYPICALLY, YOU ONLY USE THISFUNCTION IF YOU WANT TO
UPDATE THE DOCUMENT NAME AND REFERENCE IN THE
DOCUMENT TABLE. ANY OTHER USE OF THISFUNCTION COULD
HAVE DISASTROUS CONSEQUENCES!
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Standard Ruletab
(Update)

Partsand
Functions

Forms Integration User Guide

Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Overview

Thisillustration describes the Update function.

Fleaze zelect the standard rule to use IUpdate

Fleaze zelect the table [or group] o update

- |

Flzaze zelect the colurmn [or figld] to update :

=

=

Cancel

[ o ]

Aapll Help

This table describes the parts and functions of the Update Standard Rule.

Part

Function

Please select a standard rule to use list

Identifies standard rule options.

Please select the table or group to update

Identifies tables or groups available for
update.

Please select the column or field to update

I dentifies which column or field available
for update.

OK Saves changes; exits the dialog box.
Cancdl Cancels changes; exits the dialog box.
Apply Unavailable.

Help Launches the Forms Integration online

Help system.
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Using Updatein a Form

Procedure  Usethis procedure to select the Update function.

Sep Action

1 Double-click an existing element, or create a new element.

System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties

Name IVaIidationI Displayl Help I Extended Hulel Standard Hulel Conditionsl

Please enter the name of this field :
|1 004

Pleaze enter a short description of this field -
DOCUMENT AMESSAGE MUMBER

Cancel | Soply | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Update in a Form

(Contd)
Sep Action
3 From the standard rule list, choose Update.
Element Properties E
Mame I Validationl Displa_l,ll Help I Extended Fule  Standard Rule |Conditions|
Fleaze zelect the standard rule to uge : IUpdate j
Please select the table [or group) to update :
| =
Flease select the column [or field) to update :
| =
Cancel | Lppl | Help |
4 Select the table from the table list that the system updates with the
contents of the current element. Valid values are:
» Document record (use to update the document name and reference)
» Generic envelope segment (advanced use only)
» Interchange (advanced use only)
» Group (advanced use only)
» Current partner (advanced use only)
» Document (advanced use only)
5 Select the element from the column (or field) list that the system updates

with the contents of the current el ement. The el ementsthat are availablein

thislist depend on the table selected.

Forms Integration User Guide
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Update Example: Document Name

Introduction ~ We recommend that you set up a Document Name for each form, to make the
identification of adocument created by this form easier in Sterling Gentran:Server. This
allows you to differentiate between documents in the document browsersin Sterling
Gentran:Server.

To set up aDocument Name, you must select an element in the form that contains data that
distinguishes the documents translated by this form. Then, the Name column of the
document browsers that contain this document contains the data from the selected
element.

Note

You can choose any element as the Document Name, but the element must only occur
once in the document and must have a data type of “String.” For a Purchase Order, the
document name is typically the Purchase Order Number.

Procedure  Use this procedure to set up the Document Name for an ANSI X 12 Purchase Order.

Sep Action

1 Double-click the BEG03 (0324) element.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E3

Mame |‘v"alidati0n| Print I Ertended Hulel Standard Hulel Conditionsl

Please enter the name of this field :
|0324

Fleaze enter a short description of this field ;
PURCHASE ORDER MUMBER

Cancel | Lppi | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Update Example: Document Name

(Contd)
Sep Action
3 From the standard rule list, choose Update.
Element Properties E
M ame I Validationl Displa_l,.ll Help I Extended Fule  Standard Rule | Eonditionsl
Pleaze zelect the standard rule to uge : ILlpdate j
Pleaze select the table [or group] to update
Pleaze select the column [or field) to update
Cancel | Lapp i | Help |
4 From the table list, choose Document Recor d.Thisindicates that you are
updating the document record in Sterling Gentran: Server.
5 From the column list, choose Document Name. This indicates that you

are updating the Name column in the document browsers with the contents
of this element.

System Response
The Standard Rule tab of the Element Properties dialog box should now
look like the following:

Element Properties

Marne | Validationl Frint I Extended Rule  Standard Rule | Conditionsl

Flease select the standard rule to usze IUpdate j

Please select the table [or group] to update :
I Daocumnent record j

Please select the column [or field) to update :
I Docurmnent Name j

EIK‘ Cancel épph‘ HE||:I

Forms Integration User Guide
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Using Standard Rules

(Contd)
Sep

Action

6

Click OK to set up the document name.
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Overview

Using the Use System Variable Standard Rule

Overview

I ntroduction

Sandard Ruletab
(Use System
Variable)

Partsand
Functions

The Use System Variable function enables you to set a variable that maps the current date
and time to a selected element with a data type of “Date/Time.”

Thisillustration describes the Use System Variable function.

Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Fleaze zelect the standard rule to use IUse Syztem Yariable j

Fleaze zelect a syztem variable to store in thiz field ;

00— -

Ok I Cancel | Spply | Help |

This table describes the parts and functions of the Use System Variable Standard Rule.

Part Function

Please select astandard ruleto uselist | Identifies standard rule options.

Please select a system variable to Identifies avail able system variables.

storeinthisfield list

OK Saves changes; exits the dialog box.

Cancel Cancels changes; exits the dialog box.

Apply Unavailable.

Help Launches the Forms Integration online Help
system.
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Using a System Variablein a Form

Procedure  Usethis procedure to use a system variable.

Sep Action
1 Double-click an existing element.
System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties
MName |Validati0n| Displa_l,.ll Help I E xtended Hulel Standard Hulel Eonditionsl
Please enter the name of this field :
|2380
Flease enter & shart description of thiz field :
DATEATIME/PERIOD
Cancel | Spply | Help |
2 Click the Sandard Rule tab to access standard rule options.
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(Contd)
Sep Action
3 From the standard rule list, choose Use System Variable.
Element Properties E
Mame | Validationl Displa_l,ll Help | Extended Rule  Standard Rule IEDnditionsI
Pleasze select the standard rule bo uze IUse System Variable j
Please select a system vanable to store in this field
Cancel | S | Help |
4 Select Current date and time from the system variable list to map those
variables to the element.
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Using the System Date and Time

Using Standard Rules

Introduction Sterling Gentran: Server enables you to update any element (that has a data type of “Date/
Time") with the current system date or time.

Procedure  Usethis procedure to update an element with the current system date or time.

Sep

Action

Double-click the desired element to display the Element Properties dialog

box (Name tab).

Element Properties

Harmne |Validati0n| Displa_l,ll Help | Estended F|u|e| Standard Hulel Eonditionsl

Flease enter the name of this fisld :

|2asn

Pleaze enter a short description of this fisld ;

DATE/TIME/PERIOD

Cancel |

Appl | Help |

Click the Sandar d Rule tab to access standard rule options.
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(Contd)
Sep Action
3 From the standard rule list, choose Use System Variable.
Element Properties E
Hame I Validationl Displa_l,ll Help | Extended Rule  Standard Rule |Eonditions|
Pleaze zelect the standard rule to use : IUse Syztem Vanable j
Pleaze select a system variable to store in thiz field :
Cancel | Sl | Help |
4 From the system variable list, select Current date and timeto update the
element with the current system date and time.
5 Click OK to set up the system variable.
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Using the Use Constant Standard Rule

Overview

Introduction The Use Constant function enables you to move aliteral constant value to the specified
element and indicate a qualifying relationship with another element.

Why constantsare  Constants are used in formsto hold information that is needed later in theformin a
used conditional statement. Typically, EDI qualifiers are typically generated from constants (to
indicate a qualifying relationship with another element).

Sandard Ruletab  Thisillustration describes the Use Constant function.

(Use Constant)

Mame I Validatinnl Frint I Extended Rule  Standard Rule |E0nditinns|

Please select the standard rule to uze IUse Constant j
Please select a constant to store in this field ;

[ o |

If this constant iz a qualifier for anather field, Gentran can automatically uze the
exiztence of data in that field to determine whether to execute thiz standard rule. To
take advantage of this feature, simply select the field to be qualified :

=

QK I Cancel | S | Help |

Partsand This table describes the parts and functions of the Use Constant Standard Rule.
Functions

Part Function

Please select astandard ruleto uselist | Identifies standard rule options.

Please select aconstant to storeinthis | Displays available literal constants.
field list.
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Part Function

Edit Accesses the Map Constants dialog box. This
dialog box enables you to add, change or
delete alitera constant.

Select thefield to be qualified I dentifies the field to which you want to
establish a qualifying relationship.

Note

If the qualified element is not generated dueto
lack of data, the constant is not moved to the
current element or field.

OK Saves changes; exits the dialog box.

Cancdl Cancels changes; exits the dialog box.

Apply Unavailable.

Help Launches the Forms Integration online Help
system.
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Using Constantsin a Form

Procedure  Usethis procedure to use a constant.

Sep Action

1 Double-click an existing element.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E

Hame |Validation| Print | Extended Flulel Standard FIuIeI Eonditionsl

Flease enter the name of this field :

|0235

Flease enter a short description of this figld ;
FRODUCT /SERYVICE 1D QUALIFIER

Cancel | Sl | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Constantsin a Form

(Contd)
Sep Action
3 From the standard rule list, select Use Constant.
Element Properties E
Marne I Validationl Pririt I Extended Fule  Standard Rule | Conditionsl
Fleasze select the standard rule to use IUse Constant j
Please select a constant to shore in this field :
| x| Edi. |
If thiz constant is a qualifier for another field, Gentran can automatically use the
existence of data in that field to determine whether to execute thiz standard rule. To
take advantage of thiz feature, simply select the field to be qualified :
Cancel | Lppl | Help |
4 Select a constant from the constant list. This constant is mapped to the
current element.
Note
If the necessary constant is not present in the constant list, you need to
create it by using the Map Constants dialog, which you can access by
clicking the Edit button.
Thisdialog aso allows you to edit and delete literal constants.
5 Select an element from the qualifieslist if you want to indicate that it

qualifies the selected element (establish a qualifying relationship between
the two elements).

Note
If the qualified element is not generated because of alack of data, the
constant is not moved to the current element.

Forms Integration User Guide
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Use Constant Example

Introduction The system uses literal constants as arepository to store information that is used at a later
point in the form. Typically, constants are used in aform to generate a qualifier. A
qualifier isan element that has a val ue expressed as a code that gives a specific meaning to
the function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

Procedure Inthisexample, you use a constant to define a qualifier for a Product/Service ID.

Sep Action

1 Double-click the Product/Service ID Qualifier that you want to use to
further define (qualify) the Product/Service ID.

System Response

The system displays the Element Properties dialog box (Name tab).

Element Properties E2
Hame |Validation| Print I Extended Hulel Standard Hulel Conditionsl

Please enter the name of this field :
|u235

Pleaze enter a short description of this field :
PRODUCTASERVICE ID QUALIFIER

Cancel | Al | Help |

2 Click the Sandard Rule tab to access standard rule options.

Sterling Gentran:Server — May 2011 Forms Integration User Guide



Using Standard Rules Use Constant Example

(Contd)
Sep Action
3 From the standard rule list, select Use Constant.
Element Properties E
Marne I Validationl Print | Extended Rule  Standard Rule IEDnditionsI
Please select the standard rule to uze IUse Constant j
Please select a constant bo store in this field :
f =] Edi. |
If thiz cohstant iz a qualifier for another field, Gentran can automatically uze the
existence of data in that field to detemine whether to execute this standard ule. To
take advantage of thiz feature, simply select the field to be qualified :
Cancel | Sl | Help
4 Click Edit to access the Map Constants dialog box.
Map Constants 5'
D Twpe  “Walue
Sub Table 1 Sting PRODCODE Close |
Change... |
Delete |
5 Click New to access the Edit Constant dialog box.
Ledal Lorislanl
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(Contd)
Sep Action

6 Inthe ID box, type the literal constant identifier. Thisistypicaly a
description of the element in which the constant is used. If you need to
refer to the constant in an extended rule, you should use the data from this
element.

7 From the Type list, select Sring because the Product/Service ID Qualifier
isformatted as a string data type. This indicates the category of the literal
constant.

8 In the Value box, type Ul to indicate that the Product/Service ID element
must contain the UPC Code. Thisisthe value of the literal constant.

9 Click OK to add the constant to the system.

10 Click Close to exit the Map Constants dialog box.

11 The Sandard Rule tab of the Element Properties dialog box should now
look like the following.

Element Properties E

Marne | Validationl Print | Extended Rule  Standard Rule ICDnditionsI

Please select the standard rule ta uze : IUse Caonstant j

Please select a constant bo store in this field ;
Jui =] Edi. |

If thiz cotstant iz a qualifier for another field, Gentran can automatically uze the
existence of data in that field to determine whether to execute this standard ule. To
take advantage of thiz feature, simply select the field to be qualified :

0234 FRODUCT /SERVICE ID j

Cancel | S | Help |

Note

When you set a constant value for a qualifier field, you know that you
never need to override the value in the field. In this instance, you would
probably hide the field, as well.

Reference
Please see Hiding Fields on page 7 - 3 for more information.

12 Click OK on the Element Properties dialog box and the qualifying
relationship between the two elements is established.
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Overview

Using Literal Congtants and Qualifying Relationships

Overview

Introduction This section describes how to use literal constants and qualifying relationships.

Literal Constants  Literal constants are used by the system as a repository to store information that is used
later in the form. You create the literal constant and nameit. You can “hard code” (enter) a
valuethat isloaded into the element that uses the constant. However, to use a constant (the
information that is stored in it), you need to use a standard rule, as explained bel ow.
Constants are typically used to define qualifying relationships.

Qualifying A qudifying relationship establishes arelationship between an element and its qualifier. A
Relationships  qualifier contains a code that further defines the element. Qualifying relationships are
defined using an standard rule.

Function Overview  You can perform the following functions with literal constants and qualifying
relationships:

Forms Integration User Guide

Defining Literal Constants
Editing Literal Constants
Deleting Literal Constants
Mapping Literal Constants
Generating Qualifiers
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Using Standard Rules

Defining Literal Constants

Procedure

Use this procedure to create a literal constant so you can use it to store information.

Sep

Action

Select Constants from the Edit menu or the Main Tool bar.

System Response
The system displays the Map Constants dialog box.

I ranilatinn [Thypeel anatants

I Tupe e

BLLOF Leome I &=
WENDOF

SHIF_TO
REMIT_TO
DEFT_FUMEER:
STORE_MUMWBER
UPC_CODE
ELIER_CODE
ORIGIHAL_CUeHTITY Dalale
FREE_FOAM

D TE_QLALIFIER

YENDORA_HUMEER

':E B

Click New.

System Response
The system displays the Edit Constant dialog box.

Lodul Lwrislanl

I Typa

| | E
|"""“’

In the ID box, typethe literal constant identifier. Thisistypically a
description of the element in which the constant is used. If you need to
refer to the constant in an extended rule, you should use the data from this
box.
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Using Standard Rules

Defining Literal Constants

(Contd)
Sep Action
4 From the Type list, select the category of thisliteral constant.
» Integer (select for numeric constants that are a positive or negative
natural (non-fraction) number or “0” (zero)
» Real (select for numeric constants that are a positive or negative
integer with an explicit decimal point)
» Sring (select for aphanumeric constants)
5 In the Value box, type the actual constant expression. Thisis the value of
the literal constant.
6 Click OK to add the constant to the system.
7 Click Close to exit the Map Constants dialog box.

Forms Integration User Guide
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Editing Literal Constants Using Standard Rules

Editing Literal Constants

Procedure  Usethis procedure to edit aliteral constant.

Sep Action

1 Select Constants from the Edit menu or the Main Tool bar.

System Response
The system displays the Map Constants dialog box.

Iranzlabinn [Thpeel |anstants

[u} Typ=  Welie
BILLOF_L*CONG '
“EMDOR

SHIP_TO
REMIT_TO

LEFT_NUMEEFR
STORE_MUMBER

I:IFlIEIH._I?I.L_IIILlll'uHTI'I"r' Dalala
FREE_FORM

DWTE_QLALIFIER

wENDOA_NUMABER

':S B

2 Highlight the constant you want to modify, and click Change.

System Response
The system displays the Edit Constant dialog box.

10 Tupe

|EILL_EIF_L.E\DINE |5tn‘ng H

“ahe Cers)

| EM
3 Make the changes to the constant, and click OK to accept the changes.
4 Click Close to exit the Map Constants dialog box.
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Using Standard Rules

Deleting Literal Constants

Deleting Literal Constants

Procedure

Use this procedure to delete aliteral constant.

Step

Action

1

Select Constants from the Edit menu or the Main Tool bar.

System Response
The system displays the Map Constants dialog box.

Iranzlabinn [Thpeel |anstants

[u} Typ=  Welie
BILL_OF_LADING

REMIT_TO
LEFT_NUMEER
STORE_MUMBER

Delals

':S B!

I:IHIEIH._U.L_IIILI.ll'uHTI'I"r'
FREE_FORM
DWTE_QLSLIFIER
YENDOA_NUMBER

Highlight the constant you want to delete.

Click Delete to remove the constant.

WARNING

THE CONSTANT ISDELETED WITHOUT WARNING.

Click Close to exit the Map Constants dialog box.

Forms Integration User Guide
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Using Literal Constants Using Standard Rules

Using Literal Constants

Procedure  Usethis procedure to use a constant in which you previously stored information using an

extended rule.
Sep Action
1 Double-click the element in which you want to use the constant.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E2

MName |Validation| Frint I Exrtended FIuIeI Standard Flulel Conditionsl

Pleaze enter the name of this field :
|0235

Please enter a short descrption of this figld :
PRODUCT/SERWICE 1D QUALIFIER

Cancel | Lpp | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Standard Rules Using Literal Constants

(Contd)
Sep Action
3 From the standard rule list, select Use Constant.
Element Properties E
Marne I Validationl Fririt | Extended Rule  Standard Rule |Eonditions|
Pleaze select the standard mile to uze IUse Constant j
Please select a constant to store in this field :
f x| = Edi. |
If thiz constant iz a qualifier for another field, Gentran can automatically uze the
existence of data in that field to determine whether to execute this standard rule. To
take advantage of thiz feature, simply zelect the field to be qualified :
Cancel | Sl | Help
4 From the constant list, select the constant that you want to use.
5 Click OK and the data that was stored in the selected constant is loaded in
the element.
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Generating Qualifiers

Introduction A qudlifier isan element that has avalue expressed as a code that gives a specific meaning
to the function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

Procedure  Usethis procedure to define qualifying relationships.

Sep Action

1 Double-click the element that you want to use to further define (qualify)
another element.

System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties E

MName |Validation| Frint I Exrtended FIuIel Standard Flulel Conditionsl

Pleaze enter the name of this field :

|0235

Please enter a short description of this fisld :
PRODUCT/SERWICE 1D QUALIFIER

Cancel | Lppl | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Standard Rules Generating Qualifiers

(Contd)
Sep Action

3 From the standard rule list, select Use Constant.

Element Properties

Marne I Validationl Print | Extended Rule  Standard Fule IEonditiDnsl

Please select the standard e to use : IUse Constant j

Pleasze select a constant to store in this field :
| x| Edi. |

If this constant is a qualifier for another field, Gentran can automatically use the
existence of data in that field to determine whether to execute this standard rule. To
take advantage of this feature, simply selact the field ta be qualified :

[

Cancel | Al | Help |

4 From the qualifies list, select the element that this element qualifies.

Note
Thislist contains only the other active elements in the same record or
segment as the qualifying element.

5 Click OK and the qualifying relationship between the two elementsis
established.

Note

When you set a constant value for aqualifier field, you know that you
never need to override the value in the field. In this instance, you would
probably hide the field, as well.

Reference
See Hiding Fields on page 7 - 3 for more information.
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Overview Using Standard Rules

Using the Use Accumulator Standard Rule
Overview

Introduction The Use Accumulator function gives you access to a set of numeric variables that you can
manipulate via numeric operations, and then transfer to and from elements. This function
enables you to add, change, or delete calculations for the element, including hash totals
(used to accumulate numeric element values, i.e., quantity, price, etc.). Thisfunction also
enables you to load the accumul ated total into a control total element, and use
accumulators. Accumulators are used generally for counting the occurrences of a specific
element or generating increasing or sequential segment or line item numbers.

Notes
» Accumulators are global variables.

» Accumulators are set to zero prior to being used in calculations.

» Theorder in which accumulator operations are performed depends on the hierarchical
order of the form components.

Sandard Ruletab Thisillustration describes the Use Accumulator function.

(Use Accumulator)
Element Properties E2

Mame I Validationl Pritat I Extended Rule  Standard Rule | Cnndilionsl

Flease zelect the standard rule to use IUse Accurmulator ﬂ

Primary Accurnulator Op1l Op2 0Op3 Op4d

Change...

Delete

N

ak I Cancel Sl Help
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Using Standard Rules Overview

Parts and This table describes the parts and functions of the Use Accumulator Standard Rule.
Functions

Part Function

Please select a standard rule | Identifies standard rule options.
touselist

Primary Accumulator Opl, | Listsexisting accumulators and their associated

Op2,0p3,0p4list operations that were created for this element.
New Accesses the Edit Accumulator Entry dialog box;
Enables you to define an accumulator.
Change Enables you to modify an existing accumulator.
Delete Deletes a selected accumul ator.
Note

The selected accumulator is deleted without warning.

OK Saves changes; exits the dialog box.

Cancel Cancels changes; exits the dialog box.

Apply Unavailable.

Help Launches the Forms Integration online Help system.
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Using an Accumulator in a Form Using Standard Rules

Using an Accumulator inaForm

Procedure  Usethis procedure to use the Use Accumulator function.

Sep Action

1 Double-click an existing element, or create a new element.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E2
Extended Rule | Standard Rule | Conditions
Hame I W alidation I Dizplay I Surrmary List | Help

Pleaze enter the name of this field :
|1 g2

Please enter a short descrption of this figld :
LIME ITEM MUMBER

Cancel | Lpp | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Standard Rules

Using an Accumulator in a Form

(Contd)
Sep Action
3 From the standard rule list, select Use Accumulator.
System Response
The screen should look like the following.
Element Properties
Mame I Walidation | Dizplay | Summarny List I Help
Extended Fule Standard Rule Conditions
Pleaze zelect the standard rule to use : IUse Aocumulatar j
Primary Aaccumulator Op1 0OpZ2 0Op3 Opd
Mew...
Change. .. |
Delete |
Cancel | Sl | Help |
4 The Primary Accumulator list contains all existing cal culations that were
created for this element. Do you want to create a new calculation for this
entry?
» If yes, click New to access the Edit Accumulator Entry dialog box.
Proceed to the next step.
Reference
Please see Using an Accumulator in a Formon page 5 - 50 for more
information.
» If no, proceed to the next step.
5 Do you want to change an existing Primary Accumulator entry?

If yes, highlight a calculation in the Primary Accumulator list and
click Changeto access the Edit Accumulator Entry dialog box to edit
the selected calculation. Proceed to the next step.

Reference
Please see Using an Accumulator in a Formon page 5 - 50 for more

information.

If no, proceed to the next step.

Forms Integration User Guide
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Using an Accumulator in a Form Using Standard Rules

(Contd)
Sep

Action

6

Do you want to delete an existing Primary Accumulator entry?

» If yes, highlight acalculation in the Primary Accumulator list and
click Delete.

WARNING

THE SELECTED CALCULATION ISDELETED
WITHOUT WARNING.

» If no, proceed to the next step.

Verify that your entries are accurate, and click OK.

System Response
You exit the Element Properties dialog box.
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Using Standard Rules Use Accumulator Example: Counting Line Items

Use Accumulator Example: Counting Line Items

Introduction In this example, you want an incremental count of the number of lineitems for a screen
entry tranglation object, and you want to use that total value in the Number of Line Items
Total element.

Procedure  Usethis procedure to count line items and generate a control total for an ANSI X12

purchase order.
Sep Action
1 Double-click the P0101 element (in the PO1 segment in the PO1 group).

Thisisthe element that you typically use to count the line items.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties
Extended Rule I Standard Rule I Conditions
Mame | Walidation I Dizplay I Summary List | Help

Fleaze enter the name of this field :
|0350

Flease enter a short description of this figld ;
4SSIGHED IDEMTIFICATION

Cancel | i | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Use Accumulator Example: Counting Line Items

Using Standard Rules

(Contd)
Sep Action
3 From the standard rule list, select Use Accumulator.
Element Properties
MHame I Walidation | Dizplay | Summary List | Help
Extended Rule Standard Rule Conditions
Fleasze select the standard mile to use ILlse Accunnulatar j
Primary Accumulator Op1 0Op2 0Op3d Opd
e,
Change... |
Delete |
Cancel Lapp i Help
4 Click New.
System Response
The system displays the Edit Accumulator Entry dialog box.
Edin Azcumulaton Entry
Prirmany Acurulstor I :I Marma I | i I
pefaliore Cancel I
Frzl I |£| Bliemate ﬁl:cu'nl I:I

Sezand I Ii:I
Thd | E|
Foulh | [z
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Using Standard Rules Use Accumulator Example: Counting Line Items

(Contd)
Sep Action

5 Select a Primary Accumulator from the list. Before any calculations are
performed on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of thislist.

For this example, select primary accumulator “0.”

Note

Thereis only one set of accumulators for each form. This means that
accumulator “0,” whether it is used in the Primary Accumulator or
Alternate Accum box is the same accumulator with the same contents. If
you assign calculations to accumulator “0” at the beginning of the form
and then use accumulator “0” again later in the form, the content of that
accumulator is the result of the earlier calculation. Any additional
calculations you assign to that accumulator are performed on the contents
resulting from an earlier calculation.

6 In the Name box, type Line Item Number. Thisis adescriptive alias that
enables you to differentiate what the accumulators you create are used for.

7 From the First list, select Increment Primary. Thisisthe first operation
that the system performs. This specifies that the system will increment the
PO101 element by one.

Note
The First box is active only after you select a Primary Accumulator.

8 The valid selections for the First box are defined as follows:

» Increment primary adds“1” (one) to the contents of the Primary
Accumulator (i.e., Primary = Primary + 1).

» Decrement primary subtracts“1” (one) from the contents of the
Primary Accumulator (i.e., Primary = Primary - 1).

» Sumin primary adds the numeric value (takes the positive or
negative sign of the numbersinto account) of the field to the contents
of the Primary Accumulator (i.e., Primary = (+/-)Primary +
(+/-)Element).

» Hash sumin primary adds the absolute value (does not take the
positive or negative sign of the numbers into account) of the element
to the contents of the Primary Accumulator (i.e., Primary + Element).

» Load primary loads the contents of the element into the Primary
Accumulator (i.e., Primary = Element).

» Useprimary loads the contents of the Primary Accumulator into the
element (i.e., Element = Primary).

» Zeroprimary setsthe value of the Primary Accumulator to zero (i.e.,
Primary = 0).
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Use Accumulator Example: Counting Line Items Using Standard Rules

(Contd)
Sep Action
8 » Multiply with primary multiplies the el ement with the contents of
(cont.) the Primary Accumulator, and stores the result in the Primary

Accumulator (i.e., Primary = Primary * Element).

» Divideby primary divides the element with the contents of the
Primary Accumulator, and stores the result in the Primary
Accumulator (i.e., Primary = Element / Primary).

» Divideprimary by field divides the contents of the Primary
Accumulator with the element, and stores the result in the Primary
Accumulator (i.e., Primary = Primary / Element).

» Modulowith primary divides the contents of the element with the
contents of the Primary Accumulator, and stores the remainder of that
operation in the Primary Accumulator (i.e., Primary = Primary %
Element).

» Modulowith field divides the contents of the Primary Accumulator
with the contents of the element, and stores the remainder of that
operation in the Primary Accumulator (i.e., Primary = Element %
Primary).

» Negate primary makes the contents of the Primary Accumulator
negative (i.e., Primary = Primary * -1).

Note

The only way to subtract the Primary Accumulator from the element isto
“Negate” the Primary Accumulator and then use the “ Sum in primary”
operation to add the negative Primary Accumulator to the element.

» Moveprimary to alternate copies the contents of the Primary
Accumulator to the Alternate Accum. This overwrites the current
contents of the Alternate Accum field (i.e., Alternate = Primary).

» Add primary to alter nate adds the contents of the Primary
Accumulator to the contents of the Alternate Accum, and stores the
result in the Primary Accumulator (i.e., Primary = Primary +
Alternate).

» Multiply primary by alter nate multiplies the contents of the
Primary Accumulator with the contents of the Alternate Accum, and
stores the result in the Primary Accumulator (i.e., Primary = Primary
* Alternate).

» Accumulator (i.e., Primary = Primary % Alternate).

» Divideprimary by alternate divides the contents of the Primary
Accumulator with the contents of the Alternate Accum, and storesthe
result in the Primary Accumulator (i.e., Primary = Primary /
Alternate).

» Modulo primary with alter nate divides the contents of the Primary
Accumulator with the contents of the Alternate Accum, and storesthe
remainder of that operation in the Primary A
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Using Standard Rules

Use Accumulator Example: Counting Line Items

(Contd)
Sep

Action

9

From the Second list, select Use primary. Thisis the second operation
that the system performs, after the First operation is completed. This
specifies that the system loads the current value of the accumulator into
the P0101 (Assigned Identification) element.

The values for the Second, Third, and Fourth boxes are listed above.

Note

The Second box is active only after you select a First operation that does
not involve the Alternate Accum. The Third box is active only after you
select a Second operation. The Fourth box is active only after you select a
Third operation.

10

Click OK to add the accumulator.

System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties E

M amme I Walidation |
Extended Rule

Display | Surmary List | Help

Standard Fule Conditions

I Use Accumulator j

Primary Accumulator Opl1 0Op2 0Op3d Opd
O-Line Item Mumber Ine  Usze

Flease select the standard rule to use

MNew...
Change...

Delete

i

Appl | Help |

Cancel |

11

Click OK on the Element Properties dialog box to add the standard rule to
the PO101 element.

Forms Integration User Guide
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Use Accumulator Example: Counting Line Items Using Standard Rules

(Contd)
Sep

Action

12

Double-click the CTTOL element (in the CTT segment). Thisisthe
element that typically contains the total number of lineitems.

System Response

The system displays the Element Properties dialog box (Name tab).

Element Properties
Hame |Validation| Displa_l,ll Help I E stended Hulel Standard Hulel Conditionsl

Please enter the: name: of this field :
|0354

Please enter a short description of this field :
WUMEER OF LIME ITEMS

Cancel | Al | Help |

13

Click the Sandard Rule tab to access standard rule options.

14

From the standard rule list, select Use Accumulator.

15

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

16

From the Primary Accumulator list, select primary accumulator O. This
accumulator currently contains the total number of lineitems.

17

FromtheFirst list, select Use primary to specify that the system loads the
current value of the accumulator into the CTTO1 (Number of Line Items
Total) element.

The Edit Accumulator Entry dialog box should now look like this:

Primar, &equruister [0 [2] Memm ILineIlJarn Numbsr | ifik |
peraliors: [ o |
Frsl  [Useorimay (2] slemate e | [z]

Sesod | g
Thd | 1zl
Foulh | [z]
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Using Standard Rules Use Accumulator Example: Counting Line Items

(Contd)
Sep Action

18 Click OK to add the accumulator.

System Response

The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties

Mame I Validationl Displa_l,ll Help | Extended Rule  Standard Rule I Eonditionsl

Flease select the standard rule to uze IUse Accumulator j
Frimary Accumulator Op1 Op2 0Op3 Opd
O-Line ltem Mumber Use Mew. ..

Change...

Delete

i

Cancel | A i1 | Help |

19 Click OK onthe Element Properties dialog box to add the standard rule to
the CTTO1 element.

The CTTO1 element now contains the total number of lineitemsin the
purchase order.

Note

If you are adding this accumulator to a screen entry translation object, you
would typically set the CTTO1 field to display-only.
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Use Accumulator Example: Calculating Hash Totals Using Standard Rules

Use Accumulator Example: Calculating Hasnh Totals

Introduction In this example, you want to count the quantity ordered for each line item and load the
total quantity inthe CTTO02 (Hash Total) element for a screen entry tranglation object.

Procedure  Usethis procedure to calculate a hash total for an ANSI X 12 purchase order.

Sep Action

1 Double-click the P0102 element (in the PO1 segment in the PO1 group).
Thisisthe element that you typically use to count the line items.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties
Extended Rule I Standard Rule | Conditions
Hame I Walidation | Dizplay I Surarmary List I Help

Pleaze enter the name of this field :
|0330

Please enter a short descrption of this figld :
QUANTITY ORDERED

Cancel | Lpply | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select Use Accumulator.
4 Click New to access the Edit Accumulator Entry dialog box to create a

new calculation for this element.

5 Select a Primary Accumulator from the list. Before any calculations are
performed on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of thislist.

For this example, select primary accumulator “1.”

6 In the Name box, type Total Quantity. Thisis adescriptive aias that
enables you to differentiate what the accumulators you create are used for.
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Using Standard Rules

Use Accumulator Example: Calculating Hash Totals

(Contd)
Sep Action
7 From the First list, select Hash Sum in Primary.
Note
Thisisthefirst operation that the system performs. This specifies that the
system will add the numeric value of the PO102 element to the contents of
the Primary Accumulator.
8 Click OK to add the accumulator.
9 Click OK onthe Element Properties dialog box to add the standard rule to
the PO102 element.
10 Double-click the CTT02 element (in the CTT segment). Thisisthe
element that typically contains the total quantity of the purchase order.
System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties
Name |Validation| Displa_l.JI Help I Estended Hulel Standard Hulel Conditionsl
Fleaze enter the name of this field :
|034?
Fleaze enter & shart description of thiz field :
HASH TOTAL
Cancel | Spply | Help |
11 Click the Sandard Rule tab to access standard rule options.
12 From the standard rule list, select Use Accumulator.
13 Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.
14 From the Primary Accumulator list, select primary accumulator 1. This

accumulator currently contains the total quantity.

Forms Integration User Guide
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Use Accumulator Example: Calculating Hash Totals

Using Standard Rules

(Contd)
Sep

Action

15

FromtheFirst list, select Use primary. The system |loads the current value
of the accumulator into the CTTO02 (Hash Total) element.

System Response
The Edit Accumulator Entry dialog should now look like this:

Ldal e umulalin Labig

Frimag &ccumiaioe |1 [2] Wame [Tornl Guarsy g ]
perabiar Canel
Firsd  |Lios primanp (2] Atemars dccum | [x]

Secord | B

Thed | [£]

Fauth | [2]

16

Click OK to add the accumul ator.

System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties E

Hame I Validationl Displayl Help I Extended Fule  Standard Rule ICUnditionsI

Flease select the standard rule to use : IUse Accurmnulator j
Primary Accumulatar Opl1 0QOp2 0Op32 Opd
1-Total Quantity Use Mew...

Change...

Delete

i

Cancel | Al | Help |

17

Click OK on the Element Properties dialog box to add the standard rule to
the CTTO02 element. The CTTO02 element now contains the total quantity
of the purchase order.
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Use Accumulator Example: Resetting and Calculating a Vaue Total

Use Accumulator Example: Resetting and Calculating a

Value Total

I ntroduction

How to multiply
quantity invoiced
by unit price

In this example, you want to multiply the quantity invoiced for each line item by the unit
price to obtain the extended price for a screen entry translation object. Then, you want to
generate arunning total of extended price and load the final total into the TDSO1 (Total
Invoice Amount) element.

Use this procedure to multiply the quantity invoiced for each line item by the unit price to
obtain the extended price for an ANSI X12 invoice.

Sep Action

1 Double-click the I T102 element (in the IT1 segment in the IT1 group).
Thisisthe element that you typically use to count the quantity invoiced.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E3
Extended Rule | Standard Rule | Conditions
Hame I W alidation I Display I Summary List | Help

Please enter the name of this field :
|0358

Pleaze enter a short description of this figld |
QUANTITY IMVOICED

Cancel | Sl | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select Use Accumulator.
4 Click New to access the Edit Accumulator Entry dialog box to create a

new calculation for this element.

5 Select primary accumulator 2.
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Use Accumulator Example: Resetting and Calculating a VValue Total

Using Standard Rules

(Contd)
Sep

Action

6

In the Name box, type Extended Price. Thisis a descriptive alias that
enables you to differentiate what the accumulators you create are used for.

From the First list, select L oad primary.The system loads the contents of
the element into the Primary Accumulator for each iteration of the IT1

group.

System Response
The Edit Accumulator Entry dialog box should now look like this:

[ Lt Accunoaladen Loty

Frimaip Accumdalo |2 :I Nurrn:IEmd:dFliﬁ: Ik

Dpasrasi

Fral |L-:-a-:||:11'ma:.' H Alleinala Accum | H

Second | H
Thid | [2]
Farth | (4]

Click OK to add the accumulator.

System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties
Mame I Yalidation | Dizplay | Summary List | Help
Extended Fiule Standard Rule I Conditions

I I ge Accumulator j

Primary Accumulator Op1 Op2 0Op3 Op4
2-Eutended Price Load e,

Please select the standard mile to use

Change...

Delete

i

Cancel | Lappl i | Help |

Click OK onthe Element Properties dialog box to add the standard rule to
the 1T102 element.
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Using Standard Rules Use Accumulator Example: Resetting and Calculating a Vaue Total

(Contd)
Sep Action

10 Double-click the I T104 element (in the IT1 segment in the IT1 group).
Thisisthe element that contains the unit price for each line item.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E2
Extended Rule | Standard Rule | Conditions
Hame I W alidation I Dizplay I Surrmary List | Help
Pleaze enter the name of thiz field :
|021 2
Please enter a short descrption of this figld :
UNIT PRICE
Cancel | Lpp | Help |
11 Click the Sandard Rule tab to access standard rule options.
12 From the standard rule list, select Use Accumulator.

13 Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14 Select primary accumulator 2.
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Use Accumulator Example: Resetting and Calculating a VValue Total Using Standard Rules

(Contd)
Sep

Action

15

From the First list, select Multiply with primary. The system multiplies
the value of the IT104 (Unit Price) element with the contents of the
primary accumulator, and stores the result in the primary accumulator for
each iteration of the IT1 group.

System Response
The Edit Accumulator Entry dialog box should now look like this:

Edit Accumulaton Entry
Pimay doouriigtor [ |2 N | e ]
-Operalioee m
Fisl | [2] Aiemate oo | (=]

sesond | H

Thd | [z]

Fouh | [2]

16

Click OK to add the accumulator.

System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties
Mame | W alidation | Dizplay | Summary List I Help
Extended Rule Standard Rule | Conditions
Please select the standard rule bo uze IUse Aceurnulator j
Primary Accurmnulaton Op1 Op2 0Op3 Opd
2-Extended Price Fult Mew...

Change. ..

i

Delete

T Cancel Apply Help
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Use Accumulator Example: Resetting and Calculating a Vaue Total

(Contd)
Sep Action
17 Click OK onthe Element Properties dialog box to add the standard rule to

the IT104 element.

Note

If there is an extended price element in your EDI file, you could load the
total from the extended price calculation into that element. To do this, you
need to use an accumulator on that extended price element that specifies
“Use primary” for accumulator 2.

How to generatea

Use this procedure to generate a running total of the extended price.

running total of
extended price

Step

Action

Double-click the I T104 element (in the IT1 segment in the I T1 group).
Thisisthe element that contains the unit price for each line item.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties
Extended Rule I Standard Rule I Conditions
Mame | Yalidation I Dizplay I Summary List | Help

Flease enter the name of this fisld :

|021 2

Pleaze enter a short description of this fisld ;

UMIT PRICE

EET p— Sl Help

Forms Integration User Guide
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Use Accumulator Example: Resetting and Calculating a VValue Total

Using Standard Rules

(Contd)
Sep

Action

2

On the Standard Rule tab, you already established one accumulator that is
displayedin thelist.

Element Properties E2
M arne | W alidation | Dizplay | Sumrnary List | Help
Extended Rule Standard Fule Conditions
Flease select the standard rule to use IUse Accurnulator j
Primary Accumulatar Opl1 0Op2 0Op3d Opd
2-Estended Price hult Mew...

Change...

Delete

i

Cancel | Al | Help |

Click New to access the Edit Accumulator Entry dialog box to create
another calculation for this element.

Select primary accumulator 3.

In the Name box, type Running Total.

Fromthe First list, select Add primary to alter nate. The system adds the
contents of the primary accumulator to the contents of the alternate
accumulator, and stores the result in the primary accumulator for each
iteration of the IT1 group.
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Using Standard Rules Use Accumulator Example: Resetting and Calculating a Vaue Total

(Contd)
Sep Action
7 From the Alternate Accum list, select 2. The system adds the val ue of
accumulator “2” (which contains the extended price for aline item) to the
value of accumulator “3.” The system stores the sum in accumulator “3,”
which therefore contains arunning total of the extended price with each
iteration of the IT1 group.
System Response
The Edit Accumulator Entry dialog box should now look like this:
Priman Acoumulztor IS :l Hama Ithqing Tatd I [ I
PEXalice e ’m
Frel I.t'-‘.dl:l primany bo akainala H Ellamata Accun IE H
Second I |__*_I
Thrd | [z]
Foulh | [£]
8 Click OK to add the accumulator.
System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:
Element Properties
Mame I Walidation | Dizplay | Summary List | Help
Extended Fiule Standard Rule I Conditions
Pleaze zelect the standard rule to use : IUse Azcumulator j
Primary Accumulator Op1 0OpZ2 0Op3 Opd
2-E rtended Price Fulk Mew. .
3Running Total AddPa,
Change... |
Delete |
Cancel | Sl | Help |
9 Click OK on the Element Properties dialog box to add the standard rule to
the IT104 element.
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Use Accumulator Example: Resetting and Calculating a VValue Total Using Standard Rules

Howtoloada  Usethisprocedure to load the running total of the extended price into the TDS01 (Total
running total of  Invoice Amount) element.

extended price

Sep Action

1 Double-click the TDS01 element. Thisis the element that contains the
total invoice amount for each line item.

System Response

The system displays the Element Properties dialog box (Name tab).

Element Properties
Hame |Validation| Displa_l,ll Help | E utetded Hulel Standard Flulel Eonditionsl

Please enter the name of this figld :
|0351

Fleaze enter a short description of this field :
TOTAL INYOICE sk OUNT

Cancel | Sl | Help |
2 Click the Sandar d Rule tab to access standard rule options.
3 From the standard rule list, select Use Accumulator.
4 Click New to access the Edit Accumulator Entry dialog box to create a

new calculation for this element.

5 Select primary accumulator 3.
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Using Standard Rules Use Accumulator Example: Resetting and Calculating a Vaue Total

(Contd)
Sep Action
6 From the First list, select Use primary. The system |oads the contents of
the primary accumulator into the TDS01 (Total Invoice Amount) element.
System Response
The Edit Accumulator Entry dialog box should now look like this:
Piimap Accoradnter |3 [&] Heme |Hu«r'ng Totad | ik l
-OinBnations [ Cawm |
Rist IIJmplimly H n‘-'ulzlnd:eﬂmnuﬂl H
Bean | [2]
| B|
Fot | B
7 Click OK to add the accumulator.
System Response
The Standard Rule tab of the Element Properties dialog box should now
look like this:
Hame I \-‘alidationl Displayl Help I Extended Fule  Standard Rule | Condilionsl
Please select the standard rule to use IUse Accurmulator j
Frirmary Accumulator Op1 Op2 0Op3 0Op4
3-Runrning Tatal Use MHew...
Change... |
Delets |
Cancel | Sl | Help |
8 Click OK on the Element Properties dialog box to add the standard rule to
the TDSO1 element.
Note
If you are adding this accumulator to a screen entry translation object, you
would typically set the TDS01 element to display-only.
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Using Standard Rules

Using the Loop Count Standard Rule

Overview

I ntroduction

Sandard Ruletab
(Loop Count)

Partsand
Functions

The Loop Count function enables you to obtain the value of the current loop count, if the
element is part of aloop. If the loop is anested loop, you can track the current loop or the
outer loop. For example, if the Y loop is nested within the X loop, and the Y loop has
cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the“3” (X loop).

Thisillustration describes the Loop Count function.

Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Fleasze select the standard rule to uge :

Fleaze zelect a group to count

00— -

ILDDD Count j

o]

Cancel | i | Help |

This table describes the parts and functions of the Loop Count Standard Rule.

Part

Function

Please select astandard rule
touselist

I dentifies standard rule options.

Please select agroup to Identifies the group for which you want to obtain aloop

count count. If aloop is nested, you can track the current loop
or the outer loop.

OK Saves changes; exits the dialog box.

Cancd Cancels changes; exits the dialog box.
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Overview

(Contd)
Part

Function

Apply

Unavailable.

Help

Launches the Forms Integration online Help system.

Forms Integration User Guide
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Using Loop Count in aForm Using Standard Rules

Using Loop Count in a Form

Procedure  Usethis procedure to use the Loop Count function.

Sep Action

1 Double-click an existing element, or create anew element

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties
Extended Rule I Standard Rule I Conditions
Hame I Walidation | Dizplay | Surmrnany List I Help

Fleaze enter the name of this field :

|1 082

Please enter a short description of this field ©
LIME ITEM NUMBER

Cancel | S | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Standard Rules Using Loop Count in aForm

(Contd)
Sep Action
3 From the standard rule list, select L oop Count.
Element Properties E
Mame | alidation | Dizplay | Summary List I Help
Extended Rule Standard Rule I Conditions
Fleasze select the standard rule to uge ILDDD Count j
Flease zelect a group to count :
=
Cancel | Soply | Help |

4 In the Please select agroup to count text box, select the loop that you want
to obtain the current value of the loop count.
Note
If theloop is anested loop, you can track the current loop or the outer
loop.
Example
If the Y loop is nested within the X loop, and the Y loop has cycled
through 15 iterations and the X loop has cycled through 3 iterations, you
can choose to count either the “15” (Y loop) or the “3” (X loop).

5 Verify that your entries are accurate, and click OK.
System Response
You exit the Element Properties dialog box.
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Using the Use Code Standard Rule
Overview

Introduction The Use Code function enables you to select an element from a predefined code table and
specify whether or not acompliance error is generated if the element does not contain one
of the valuesin the code table for screen entry trandlation objects. The Use Code function
enables you to extract and print the description of a code for print translation objects.

Creatingcode  The Forms Integration subsystem enables you to create code tables to be used with the
tablesin Forms  current form. You can set up code tables in the Forms Integration subsystem to function
Integration like the partner cross-reference and lookup tablesin Sterling Gentran: Server. However,
code tables that are set up in the Forms Integration subsystem can be used only for the
current form. Code tables that you create in Sterling Gentran:Server can be used globally
for al forms.

UsingtheUse  An element with a Use Code rule enables values to either be checked against or selected
Codefunction from the codes in a specified code table. Codes are typically used to further qualify
another element.

Example

If the XX element contains address information, you can further qualify that element by
choosing the code “ SU” from the 0222 table. In the 0222 table, the code “SU” is described
asa"“supplier'saddress.” Therefore, by using this code with the XX element, you are
indicating that the XX element is not just address information, but address information for
the supplier.

Related topic ~ See Defining a Code List on page 5 - 87 for more information.
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Using Standard Rules Overview

Sandard Ruletab  Thisillustration describes the Use Code function.
(Use Code)

Element Properties E

M ame I Validatinnl Displayl Help I Extended Rule  Standard Rule |E0nditinns|

Please zelact the standard rule bo uze IUse Code j

Please zelact the code list to uze

[ o |

™ Raise a compliance enor if the code is not found in the list

If you would like the description of the code ta be stared in a field, please
zelect that field below :

| i

QK. I Cancel | Lpply | Help |

Partsand This table describes the parts and functions of the Use Code Standard Rule.
Functions

Part Function

Please select a standard rule to I dentifies standard rule options.
use list

Please select acodelist to use Displays available code lists.

list.

Edit Accessesthe Edit Code List dialog box. Thisdialog
box enables you to add, change, delete or load a
code list.

Raise acompliance error if the Specifies whether you want the system to generate
codeisnot foundinthelist check | acompliance error if the element does not contain
box one of the codes from the specified table (nothing
elseisvalid for that field).
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(Contd)
Part Function

If youwould like adescription of | Displays elements where you want the description

the code to be stored in afield, of the code that is used to appear when the selection

please select the field below list | ismade.

box
Example
If the codeis SU, it much more useful to view the
description of the code (suppliers address). If you
selected element XX from the store description list,
the description for the code use is mapped to
element XX.

OK Saves changes; exits the dialog box.

Cancel Cancels changes; exits the dialog box.

Apply Unavailable.

Help Launches the Forms Integration online Help
system.
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Using Use Code in aForm

Using Use Codein a Form

Procedure  Usethis procedure to use the Use Code function.

Sep Action
1 Double-click an existing element, or create a new element .
System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties
Hame | Walidation | Print | Extended Rule I Standard Rule I Conditions I
Please enter the: name: of this figld :
IDDSB
Fleaze enter a short description of this field :
ENTITY IDEMTIFIER CODE
Cancel | Sl | Help |
2 Click the Sandard Rule tab to access standard rule options.

Forms Integration User Guide
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Using Use Code in a Form Using Standard Rules

(Contd)
Sep Action

3 From the standard rule list, select Use Code.

Element Properties

Marne | Validalionl Fritat I Extended Rule  Standard Rule | Eonditionsl

Please select the standard rule to uze : IUse Code j

Flease select the code list to use :

| = Ed.. |

I Raise a compliance emar if the code is not found in the list

If you wauld like the description of the code ta be stared in a field, pleaze
zelect that field below :

| =

Cancel | Lppl | Help |

4 Isthe code list that you want to use listed in the Please select the code list
to use drop-down list?

» If yes, select that code list and proceed to the next step.

» If no, click Edit to accessthe Edit Code List dialog box. This enables
you to load or create a code table. Proceed to the next step.

5 Must the element contain, for compliance reasons, one of the codes from
the specified table (nothing elseisvalid for that field?

» If yes, select the compliance error check box. Proceed to the next step.

Example

If an element is defined as containing only “YES” or “NO,” you can
set up an exclusive code table that containsonly YES and NO. Then if
you receive a“MAYBE” in that element, the system flagsit asan
error.

» If no, verify that the compliance error check box is not selected.
Proceed to the next step.
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Using Standard Rules

Using Use Code in aForm

(Contd)
Sep Action
6 Do you want the code description to be stored in afield?

If yes, select an element from the drop-down list where you want the
description of the code (that is used) to appear when the selection is
made. Proceed to the next step.

Example
If the codeis“SU,” it is much more useful to view the description of

the code (“ Supplier's Address). If you selected element “XX” from
the store description list, the description for the code used is mapped
to element “ X X.”

If no, proceed to the next step.

Forms Integration User Guide
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Use Code Example: Selecting a Code List Item Using Standard Rules

Use Code Example: Selecting a CodeList Item

Introduction For this example you need to have alist displayed during data entry, so the user can select
your partner’s customer product code. Therefore, you need to establish and use a code
table with the Product Service ID Qualifier.

Procedure  Usethis procedure to select from a code list table.

Sep

Action

Load the code list table from the standard for the Product/Service ID
Qualifier element.

Reference
Please see Loading a Code List Table from the Sandard on page 5 - 98 or
more information.

Note

Please note that the standards provide code list tables only for elements
that use them. For example, in the TD4 segment, the TD401 (Specia
Handling Code) and TD403 (Hazardous Material Class Code) have code
tables provided by the standard.

Define a code list table for the Product/Service ID Qualifier element that
only contains the code value “BP” (Buyer’s Part Number).

Reference
Please see Defining a Code List on page 5 - 87 for more information.
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Use Code Example: Selecting a Code List Item

(Contd)
Sep Action
3 Double-click the element for which you need to validate data against a
code table (Product/Service ID Qualifier).
System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties
MName I Walidation I Frirt I Extended Rule | Standard Rule I Conditians I
Please enter the name of this field :
|0235
Fleaze enter a short description of this field :
PRODUCT/SERWICE 1D QUALIFIER
Cancel | Lpply | Help |
4 Click the Sandard Rule tab to access standard rule options.
5 From the standard rule list, select Use Code.
Element Properties E
MHame I Walidation I Print I Extended Rule  Standard Rule | Conditions I
Flease select the standard rule to use : IUse Code j
Please select the code lizt o uze
| = Ed... |
™ Raise a compliance ermor if the code is not found in the list
If you would like the descrption of the code to be stored in a field, please
select that field below :
Cancel | Lppl | Help |
6 From the code list, select the code list table that the datain this element is

validated against (0235).

Forms Integration User Guide
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Use Code Example: Selecting a Code List Item Using Standard Rules

(Contd)
Sep Action
7 If you need to specify that, for compliance reasons, the element must
contain one of the codes from the specified table (nothing elseisvalid for
that element), select the compliance error check box.
8 Click OK to add this standard rule to the element.
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Overview

Using Code List Tables

Overview

I ntroduction

Use Code Sandard
Rule

Codelist function

Code List Tables are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined with a code.

Sterling Gentran:Server allows you to load code lists from the standard. You can either
load all the codes in the table, or you can select only one or more codes from the table.

Once you load or create a code table, you can use a“Use Code” standard rule. For screen
entry translation objects, you can use it to select an element from alist that contains a
predefined code table. You can a so specify whether or not acompliance error is generated
if the element does not contain one of the values in the code table. For print translation
objects, the Use Code function enables you to extract and print the description of a code
and validate the contents of a element against the values in the code table for print
tranglation objects.

The Code List function also enables you to store a code's description in an element/field,
create a unigque code table, use code values from a code table, and flag whether or not the
system will generate an error if avalidation against the code table fails. You can import
and export code lists and copy and paste code lists between forms.

An element with a Use Code standard rule applied to it allows values to either be checked
against or selected from the codes in a specified code table. Codes are typically used to
further qualify the element.

Example

The Product/Service ID (0234) element contains a product code that you expect to be the
customer's product code. If you receive avaue in that element that is something other
than the customer's product code, you want the system to generate an error. So, you first
use the code table for the Product/Service ID Qualifier (0235), but specify when you load
it that the code table should only include the code “BP.” In this code table, the code “BP”
isdescribed asa“Buyer’s Part Number.” Then, you make the 0235 code table exclusive
for the Product/Service ID Qualifier (0235) element. Therefore, by using this code with
the qualifier for the Product/Service ID element, you are indicating that the Product/
Service ID element must contain not just a product code, but product code from the
customer.
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CodelList Table  You can perform the following functions with Code List Tables:
functions pefining aCodeList
» Modifying aCode List or Code List Entry
» DeéetingaCodeList or Code List Entry
» Importing aCode List
» Exporting aCode List
» Loading Code Tables from the Standard
» Copying and Pasting Code Lists
» Validating Data Against Code List Tables
» Loading Code Item Descriptions
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Defininga Code List

Defining a Code List

Procedure  Usethis procedure to define a code list table.

Sep Action
1 Select Code Lists from the Edit menu or the Main Toolbar.
System Response
The system displays the Code Lists dialog box.
Leodc Lisls
Tahle T [ezcnphion
£33 BRG] o=
Pate
2 Click New to access the Edit Code List dialog box.
Falit Camle 1 il
~Tabke Delails
Tale I Desc [
Allawed Codes [
Codaale Decariplion
3 In the Table ID box, type the name of the element for which this code list
tableis used.
4 In the Description box, type the description of the element for which this

code list table is used.

Forms Integration User Guide
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Defining a Code List Using Standard Rules

(Contd)
Sep Action
5 Click New to access the Edit Code List Entry dialog box.
Edit Codc Lict Entre
Makie
O eripbion | Cance I

6 In the Value box, type the actual value of the code.

7 In the Description box, type a description of the code value. The code
value description is used if you specify an element to which you want the
code description mapped.

8 Click OK to save the code list entry.

9 Repeat Step 5 through Step 8 to add more code list entries to the code list
table.

10 Click Close to save and exit the Edit Code List dialog box.

11 Click Close to exit the Code Lists dialog box.
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Modifying a Code List

Procedure  Usethis procedure to modify acode list table or code list entry.

Sep Action

1 Select Code Lists from the Edit menu or the Main Toolbar.

System Response
The system displays the Code Lists dialog box.

Lode: Lisls

Table 1D [ezanphon

Copy
Pede
2 Highlight the code list that you want to modify.
3 Click Change to access the Edit Code List dialog box.
Falit Camle 1wl
~Tabke Oelails
Table D | 0215 Dezc |PADDUCT/SERVICE ID QUALFIER K
Ailbwed Codes Cancel
Code Vake ['==cnphon
BF EUTER'S FERT HUMEER

Deleta

Load...
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Modifying a Code List Using Standard Rules

(Contd)
Sep Action
4 At this point, you can add new code list entries to the table, delete entries,
or modify code list entries. To modify an entry, highlight it and click
Change to access the Edit Code List Entry dialog box.
Edit Code: Lizt Enlry
Wabe IEIF|I
D excrplion IEIIJ'-r'EFI'S F4RT MLUMBER Cance I
5 Make the necessary changes.
6 Click OK to save the code list entry.
7 Repeat Step 2 through Sep 6 to modify other code list entries in the code
list table.
8 Click Close to save and exit the Edit Code List dialog box.
9 Click Close to exit the Code Lists dialog box.
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Using Standard Rules Deleting a Code List or Code List Entry

Deletinga Code List or CodelList Entry

Procedure  Usethis procedure to delete acode list table.

Sep Action

1 Select Code Lists from the Edit menu or the Main Toolbar.

System Response
The system displays the Code Lists dialog box.

Lodc Lisls

Tale 1D Dezanphon

Copy
2 If you want to delete a code list, highlight that list.
3 Click Delete to delete the code list table.
WARNING
THE SELECTED TABLE DELETED WITHOUT
WARNING.
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Deleting a Code List or Code List Entry

Using Standard Rules

Use this procedure to delete a code list entry.

Action

Select Code Lists from the Edit menu or the Main Toolbar.

System Response
The system displays the Code Lists dialog box.

Lodc Lizls

Delata

Py

7 g
i

Highlight the code list from which you want to delete an entry.

Click Change to access the Edit Code List dialog box.

Falit Camlee 1 it

~Table O elaiz
Tahle D |[215 Dezc | PRODUCT/SERVICE ID QLALFIER

#llawed Codex
Codeale [e=cnphion
BF BUTER'S FERT HUMBER

[ B | 1

How to delete a
CodelList Entry
Sep
1
2
3
4

To delete an entry, highlight it and click Delete to removethe entry. Delete
any other entries you wish.
WARNING

THE SELECTED ENTRY ISDELETED WITHOUT
WARNING.
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Deleting a Code List or Code List Entry

(Contd)
Sep Action
5 Click OK to save the code list table.

Forms Integration User Guide
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Importing a Code List

Importing a Code List

Using Standard Rules

Introduction The Code List Import function enables you to import code lists created for another map
and share code lists with other users of Sterling Gentran: Server.

Procedure  Usethis procedure to import a code list table.

Sep

Action

Select Code Lists from the Edit menu or the Main Toolbar.

System Response

The system displays the Code Lists dialog box.

I

Table D

Daszariplion

Click Import to access the Open dialog box.

Logkin: |23 Bin <] gI =
File name: | [ =
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Importing a Code List

(Contd)
Sep Action

3 Select the location of the code list file. The default location is Forms
Integration install folder (the default is GENSRVNT\BIn).
Note
The default file extension for code listsis .CDE.

4 Theimported code list will be available for your use.

5 Click Close to exit the Code Lists dialog box.

Forms Integration User Guide
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Exporting a Code List Using Standard Rules

Exporting a Code List

Introduction The Code List Export function enables you to export code lists to file. This enablesyou to
define a code list for one map and use that code list in another map. This function also
allows you to share code lists with other users of Sterling Gentran:Server.

Procedure  Usethis procedure to export a code list table.

Sep Action

1 Select Code Lists from the Edit menu or the Main Tool bar.

System Response
The system displays the Code Lists dialog box.

Lodc Lisls

Table ID [ezanphian

Oaze

ELY,

Dielata

Import ..

Ewpol...

e s

2 Select acode list and click Export.

System Response
The system displays the Save As dialog box.

Save As

Save i |BBin j gl E

File name:  |0235.CDE

Save as hupe: II:ode Tables [*.COE] j Cancel |
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Using Standard Rules Exporting a Code List

(Contd)
Sep Action

3 In the File name field, enter the file name and location. Verify that the
correct folder is selected in the Save in drop-down list.
Note
By default, the file nameislisted asthe table ID with a“.CDE” file
extension. The default file location is the GENSRVNT\Bin folder.

4 Click Save.
System Response
The code list is exported and you return to the Code Lists dialog box.

5 Click Close.
System Response
You exit the Code Lists dialog box.
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Loading a Code List Table from the Sandard

Introduction  The EDI standards provide code list tables only for elements that use them.

Example

In the TD4 segment, the TD401 (Special Handling Code) and TD403 (Hazardous Material
Class Code) have code tables provided by the standard.

Procedure  Usethis procedure to load a code list table from the standard.

Sep Action

1 Double-click the element for which you need to use a code table. The
system displays the Element Properties dialog box (Name tab).

Element Properties E

MHame I\-"alidationl Frint I Extended Hulel Standard Hulel Conditionsl

Please enter the name of this fisld :
|0355

Pleasze enter a short description of this figld ©
UMIT OR BASIS FOR MEASUREMENT CODE

Cancel | Anpl | Help |

2 Click the Sandard Rule tab to access standard rule options.
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Using Standard Rules Loading a Code List Table from the Standard

(Contd)
Sep Action
3 From the standard rule list, select Use Code.
Element Properties E
Marne | Validationl Print | Extended Rule  Standard Rule ICDnditionsI
Please select the standard rule ta uze : IUse Code j
Please select the code list to uze
| =] Edit... |
™ Raize a compliance error if the code is not found in the list
If pow would like the description of the code to be stored in a field, please
select that field below
THE S Lol Help
4 Click Edit Table.

System Response
The system displays the Edit Code List dialog box.

Falit Camle 1 il

~Tablk Delals
Tale 1D |[ﬁ5 [esc ||T OR BASIS FOH MEASUREMEMT CODE

1]

~Aillawed Codes
Code Vale Dezzriplion

(1Sl

The Table ID box contains the name of the element for which this code list
table will be used. The Description box contains the description of the
element for which this code list table will be used.
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Using Standard Rules

(Contd)
Sep

Action

5

Click Load.

System Response

The system displays the Load Code List dialog box.

rSelect Code Souce m

Standard | [2] st [mss 2] -

[ concer |

~Select Codes

Code: In Standand Coder £ glecled

a1 ALCTUAL POUMDS &I

oz STATUTE MILE

03 SECONDS L

a4 SHaLL SPRAY

05 LIFTS Ldd Al -2

R .

10 GAOUP -

11 OUTAT 3] [ Fmows |

* * I3 I

Use the following table to determine your next step.

IF..

THEN...

You want to select
specific codes
only,

Highlight each code from the Codesin Standard list
that you want to be loaded. Click Add to moveit to
the Codes Selected list.Proceed to the next step.

To load the entire
codelist,

» click Add All to select al the codes and move
them to the Codes Selected list.

WARNING

WE RECOMMEND THAT YOU ONLY
ADD THE CODESTHAT YOU AND YOUR
TRADING PARTNERSARE ABLETO
CREATE OR ACCEPT. ADDING ALL
THE CODESIN THE CODE TABLE
(USING THE ADD ALL BUTTON)
CREATESA MUCH LARGER
TRANSLATION OBJECT THAN IF YOU
ONLY USE SELECTED CODES.

» Proceed to the next step.

Click OK to load the code list.

Click Close to exit the Code Lists dialog box.

Click OK to exit the Element Properties dialog box.
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Copying and Pasting Code Lists

Copying and Pasting Code Lists

Introduction The Code List Copy and Paste function enables you to copy code lists from one map to
another.

Procedure  Usethis procedure to copy and to paste a code list table.

Sep Action
1 Select Code Lists from the Edit menu or the Main Toolbar.
System Response
The system displays the Code Lists dialog box.
Lodc Lisls
Tehle IO Dizzarplion
R EE m
Change. .
Copy
Pede
2 Select acode list and click Copy.
System Response
The selected code list is copied to the clipboard.
3 Click Close to exit the Code Lists dialog box.
4 Open the form in which you want to use the code lit, if the form is not

aready open.

Forms Integration User Guide
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(Contd)
Sep Action
5 Select Code Lists from the Edit menu or the Main Toolbar.
System Response
The system displays the Code Lists dialog box.
(rodetio__F
Table ID Dazciplion
Capy
Faste
6 Click Paste to add the copied code list to this form.
7 Click Close to exit the Code Lists dialog box.
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Validating Data Against Code List Tables

Validating Data Against Code List Tables

Introduction For print translation objects, you can use code list tables to validate an element for
compliance checking.

Procedure  Usethis procedure to validate data against a code list table.

Sep

Action

Double-click the element for which you need to validate data against a
code table.

Note

The standards provide code list tables only for elementsthat use them. For
example, in the TD4 segment, the TD401 (Specia Handling Code) and
TD403 (Hazardous Material Class Code) have code tables provided by the
standard.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E2
Hame |Validation| Print I Extended Hulel Standard Hulel Conditionsl

Please enter the name of this field :
|0355

Fleaze enter & shart dezcription of thiz field :
UKIT OR BASIS FOR MEASUREMENT CODE

Cancel | Sl | Help |

Click the Sandard Rule tab to access standard rule options.

From the standard rule list, select Use Code.

Forms Integration User Guide
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(Contd)
Sep Action
4 Isthe Tables list empty?

» If yes, you need to load a code table.
Reference
See Loading a Code List Table from the Sandard on page 5 - 98 for
instructions.

» If no, from the code list, select the code list table that the datain this
element is validated against.

5 Do you need to specify (for compliance reasons) that the element must
contain one of the codes from the specified table (nothing elseisvalid for
that field)?

» If yes, select the compliance error check box. Proceed to the next step.
» If no, proceed to the next step.
6 Click OK to add this standard rule to the element.
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Loading Code Item Descriptions

L oading Code Item Descriptions

Introduction Typically, you only load code item descriptions for print translation objects.

Procedure  Usethis procedure to load a code item description.

Sep Action
1 Double-click the element for which you need to load a code item
description.
System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties E
Name IVaIidationI Print I Extended Hulel Standard F|u|e| Conditionsl
Pleaze enter the name of this field :
|0355
Please enter a short description of this figld ;
UNIT OR BASIS FOR MEASUREMENT CODE
Cancel | Al | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select Use Code.
4 Isthe code list table empty?

» If yes, you need to load the code.

Reference
See Loading a Code List Table from the Sandard on page 5 - 98 for

instructions

» If no, from the code list, select the code list table that the datain this
element will be validated against.

Forms Integration User Guide
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(Contd)
Sep

Action

5

Do you need to specify, for compliance reasons that the element must
contain one of the codes from the specified table (nothing else isvalid for
that field)?

» If yes, select the compliance error check box. Proceed to the next step.
» If no, proceed to the next step.

From the store description list, the element to which you want the
description of the code item (that is used) to be mapped to when the
selection is made.

Example

If the code you used is“BR,” it would be useful to view the description of
the code (“Buyer's Part Number”). If you selected element “0350” from
the Store Field list, the description for the BP code is mapped to element
“0350.”

Click OK to add this standard rule to the element.
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Overview

Using Extended Rules

Overview

I ntroduction

Using Variables

Extended rule
sections

Using Extended Rules

Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any operation you require. Thisis afull programming
language that gives you access to the entire Sterling Gentran:Server internal storage area.

You can use these rules to define more compl ex tranglations than are avail able through the

use of standard rules.

You must declare any variable that is not already defined as part of the form specification
before you use that variable with an extended rule.

An extended rule generally consists of two sections: a declarations section followed by a
statements section. This table describes extended rule sections.

Section Name

Description

Declarations

The declarations section enables you to specify the
names and types of any variables you use either in this
rule or in any other rule that is within the scope of this
rule.

Note

The declarations section is only required if you use
additional variables.

Statements

The statements section is where you define the actions
that you want the rule to execute.
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Declar ations Section

Introduction The variables that you define in the declarations section are used to store values. Variables
consist of aname and a data type. Variable names can include al phanumerics and the “:”
and“_" characters. The first character in a variables name may not be a numeric. Please

note that all variable names are case-sensitive.

Note
A declaration must be terminated with a semicolon (;). To improve readability, you
typically include a blank line in between the declaration and statement sections.

Supported data  Thistable describes supported data types.

types
Data Type Description Example
Integer awhole number with no Declarei as an integer
decimal component. integer i;
Real awhole number that may have | Declarer asarea number
adecima component. real r;
String contains one or more printable | Declare s as a 20-character
characters. string
string[2Q] s;
Datetime contains a date or time. Declare d as adate or time
datetimed,;
Array defines atable of multiple Declarea as an array of 10
occurrences of asingle data integers
type. integer a[10];
Declare p as an array of 50 10-
character strings
string[10] p[50];
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Satements Section

Introduction The actual work performed by an extended rule is defined in the statements section. A rule
consists of a statement or a combination of statements (to perform more complex
operations). A statement is a single operation that consists of a combination of
expressions, keywords, commands, operators, and symbols.

What isan  Anexpressionisalogical unit (e.g., A =B or A + B) that the system evaluates. The
expression?  statements section consists of a sensible combination of keywords, operators, and
symbols.
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When Rules are Processed

When Rules are Processed

I ntroduction

L evels of extended
rules

Scope

You can specify pre- and post-session rules on the Session Rules dialog box. Pre-session
extended rules are processed before the trandation object, and are in scope for every
extended rule defined in the translation object. Post-session rules are executed after the
trandlation object is processed.

This table describes the form component level at which you can attach extended rules.

Form Component L evel Attach using the...

Groups, sub-groups, repeating segments, | Loop Extended Rule tab of the

and repeating elements component’s associated Properties dialog
box.
Elements Element Level Extended Rule dialog box.

The scope of an extended rule determines which variables are accessible from within a
given extended rule. The scope varies depending on the current state of the form. The
scope of an extended rule is defined as:

» Pre-session extended rules (defined on the Session Rules dialog box) are in scope for
every rulein the trandlation object.

» On New, On Store, On Open, and On Delete extended rules (defined on the Loop
Extended Rules tab of the appropriate Properties dialog box) are in scope until the
conclusion of the corresponding action (creating a new group, storing a group,
opening an existing group, and deleting a group). On Open and On Delete extended
rules are not available for print forms; only for screen entry.

» Fieldlevel extended rules are only in scope for the duration of the element.

An extended rule attached to the current form component depends on the type and state of
the form component.

Example

If acurrent group to which the rule is attached is subordinate to another group, the parent
group is automatically in scope for the duration of the entire child group, and the current
hierarchical structureisalso in scope for the duration of the child. An extended rulethat is
attached to an element is only in scope for the duration of the element. Field level
extended rules are always processed after standard rules.

A variableis considered to be “in scope” if it was declared in the current rule or in the Pre-
Session rule.

The trangdlator builds the data storage area for aform based on the EDI structure.
Therefore, extended rules address the form based on the hierarchy of the EDI file.
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Using Extended Rules

Screen entry form The tranglator processes screen entry formsin the following manner:

processing

Sage

Description

1

Reads the data into the Document Editor and processes all
cumulative standard rules (e.g., accumulators, etc.). Does not
process any extended or non-cumul ative standard rules).

Executes group level extended rulesin the following situations:
» On_New when anew group is created

» On_Openwhen an existing group is edited

» On_Storewhen agroup is saved

» On Deletewhenagroupisdeleted

Executes field level rulesin the following sequence when focusis
lost from the field:

» Non-cumulative standard rules
» Extendedrules

When the form is saved or recalculated, all standard rules are
executed.

Print form The trandator processes print forms in the following manner:

processing

Sage Description

1 Reads the data and processes all cumulative standard rules (e.g.,
accumulators). Does not process any extended or non-cumulative
standard rules).

2 Executes group level extended rulesin the following situations:
» On_New just prior to printing a group
» On_Storejust after printing a group

3 Executes field level rulesin the following sequence after the field

is printed:
» Non-cumulative standard rules
» Extended rules
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Defining Extended Rules
Overview

Introduction The form component that an extended rule accesses depends on what you want the scope
of the rule to be. You also need to determine when you want the rule to be executed (e.g.,
before or after the form component is processed.

The process you need to follow to define an extended rule varies sightly, depending on
whether you are defining a session rule or arule for aform component. You can define
extended rules to access three different levels of form components.
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Using Extended Rules

Defining a Session Rule

Procedure  Usethis procedure to define a pre- or post-session rule.

Step

Action

1

From the Edit menu, select Session Rules.

System response
The system displays the Session Level Extended Rules dialog box.

Do you want to define a pre-session rule?
» If yes, click the Pre-session option.

» If no (you want to define a Post-session rule), click the Post-session
option.

In the Editor list, type the extended rule.

Note

The Session Level Extended Rules dialog box contains line and
character number (within aline) indicators. These indicators, which are
displayed to the lower right of the Editor box (the first indicator
references the line number and the second references the character
number), enable you to easily debug compile errors.

Do you want to check the rule for errors?

» If yes, click Compile to compile the extended rule.

System response
Any warningsor errors are displayed in the Errorslist. Double-click
an error to instantly navigate to the line containing the error.

» If no, continue with step 6.

Note

The Compile function gives you immediate feedback about the accuracy
of your rule. The rule is compiled when you compile the entire

trand ation object.

Correct any errors that the system flagged and click Compile again.

Note
Repeat this process until there are no errors generated.

Click OK to add the extended rule.
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Defining a Form Component Extended Rule

Procedure  Usethis procedure to define an extended rule for aform component.

Sep Action

1 Click the form component with the right mouse button to access the
shortcut menu.

2 Select Extended Rules (or Extended Rule if the form component isan
element) from the shortcut menu.

System Response

» If theform component isan EDI file, repeating group, repeating
segment, the system displays the Loop Extended Rules tab of the
appropriate Properties dialog box.

» If theform component is an element, the system displays the
Extended Rule tab of the Element Properties dialog box.

3 Areyou defining the rule for agroup?
» If yes, proceed to the next step.
» If no, proceed to Step 5.

4 Use this table to determine which extended rule execution option to
select.
Note
You can define an On New, On Store, On Open, and On Delete rule for a
single group
I F you want to executethe THEN...

extended rule when...

you create a new group in the click the On New option.
tranglation object,

you store a group, click the On Store option.

yOu open an existing group, click the On Open option.

If you want the extended ruleto be | click the On Delete option.
executed when you delete a group,
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(Contd)
Sep

Action

5

In the extended rule list, type the extended rule.

Reference
See Alphabetic Language Reference on page 6 - 41 for more information
about rule syntax.

Note

The Extended Rules dialog boxes contain line and character number
(within aline) indicators. These indicators, which are displayed to the
lower right of the Editor box (the first indicator references the line
number and the second references the character number), enable you to
easily debug compile errors.

Do you want to check the rule for errors?
» Ifyes, click Compileto compile the extended rule.

System response
Any warnings or errors are displayed in the Errors list. Double-click
an error to instantly navigate to the line containing the error.

» If no, continue with step 7.

Note

The Compile function gives you immediate feedback about the accuracy
of your rule. Therule is compiled when you compile the entire trandation
object.

Correct any errors that the system flagged and click Compile again.
Repeat this process until there are no errors generated.

Click OK to add the extended rule.

Note
When an element contains an extended rule a black asterisk appearsto the
right of the element icon.
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Extended Rule Syntax
Overview

I ntroduction The statements section of an extended rule consists of a sensible combination of

keywords, operators, and symbols. The correct syntax for each of these component is
explained bel ow.

Note

You use spaces and operators to separate keywords and symbols. You cannot string two
keywords sequentially together without an operator.
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Keywords and Commands

Introduction A keyword is afixed defined use of aword that indicates how the programming language
should beinterpreted. There are two types of keywords. Thefirst type of keyword controls
the flow of execution of the defined rule. These keywords are used to evaluate conditions
and perform looping operations.

The second type of keyword is a command. Commands perform actions on variables and
are responsible for the movement of data.

Valid keywords A list of Sterling Gentran: Server execution control keywords s as follows:

IF

THEN
ELSE
BEGIN
END
WHILE

DO
CONTINUE
BREAK

Valid commands A list of Sterling Gentran:Server commands is as follows:

AUDITLOG
GET

SET
STRDATE
CONCAT
LEN

ATOI
ATON
CERROR
EMPTY
EXIST
INDEX
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Valid commands
(contd.)

NTOA

COUNT
DELETE

FSEEK

FTELL

LEFT

RIGHT

MID

SELECT

INSERT
UPDATE
READBLOCK
UNREADBLOCK
READBYTES
WRITEBYTES
CREATEOBJECT
DELETEOBJECT
QUERYOBJECT
GETID
WINEXEC
DATE

EXEC

PARAM

Note
A statement must be terminated with a semicolon (;).

Forms Integration User Guide
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Operators

I ntroduction

Using Extended Rules

Operators define the simplest operation in an expression. This table describes valid

extended rule operators.

Operator Description
+ addition, concatenation
- subtraction
* multiplication
/ division
= assignment, equality
> greater-than
< less-than
>= greater-than or equal to
<= less-than or equal to
I= not equal to
! logical not
& logical and
| logical or
<< date modification
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Symbols

I ntroduction

Symbol syntax

Symbols

Operations are performed on symbols. The symbols that you can use in Sterling

Gentran: Server extended rules are variabl es, constants, form components/internal storage,
arrays, and accumulators. You can address existing form components and you a so have
the ability to create additional instances of form components, as long as the form
component isoriginally defined in internal storage. You can use thisfunction to create, for
example, extraline itemswhen onelineitem field is already defined in internal storage.

You must address each type of symbol in the proper syntax.

String constant

To address a string constant, you must enclose the constant value in quotes:
#fieldname="HDR";
where HDR is the constant value

Addressing or creating afield in internal storage

To address afield or create afield in internal storage, within the scope of the current
mapping action, the syntax is#FIELD_NAME

#ield_1=2;

where 2 isa numeric constant value

Addressing or creating a field in a group

To address afield within agroup or create afield within agroup in internal storage within
the scope of the current hierarchy, the syntax is SGROUP#FIELD_NAME
$N1.#0234
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Symbol syntax ~ Addressing or creating a group in internal storage
(cont.) To fully address a group in the entire internal storage area or create agroup in internal
storage, the syntax is $LOOP[index1][index2][index3] where the index entries indicate
the hierarchical structure of the loop and enable you to address specific instances of a
group:
$Group_C[3][2] #Field_2

where you are specifying the second instance of Group_C within the third instance of
Group_B:

Group A

Group B

Group C

TR

Addressing an array
To address an array (of any type), you address each element of the array individually. For
example, if array_lisan array (of integers) and is declared:

integer array_1[5]

with variables 0 through 4, each element of the array is addressed individually as follows:;
array_1[0]
array_1[1]
array_1[2]
array_1[3]
array_1[4]

Accessing an accumulator

An accumulator can be accessed in the same manner as variables or internal storage. To
address an accumulator, use the syntax accum(n) where “n” is the number (not the name)
of the accumulator:

accum(2) =5
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Exampleof a  Thisdiagram illustrates an example of a simple statement.
simple statement

I THE

| $Group_Name#Fiel d_Name| |#Fi e d_Name|2;
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Common Statements and Examples
Overview

Introduction  Some of the common statements are as follows:
» assignment
» datetime expressions
» conditiona logic
» string conditions and functions
» numerical functions
» raise compliance error function
» removefield value function
» existence of datafunction
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Assignment

Introduction The assignment statement is the most powerful and most often used extended rule
statement. In the most simple form, it is written as follows:

variable=expression

However, you can use this statement in more flexible and complex ways, defined as
follows:

numeric_variable=numeric_expression
numeric_field=numeric_expression
string_variable=string_expression
string_field=string_expression
datetime_variable=datetime_expression
datetime_field=datetime_expression

Numeric A numeric expression can consist of number, numeric fields, numeric variables, and
expressions  numeric functions combined with the standard arithmetic operators.

Sring expression A string expression can consist of string constants, string fields, string variables, and
string functions concatenated with the “+” operator.

Datetime A datetime expression can consist of a datetime constant, datetime field or datetime
expression  variable.

Examples  Some examples of assignment expressions are as follows:

a = b5;

a=>b + c

s = "hello";

s =s + "world";
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Datetime Expressions

I ntroduction

Date syntax

<< operator

Time syntax

Datetime expressions consist of a datetime variable and (optionally) datetime modifiers.
Datetime expressions can be written using datetime constantsif you are using the standard
syntax, as follows:

year/ nont h/ day
hour: m nut e: second
year/ nont h/ day/ hour : m nut e: second

Datetime expressions can also be written with datetime fields, variables, or using date and
time functions.

Date functions are written as follows (month specified as 0-11):
datetime d;

d = date(1995,4,6);
d = date(1995,4,6,12,0);
d = date(" %y/%m/%d", "95/4/6");

Thed =date(" %y/% m/%d", " 95/4/6"); format enables you to convert any string format
typeinto adatetime format type by indicating aformat mask (" %y/% m/%d" ) along with
the string (" 01/4/6" ) you want to convert. You use this function if you are using non-
standard syntax and need to specify the syntax you are using.

You can use the << operator to modify your datetime variable by adding time increments
(e.g., days, weeks, years). For example:
datetine d;

d=d <<weeks(2);
/1 This adds 2 weeks to d.

Time functions are written as follows:

d =tinme(12,0);
d = tinme(12,0,59);

You can use the << operator to modify your datetime variable by adding time increments
(e.g., seconds, minutes, years). For example:
datetine d;

d=d <<seconds(1);
/1 This adds 1 second to d.
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Get and set The get and set functions enable you to access (get) or modify (set) individual components
functions  of adatetimetype. These functions are used as follows:

i nteger a;

datetine d;
a = get days (d);
a = get hours (d);
set hours(d, a);
set days (d, a);
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Conditional Logic

I ntroduction

IF..THEN...
ELSE

Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
Do not end conditions with a semicolon (;) — thisterminating syntax is necessary for
statements only.

You can use the IFFTHEN keywords to execute one or more statements conditionally. The
condition istypically acomparison, but it can be any expression that concludes with a
numeric value. Sterling Gentran: Server interprets the value as either true or false. The
system interprets a zero value as false and a nonzero value as true.

Note

If you include more than one statement in the body of an IF/THEN loop, you must
surround the statements with the BEGIN/END keywords. If you only use asingle
statement, you can omit the BEGIN and END.

Sterling Gentran:Server evaluates the IF/THEN condition, and if it is true, the system
executes all the statements that follow the THEN keyword.

You can use the EL SE keyword in conjunction with IF/THEN to define several blocks of
statements, one of which is executed. Sterling Gentran:Server tests the first IF/ THEN
condition. If the condition is false, the system proceeds to test each sequential condition
until it finds one that istrue. The system executes the corresponding block of statements
for the true condition. If none of the IFFTHEN conditions are true, the system executes the
statements following the EL SE keyword. The IF/THEN/EL SE statement is written as
follows:

I F condition THEN
BEG N
st at erment 1;
st at ement 2;
END
ELSE
BEG N
st at ement 3;
st at enent 4;
END
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Sring Conditions and Functions

Introduction You can use string conditionsin IF/THEN and IF/THEN/EL SE statements to perform
comparisons between strings. Examples of the syntax are as follows:

IF s1 = s2 THEN
IF s1 < s2 THEN
IF sl > s2 THEN

The following string functions are also available for you to use:

» left

» right

» mid

» strdate
» concat
» strstr

Left, right, mid  Theleft, right, and mid functions enable you to extract substrings from a string. The left
syntax  function extracts a specified number of characters from the Ieft of the string variable or
field and returns the result as a string. The right function extracts a specified number of
character from the right of the string variable and returns the result as a string. The mid
functions extracts from a specified position in the string to the right, for a specified
number of characters. Thisis an example of how the statements are used.

string[10] s;
string[3] si;
string[3] s2;
string[4] sS3;
string[7] s4;

s = "abcdefghij"

sl = left(s,3);
s2 = right(s,3);
s3 = md(s, 3,4);

Srdatesyntax  The strdate function converts a datetime type into a string using aformat that you specify.
This function allows you to include static characters such as a slash (/), which gives you
accessto full date support.

Syntax
datetine d;
string[8] s;

strdate(d, "%/ % %", s);
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Concat syntax  The concat function concatenates a specified number of characters from one string onto
the end of another string. The following example demonstrates the syntax to concatenate
five characters from string “s2” onto the end of string “s1”

string[10] s1,s2;
concat (s1,s2,5);

Srstr syntax  The strstr function finds a substring inside a string. This function returns the position of
the first instance of the designated substring. If this function does not find the specified
substring inside the string, it returns avalue of -1.

Syntax
i nteger d;

d = strstr("hello", "el");
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Numerical Functions

Introduction The numerical functions enable you to convert one data type to another. The numerical
functions that are available for you to use are the following:

» len
» &oi
» aton
» ntoa

Len syntax  Thelen function counts and returns the number of charactersin astring.

Example
i nteger a;
a = len("hello");

Atoi, aton, ntoa  The atoi function converts strings into integers.

syntax
The aton function converts string into real numbers.

The ntoa function converts integers and real numbers into strings.

Example

i nteger a;

real b;
string[8] s;

a = atoi("5");

b = aton("5.5");
ntoa(5.5, s);
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Raise Compliance Error Function (CERROR)

Introduction The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the trandation report.

Syntax
cerror (100, $I1 LD 0] [ 1] [ 1] . #VATC) ;

The above example raises compliance error 100 on the VATC element of the specified
instance of the ILD group. You typically specify this function as a action to be performed
if aconditionisfalse.
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Remove Field Value Function (EMPTY)

Introduction The empty function sets the value of afield in internal storage to null. Thisfunction is not
the same as setting the value of afield to a zero length string (" ") or to zero.

Syntax
empty($ILD{ O] [ 1] [1] . #VATC) ;

The above example sets the value of the specified instance of the VATC element to null.
Thisfunction istypically used to prevent output to the specified field.
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Existence of Data Function (EXIST)

Introduction The exist function tests to determine if afield is empty (null). It returns a non-zero (true)
valueif thereisdatain a specified field in internal storage. If datais not present in the
specified field, this function returns a zero (false) value. This function istypically used as
apart of acondition.

Syntax
I F exist($ILD{0][1][1].#VATC) THEN

The above example returns a non-zero value if the condition istrue (data is present in the
specified instance of the VATC element). A zero valueis returned if the condition isfalse
(no datais present in the specified instance of the VATC element).

There are some situations when the |F EXIST returns a non-zero (true) value whether or
not the condition is true. You can work around this by only using IF EXIST for date- and
number-type fields. Be certain that all referencesto the field which isinterrogated are

nested within the |F EXIST begin block. For string-type fields, use the following format:

IF Fieldl = " "
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Count Function (COUNT)

Introduction The count function returns the total number of times a group (or repeating record) has
iterated.

Syntax
count ( GROUPNANE[ 3] [ *]) ;

The above example returns the total iterations of the GROUPNAME group within the
third iteration of the parent group.
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Delete Function (DELETE)

Introduction The delete function del etes the specified iteration of arepeating record or group.

Syntax
del et e( GROUPNAME[ i teration]);
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File Pointer Functions (FSEEK, FTELL)

File Pointer Functions (FSEEK, FTELL)

I ntroduction

The fseek function moves the file pointer to anew location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of thefile or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current_fileis“0.” To
invoke the fseek function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the ftell, readblock, and
writeblock functions.

Syntax
fseek(current_file,offset,origin);

Theftell function obtains the current position of thefile pointer and returnsit as an integer.
To invoke the ftell function against the input file, the value for current_fileis“0.” To
invoke the ftell function against the output file, the value for current_fileis“1.” The fseek
functionistypically only used in conjunction with the fseek, readblock, and writebl ock
functions.

Syntax
nuneric_variable = ftell(current_file);
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Block of Data Functions (READBLOCK, WRITEBLOCK)

Introduction The readblock function reads a block of data (segment or record) from the input file and
placesit into the argument of a string variable. The writeblock function writes the data
contains in the argument of a string variable to the output file.

The readblock and writeblock functions are used in conjunction with each other to pass a
block of datafrom the input file to the output file without compliance checking or testing
for proper EDI syntax. Together these functions provide a more efficient alternative of
using “wildcard” segments, which are typically implemented in build and break maps.

Syntax
readbl ock(string_variabl e);
writebl ock(string_variable);
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Select Function (SELECT)

Introduction The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and “receiverlist” can be a string field, string
variable, or string literal. It isimportant to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax
sel ect fieldnanme into receiverlist fromtabl enane where key =
expression [and key = expression];
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Update Function (UPDATE)

Introduction The update function allows information in the database tables to be updated. Thisfunction
issimilar to the Update standard rule, except that it provides more flexibility. Only the
tables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It isimportant to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax
updat e tabl enanme set fiel dname =expression [fiel dnane =expression]
where key = expression [and key = expression];
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Insert Function (INSERT)

Introduction  Theinsert function allows information in the database tables to be updated.

Syntax
insert into tablename [ (fieldlist) ] [ (valuelist) ];
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User Exit Function (EXEC)

What isa user A user exit isan extended rule that enables the map to temporarily exit trandation to
exit?  enhanceyour functionality or fulfill specific requirements that Sterling Gentran: Server
does not perform during normal trandation.

Reference
See User Exits, appendix B, for more information.

Placingthe  You can usethe exec function in an extended rule for amap component at any hierarchical
extended rule  leve, including field level extended rules, if appropriate.

Note
When you apply auser exit to a map component, subordinate map components may also
be able to execute the same user exit.

Allowabledata  These are the extended rule data types that you can use with exec:
types , |NTEGER

» REAL
» STRING
Note

You cannot use date and time data unless you process it as a string data type.
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ActiveX and User Exit Functions

Introduction Sterling Gentran: Server now supports additional extended rule functionality to allow you
to use Microsoft's ActiveX Data Objects (ADO) from within extended rules, aswell as
providing enhancements to user exit support.

ActiveX indexed  Sterling Gentran: Server now supports ActiveX indexed properties, specifically these types
properties  of index:

» variant
» numeric
» string

Theindex support alows you to use these syntaxes (if they are supported by your
Automation server):
n

n
n

ob. property[1];
ob. property[“Count”];
ob. property[ob. nethod()];

Sterling Gentran: Server also supports chaining of ActiveX method calls and properties,
which simplifies extended rules for Automation servers with moderately complex object
models (e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.iten]“Messageld’].val ue

Createobj ect The createobject function enables you to create an instance of an ActiveX Automation
syntax  Server.

Syntax

obj ect = createobject(“ProglD);

ProglID is the programmatic identifier. An example of aProgID is:
“InternetExplorer.Application”
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Deleteobject  The deleteobject function enables you to delete an instance of an ActiveX Automation
syntax  Server. Anobject must be deleted before the end of the map that usesit. It is more efficient
to delete the object immediately on completion (using the DELETEOBJECT command),
although the Sterling Gentran: Server translator will delete the object automatically at the
end of the map. Also, if you assign one object to another one, both copies of the object
must be deleted for that object to be properly unloaded.

Syntax
del et eobj ect (obj ect) ;

Getiid syntax ~ The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

Syntax
string_variable = getiid(“ProglD', “InterfacelD");

Interfacel D (11D) isthe interface identifier. An example of an lID is:
“IWebBrowser2”

Queryobject The queryobject function is used to request a different interface on an existing object.

ntax
¥ Syntax

obj ect2 = queryobj ect (objectl, "{IID");

Note

You may not use extended rulesthat compare two ActiveX properties or method results, or
any combination of properties or method results. This type of comparisonisinvalid
because property and method types are unknown prior to compilation and thusit is not
possible to generate the correct comparison code.
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Overview

Alphabetic Language Reference

Overview

I ntroduction

Typeface
conventions

Typeface
conventions

This section contains an al phabetic reference for the Sterling Gentran: Server proprietary
programming language keywords and commands. This enables you to quickly and easily
refer to information on specific keywords or commands.

This table lists the typeface conventions used in this section.

I F the typeface follows this

example... THEN it isused to indicate...

While what you need to type.

condition in syntax, information that you need to provide.

[1] that, in syntax, itemsinside square brackets are
optional.

The following programming guidelines are utilized in this section:

Forms Integration User Guide

Keywords and commands are shown in all lower case letters.
Map components are shown in all upper case letters.
A double dlash (//) introduces comments.

Linesthat are too long to fit on one linein this section may be continue on the next
line using a line-continuation character (A).
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atol

Introduction Theatoi functionisanumerical function that converts stringsinto integers. The numerical
functions enable you to convert one data type to another.

Syntax  int = atoi(string);

where: int = integer variable
string = string variable

Example integer a;
string[20] s;
s = "5";
a = atoi(s);
// "a" contains the value 5
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Using Extended Rules aton

aton

Introduction The aton function is a numerical function that converts strings into real numbers. The
numerical functions enable you to convert one data type to another.

Syntax  read = aton(string);

where: red real number variable
string = string variable

Example real a;
string[20] s;
s = "5 5";
a = aton(s);
/] "a" contains the value 5.5
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auditlog

Introduction The auditlog function enables you to write user-defined audit messages to the Sterling
Gentran: Server Audit Log. When an extended rule that calls an auditlog operation is
executed, it writes the specified user-defined message to the Audit Log.

Note
This function does not return a value.

Syntax  auditlog(Messagel D, Type, Key, [, stringl] [, string2] [, string3] [, string4] [, string5]
[, string6] [, string7];

MessagelD  Thefirst parameter, Messagel D, is the user-defined audit message identifier, which much
be an integer value.

Type  Thesecond parameter, Type, isakeyword that identifies the type of audit message. These
pre-defined keywords are valid for Sterling Gentran: Server:

» AL_PROC (processing)
» AL_MSG (message)
Note

You may also supply an integer value to account for atype for which akeyword is not
currently defined.

Key  Thethird parameter, Key, isakeyword that is either zero (if the type of parameter two is
“AL_PROC") or the identification of a piece of data of the specified type. These pre-
defined keywords are valid for Sterling Gentran: Server:

» AL _KEY_INPUT
» AL_KEY_OUTPUT
Note

You may also supply an integer value to account for akey for which akeyword is not
currently defined.
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Parameters4
through 10

Examplel

Example2

auditlog

Parameters four through ten are optional string values that the user-defined message may
requireto fill in variables defined in the audit message.

audi t| og(Messagel D, AL_PRCC, 0, ...);
/1l ssues a processing nessage in any nap.

audi t| og( Messagel D, AL_MSG Oatoi (param(1)), ...);
//1ssues a data audit for the nessage which is currently
/| processi ng.
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begin

Introduction Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
You can use the if/then keywords to execute one or more statements conditionaly. If you
include more than one statement in the body of an if/then loop, you must surround the
statements with the begin/end keywords. If you only use a single statement, you can omit
the begin and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statenent 1,
st at enent 2;
end
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break

I ntroduction

Example

break

The break function terminates the execution of the nearest enclosing while loop, and
passes control to the statement that follows the end keyword. The break keyword is
generally used in complex loops to terminate aloop before several statements have been

executed.

i nteger i
i =0;

Wile i <10 do

Begi n
#Total = Total + 50;
i =i + 1;

I f #Total > 100000
Br eak;
El se
Cont i nue;
End

//\While the value contained in the variable
/150 will be added to the field Total.

/11f the value in the field Total

"i" is less than ten,

becones greater than 100000

/Ibefore "i" equals 10, break out of the while | oop else continue

/I processing until "i" equals 10.
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cerror

I ntroduction

Syntax

Example

Complianceerror
codes

Using Extended Rules

The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the translation report. You typically specify thisfunction asa
action to be performed if a condition isfalse. Thistable describes when the cerror function

is supported in Sterling Gentran: Server.

I F the map/form is of

type... THEN thecerror function is...
Screen entry Not valid.
Print Not valid.
Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.

Break (Interchange,
Group, or Transaction
Set)

Only valid on the input side of the map.

Build (Interchange,
Group, or Transaction
Set)

Not valid.

cerror(error_number,$GROUP_NAM EJindex][index][index].
A#FIELD_NAME);

cerror (100, $I LD O] [ 1] [ 1] . #VATO);

/1 This raises conpliance error 100 on the VATC el enent of the
/I specified instance of the ILD group

The compliance error codes are as follows

Error
Number Error Generated
100 Mandatory Element
105 Conditional Element
110 Incorrect Element Format
111 Invalid Date
112 Invalid Time
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(Contd)
Error

Number Error Generated
113 Invalid String
114 Invalid Number
115 Incorrect Element Length
116 Element Too Short
117 Element Too Long
118 Invalid Overpunch Data
119 Invalid Numeric XData
120 Too Many Components
121 Too Many Elements
125 Element Delimiter
130 Conditional Relation
135 Element Code
140 Standard Rule Failure
145 Binary Substitution Failed
200 Mandatory Component
205 Conditional Component
210 Incorrect Component Format
215 Incorrect Component Length
220 Component Delimiter
225 Component Code
300 Mandatory Segment
305 Segment Sequence
310 Invalid Start End
315 Incorrect Block Format
320 Segment Terminator
330 Unexpected Segment
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Using Extended Rules

(Contd)
Error
Number

Error Generated

400

Session Error

405

Unknown Partner

410

Invalid Control Number

415

Invalid Sub Count

420

Unknown Relationship

425

Unknown Standard

430

Unknown Version

435

Unknown Transaction

440

Duplicate Control Number

445

Duplicate Doc Name

500

ActiveX Bad Param Count

505

ActiveX Bad Argument Type

510

ActiveX Unknown Name

515

ActiveX Type Mismatch

520

ActiveX Missing Required Param

525

ActiveX Server Unavailable

530

ActiveX Object Not Created

535

ActiveX Other Error

600

XML Element Type Match

601

XML Element Root Type

602

XML Element Required

620

XML Attribute Undeclared

621

XML Attribute Not Unique

622

XML Attribute Required

623

XML Attribute Fixed Error

624

XML Attribute ID Not Unique
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(Contd)
Error

Number Error Generated
625 XML Attribute ID REF Match
630 XML Attribute Parse Name Error
631 XML Attribute Parse Equal Error
632 XML Attribute Parse OQuote Error
633 XML Attribute Parse CQuote Error
640 XML Attribute Name Error
641 XML Attribute Names Error
642 XML Attribute NM Token Error
643 XML Attribute NMTokens Error
644 XML Attribute Entity Error
645 XML Attribute Entities Error
660 XML Reference Char Invalid
661 XML Reference Entity Recursion
662 XML Reference Entity Undeclared
699 XML Unknown Error
700 ODBC Data Source Open Error
701 ODBC Data Source Rollback
702 ODBC Data Source Commit Error
703 ODBC Data Source Rollback Error
710 ODBC Query Open Error
711 ODBC Command Error
712 ODBC Cursor Error
720 ODBC Output Table Error
721 ODBC Output Operation Error
730 ODBC Mandatory Element
731 ODBC Data Conversion Error
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Using Extended Rules

(Contd)
Error
Number

Error Generated

732

ODBC Incorrect Element Format

733

ODBC Standard Rule Failure

799

ODBC Unknown Error

800

NCPDP BFHS Missing

801

NCPDP BFHS Seg ID Error

802

NCPDP BFHS Transmission Type Error

803

NCPDP BFHS Sender ID Missing

804

NCPDP BFHS Batch ID Error

805

NCPDP BFHS File Type Error

806

NCPDP BFHS Receiver ID Mlssing

807

NCPDP BFDDR Missing

808

NCPDP BFDDR Seg ID Error

809

NCPDP BFDDR Transaction Ref Missing

810

NCPDP BFTR Missing

811

NCPDP BFTR Seg ID Error

812

NCPDP BFTR Batch ID Error

813

NCPDP BFTR Record Count Error

814

NCPDP BFTR Record Count Mismatch Error

815

NCPDP DR Repeating Segment Error

816

NCPDP DR Transaction Code Error

817

NCPDP DR Transaction Count Error

818

NCPDP DR Transaction Count Mismatch Error

819

NCPDP DR Header Response Code Error

820

NCPDP DR Transaction Response Code Error

830

NCPDP Null Char

832

NCPDP Invaid Char
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(Contd)
Error

Number Error Generated
833 NCPDP Unexpected EOF
835 NCPDP Unexpected STX
836 NCPDP Unexpected ETX
837 NCPDP Missing Stream Separator 1
838 NCPDP Missing Stream Separator 2
839 NCPDP Unexpected Separator
840 NCPDP Unexpected FS
841 NCPDP Unexpected GS
842 NCPDP Missing GS
845 NCPDP Positional Segment Tag Off
855 NCPDP Delimited Segment Empty
856 NCPDP Delimited Segment Missing First FS
857 NCPDP Delimited Field ID Invalid
858 NCPDP Delimited Field ID Invalid Char
859 NCPDP Delimited Field ID Null Char
860 NCPDP Delimited Field ID Incomplete
861 NCPDP Delimited Field Data Missing
862 NCPDP Delimited Field Data Null Char
863 NCPDP Delimited Field Data Invalid
864 NCPDP Delimited Field Data Invalid Char
865 NCPDP Delimited Segment ID Invalid
866 NCPDP Delimited Segment ID Invalid Char
867 NCPDP Delimited Segment ID Null Char
868 NCPDP Delimited Segment ID Incomplete
869 NCPDP Delimited Field ID Size
885 NCPDP Batch Nothing After STX
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(Contd)
Error
Number

Error Generated

886

NCPDP Batch Unexpected STX

887

NCPDP Batch Missing ETX

888

NCPDP Batch Data File Open

890

NCPDP Data Field String Separator

891

NCPDP Data Field String No Filename

892

NCPDP Data Field String Start Byte

893

NCPDP Data Field String End Byte

894

NCPDP Data Field String Incomplete

895

NCPDP Data Field String Extra Characters

896

NCPDP Data Field Size Incorrect

897

NCPDP Data Field Start Out of Bounds

898

NCPDP Data Field Start Beyond End

899

NCPDP Unknown Error
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concat

I ntroduction

Syntax

Example

concat

The concat function concatenates a specified number of characters from one string onto
the end of another string.

concat(string,string,num_char);

where: string = string variable
num_char = number of characters from the second string onto the
end of thefirst string

Note
You may not use an ActiveX property asthefirst parameter of the concat function because
the length of the property is unknown prior to compilation.

string[20] s1,s2;
sl = "IBM;
s2 = "Sterling";

concat (s1, s2, 8);

/] Concat enate ei ght characters fromstring "s2" onto the end of
/lstring "s1"

/1 sl will now contain the value "IBM Sterling".
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continue

I ntroduction

Example

Using Extended Rules

The continue function continues the execution of the innermost loop without processing

the statementsin the loop that follow the continue statement.

i nteger i
i =0;

Wi le i <10 do

Begi n
#Total = Total + 50;
i =i + 1;

I f #Total > 100000
Br eak;
El se
Cont i nue;
End

//\While the value contained in the variable "i"
/150 will be added to the field Total.

/11f the value in the field Total

is less than ten,

becones greater than 100000

/Ibefore "i" equals 10, break out of the while | oop else continue

/I processing until "i" equals 10.
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count

Introduction The count function counts and returns the number of iterations of agroup. An exampleis
asfollows:
integer i;
i = count ($N1[*]);

//The [*] is a wildcard that counts the nunber of iterations of the //
N1 group.
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createobj ect

I ntroduction

Syntax

Example

Using Extended Rules

The createobject function enables you to create an instance of an ActiveX Automation
Server.

object = createobject("ProglD");

where: ProgiD = programmatic identifier

obj ect ob;

ob = createobject("InternetExplorer. Application");

// Creates an instance of the default interface of an ActiveX

/1 Aut omati on Server.

/I Not e:

/1 The createobject command is nore efficient if you use the 11D
/linstead of the interface nane.
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date

I ntroduction

Syntax

Example

Format specifiers

date

The date function converts a string type into a datetime type using aformat that you
specify. This function allows you to include static characters such asa dash (/), which
gives you access to full date support.

Datetime = date("format”,string);

where: datetime = datetime variable (month specified as 1-12)
format = desired date format
string = string variable

datetine d;

d = date(1995, 4, 6);

d = date(1995, 4,6, 12,0);

d = date(" %/ % %", " 95/ 4/ 6");

d = date("%/ %1 %", #strdate);

Thistable lists the format specifiers.

Format Specifier

Description

%8

1SO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
secondsin Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z2)

Note
This date format cannot be combined with any other
format specifier.

%a

Abbreviated weekday name

%A

Full weekday name

%b

Abbreviated month name

%B

Full month name

%d

Day of the month as a decimal number (01 — 31)
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date Using Extended Rules

(Contd)
Format Specifier Description

%D 1SO-8601 date format (date component only)
Format
YYYYMMDDZ
Note
This date format cannot be combined with any other
format specifier.

%H Hour in 24-hour format (00 — 23)

%l Hour in 12-hour format (01— 12)

%j Day of the year as a decimal number (001 — 366)

%m Month as adecimal number (01 —12)

%M Minute as a decimal number (00 — 59)

%S Second as adecimal number (00 — 59)

%U Week of the year as a decimal number, with Sunday as the
first day of the week (00 — 51)

%W Weekday as a decimal number (0 — 6, with Sunday as“0")
%W Week of the year asadecimal number, with Monday asthe
first day of the week (00 —51)

%y Year without the century as a decimal number (00 — 99)
%Y Year with the century as a decimal humber
%% Percent sign
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Using Extended Rules delete

delete

Introduction The delete function deletes a specified occurrence of a group.

Syntax  delete($§GROUP_NAME[N]);

where [n] is the occurrence of the group that you wan to delete.

Example delete($ILD2]);
/1 Del etes the second occurrence of the |LD group.
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del eteobject Using Extended Rules

deleteobj ect

Introduction The deleteobject function enables you to delete an instance of an ActiveX Automation
Server. An object must be deleted before the end of the map that usesit. It ismore efficient
to delete the object immediately on completion, although the Sterling Gentran: Server
translator will delete the object automatically at the end of the map. Also, if you assign
one object to another one, both copies of the object must be deleted for that object to be
properly unloaded.

Syntax  deleteobject(object);

Example  object ob;
ob = createobject("InternetExplorer. Application");
del et eobj ect (ob);
/1 Del etes the instance of the object.
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Using Extended Rules
empty
I ntroduction

Syntax

Example

empty

The empty function setsthe value of afield in internal storage to null. Thisfunction is not
the same as setting the value of afield to a zero length string (" ") or to zero.

empty($GROUP_NAME[index][index][index]. #FIELD_NAME)

enmpt y($! LD. #VATO) ;
/1Set the value of the specified instance of the VATC el enent
//to null
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end Using Extended Rules

end

Introduction Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
You can use the if/then keywords to execute one or more statements conditionaly. If you
include more than one statement in the body of an if/then loop, you must surround the
statements with the begin/end keywords. If you only use a single statement, you can omit
the begin and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statenent 1,
st at enent 2;
end
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Using Extended Rules exec

exec

Introduction The exec function invokes the execution of aabatch file or program. The trandator waits
until the script finishes before continuing with tranglation. After the script runs and returns
anumeric return code, the exec function:

» Retrievesthe return code

» Returnsto transation

» Usesthereturn codein trandation.
Note

You must set an integer value equal to the return value of the exec (...) call for the ruleto
compile.

Syntax  nReturn = exec(string)

where:
nReturn = return value
string = string variable or literal value that represents the shell script

Example integer nReturn;
nRet urn 0;
nRet urn exec (“c:\addrunmsh”);
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exist

exist

I ntroduction

Syntax

Example

Using Extended Rules

The exist function tests to determine if afield is empty (null). It returns a non-zero (true)
valueif thereisdatain a specified field in internal storage. If datais not present in the
specified field, this function returns a zero (false) value. This function istypically used as
apart of acondition.

There are some situations (for example, if the field or element has a"Use Code" standard
rule applied to it) when the IF EXIST returns a non-zero (true) value whether or not the
condition istrue. You can work around this by only using IF EXIST for date- and number-
typefields. Be certain that all references to the field which isinterrogated are nested
within the |F EXIST begin block.

For string-type fields, use the following format:

IFFieldl=""

if exist($GROUP_NAMEJ[index][index][index]. #FIELD_NAME) then

if exist($lLD #VATC) then
#TEMP_FI ELD = #VATC

// Return a non-zero value if the condition is true (data is present
/1in the

//specified instance of the VATC elenent). A zero value is returned
/1if the condition is false (no data is present in the specified
//instance of

//the VATC el enent).
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Using Extended Rules

fseek

I ntroduction

Syntax

Example

fseek

The fseek function movesthe file pointer to a new location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of thefile or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current_fileis“0.” To
invoke the fseek function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the ftell, readblock, and
writeblock functions.

fseek(current_file,offset,origin);

where: current_file = Oindicatestheinput file; 1 indicates the output file
offset = The position to which the file pointer is moved relative
to the origin.
origin = The keyword depends on the starting location:
begin = start at beginning of thefile
end = start at the end of thefile

current = start at the current position in thefile

string[1024]tenp_buffer;

I nteger Position;

Position = ftell (0);

whi | e readbl ock(tenp_buffer) do

begin
if left(tenp_buffer,3) = "IEA" then
begin
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
/I Read a segnment frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. |If found, reset file pointer to where it was
/I before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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ftell

ftell

I ntroduction

Syntax

Example

Using Extended Rules

The ftell function obtains the current position of the file pointer and returnsit as an
integer. To invoke the ftell function against the input file, the value for current_fileis“0.”
To invoke the ftell function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the fseek, readblock, and
writeblock functions.

numeric_variable = ftell(current_file);

string[1024]tenp_buffer;

I nt eger Position;

Position = ftell (0);

whi | e readbl ock(tenp_buffer) do

begin
if left(tembuffer,3) = "IEA" then
begi n
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
// Read a segnent frominput file and place in tenp_buffer. Look for
/"1 EA" segnment tag. |If found, reset file pointer to where it was
/I before the "I EA" segnment was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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Using Extended Rules get

Introduction The get function enables you to access individual components of a datetime variable.

Syntax integer_variable = get datetime_component (datetime_variable);

where: integer_variable = integer variable
datetime_component = individual component of the datetime
variable

datetime_variable datetime variable of which you want to

access a component part

Example integer tenp_days;
i nteger tenp_hours;
datetine d;
tenp_days = O;
tenmp_hours = 0;
d = '12/25/2001 12:15:30"';//A fields value in the nmap can be
/] assigned to the datetime variable "d"
/lor a hard coded val ue can be assi gned.

tenp_days = get days (d);
tenp_hours = get hours (d);

/] Accesses the days fromthe datetinme variable "d" and |oads into

/lvariable " tenp_days ". Accesses the hours fromthe datetine
/lvariable "d" and loads into variable "tenp_hours".
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getiid

getiid

I ntroduction

Syntax

Example

Using Extended Rules

The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

This creates an instance of the default interface of an ActiveX Automation Server.
string_variable = getiid("ProgID");

Thislooks up the Interfacel D (11D) of an interface.

string_variable = getiid("ProglD", "Interface_Name or { Interface ID}");

obj ect ob;

string[50] iid;

iid = getiid("InternetExplorer.Application", "IWbBrowser2");
ob = createobject("InternetExplorer. Application", iid);

ob.Visible = 1;

/1D splays the Internet Explorer on the desktop by setting a
/I property value in an ActiveX Automation Server.
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Using Extended Rules if then...else

If then...else

Introduction Theif, then, and else keywords allow the use of conditional logic. Sterling Gentran: Server
uses conditional logic to test conditions and then, depending on the results of the test,
perform different operations. Conditions can be nested to any level. You can use the if/
then keywordsto execute one or more statements conditionally. The condition istypically
acomparison, but it can be any expression that concludes with a numeric value. Sterling
Gentran: Server interprets the value as either true or false. The system interprets a zero
value as false and a nonzero value astrue.

Sterling Gentran:Server evaluates the if/then condition, and if it istrue, the system
executes al the statements that follow the then keyword. If the condition is false, none of
the statements following then are executed.

You can use the else keyword in conjunction with if/then to define several blocks of
statements, one of which is executed. Sterling Gentran:Server tests the first if/then
condition. If the condition is false, the system proceeds to test each sequential condition
until it finds one that istrue. The system executes the corresponding block of statements
for the true condition. If none of the if/then conditions are true, the system executes the
statements following the el se keyword.

Note
Do not end conditions with a semicolon (;) — thisterminating syntax is necessary for
statements only.

Example if condition then
begin
statenent 1;
st at ement 2;
end
el se
begin
st at ement 3;
st at enent 4;
end

Forms Integration User Guide Sterling Gentran:Server — May 2011



index

index

I ntroduction

Syntax

Example

Using Extended Rules

Theindex function enables you to determine which instance of a particular loop the
trangdlator is currently accessing.

index(integer_variable);

where: integer_variable = integer variable that indicates the
hierarchical level for which you want to
determine the loop count

i ndex(1)

/1 This extended rule is located on the ILD group in the diagram
//below. This determnes the current |oop count for the first |evel
//(CDD) in the hierarchical structure.

INVOIC M- INVOICE DETAILS £F
00D -M- 993999 £
LD -M- 999939 £
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Using Extended Rules insert

Insert
Introduction  Theinsert function allows information in the database tables to be updated.

Syntax insert into tablename [ (fieldlist) ] [ (valuelist) ];

where: tablename DivisionLookup | PartnerLookup | DivisionL ocation
PartnerLocation | DivisionXref | PartnerXref

fieldlist (fieldname[ , fieldname])
fieldname The name of one of thefieldsin the table.
valuelist (String[ , String] )

Notes

» Alist of thetablesis available later in this chapter.

» Thefieldlist lists one or more fieldnames to which dataisto be added.
» Thefieldnames can belisted in any order.

» Thevaluelist must bein the same order asthe field list.

Example updat eSt at us = updat e Part ner Lookup

set Description = "Lookup Update
Test", Text 1="Text 1Updat ed", Text 2="Text 2Updat ed", Text 3="Text 3Updat ed", T
ext 4="Text 4Updat ed"

where Tabl eNane = "PartLkp" and Item= "1";

if updateStatus = 1 then

begin
_ nmessagebox("Update PartnerLookup: Record Not Found, Attenpting
Alnsert...", 1);

insertStatus = insert into PartnerLookup( PartnerKEY, Tabl eNane,

Al'tem Descri ption, Text 1, Text 2, Text 3, Text 4)
Aval ues ("PETZONE", "Part Lkp","1", "Lookup | nsert
ATest ", " Text 1M, "Text 2", "Text 3", "Text 4") ;
if insertStatus = 0 then
begin
nessagebox ("I nsert PartnerlLookup: Failed",1);
end
end

if updateStatus = 2 then
begin

nmessagebox (" Updat e PartnerLookup Failed with GtherError",1);
end
/| Exanpl e assunes that a | ookup table named "PartLkp" has been
//created.
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| eft

left

I ntroduction

Example

Using Extended Rules

The left function extracts a specified number of character from the left side of a string
variable or field and returns the result as a string.

The syntax is asfollows:
string_variable = left(string_variable,num_char)

where: num_char = integer variable

Note
You may not use an ActiveX property asthe first parameter of the left function because
the length of the property is unknown prior to compilation.

string [25] nane;

string [5]tenp_vari abl e;

nane = "Acme Shi ppi ng Conpany"
tenp_variable = left(nane, 4);

/] "tenp_variable" would contain "Acne"
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Using Extended Rules len

len

Introduction The len function is a numerical function that counts and returns the number of characters
in astring. The numerical functions enable you to convert one data type to another.

Syntax  number_char = len(string);

where: num_char = integer variable

Example integer a;
a = 0;
a = len("hello");
/] "a" contains the value 5
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messagebox

I ntroduction

Syntax

Example

Defined
numbers

Using Extended Rules

The messagebox function enables you to display a message box for which you have
designated the format and content. You can specify the number and type of buttons on the
message box, the message icon (e.g., hand, question mark, exclamation point, or asterisk),
and the message displayed. You can also issue areturn value based on the chosen action.

Note
Only String values can be displayed in a message box.

messagebox (" message”,defined_number)

where: message message string
defined number =  defined number of the desired buttons plus the
defined number of the desired icon (if used)

i f messagebox("Do you really want to delete this object?",36) = 6
begin

end

//Di splays a message box with the given string as the nmessage, Yes
//and NO buttons (4) and a question mark icon (32). The nunber and
/1type of buttons (4) plus the icon (32) equals the defined_nunber

/1(36). If the user clicks the Yes button (return value "6"), the
//statenments in the begin/end | oop are executed.

Thistable lists the defined_numbers for the button and icon types.

Defined_Number Button or Icon Types
0 OK button only
1 OK and Cancel buttons
4 Yes and No buttons
16 Icon Hand
32 Icon Question Mark
48 Icon Exclamation Point
64 Icon Asterisk

Sterling Gentran:Server — May 2011 Forms Integration User Guide



Using Extended Rules messagebox

Messagebox  Thistable lists the message box return values.
return values

Return Value Action Selected
1 OK selected
2 Cancel selected
6 Yes selected
7 No selected
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mid

mid

I ntroduction

Syntax

Example

Using Extended Rules

The mid function extracts from a specified position in a string, either to the end of the
string or for aspecified number of characters and returnsthe resultant string. Thisfunction
is zero-based.

string_variable = mid(string_variable,start_pos,num_char)

where: start pos = integer variable
num _char = integer variable

Note
You may not use an ActiveX property as the first parameter of the mid function because
the length of the property is unknown prior to compilation.

string [25] nane;

string [10]tenp_vari abl e;

nane = "Acme Shi ppi ng Conpany”

tenp_vari abl e = m d(naneg, 6, 8);

/1 "tenmp_variable" will contain "Shipping"
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Using Extended Rules ntoa

ntoa

Introduction The ntoa function is a numerical function that converts integers and real numbers into
strings. The numerical functions enable you to convert one data type to another.

Syntax  string = ntoa(integer/real ,string);

where: integer/real =  integer or real number variable
string = string variable

Example Integer b;
string[8] s;
b = 5.5;
nt oa(b, s);
/1 The variable "s" contains the string "5.5".
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param

param

I ntroduction

Syntax

Example

Using Extended Rules

The param function is used to read the value of the PARAM(n) variable. The extended
rule allows you to reference values that have been passed into the translator viathe
command line. The -u switch can be used during the invocation of the translator to pass
valuesin so they can be referenced by an extended rule. Typically, the param extended
ruleis not used by maps that are running within the Sterling Gentran: Server for Microsoft
Windows environment because Sterling Gentran: Server does not use the -u switch when
invoking the translator. However, if you are invoking the trandlator to perform translation
outside of Sterling Gentran:Server (tx32 -f <inputfile> <templatefile> <outputfile>
<reportfile>), you have the option to pass values into the translator viathe -u switch and
reference those values using the param extended rule.

param(integer PARAM _number);
where: interger PARAM_number = the number of the pre-defined variable

For example, if you invoke TX32.EXE in the following manner:

tx32.exe -f input.txt 850.tpl output.txt out.rpt -u
"PurchaseOrder Nunber" -u 12345 -u 500. 25

Then you could write an extended rule in the \GENSRVNT\Tutorial\Pet_850.map that
looks like the following:

string [32] strDescription;
string [32] strPONbr;
string [32] strTotal Cost;
real nTot al Cost;

strDescription = param0);
strPONbr = paran(1);

strTotal Cost = paran(?2);

nTot al Cost = aton(strTotal Cost);

if nTotal Cost > 200 then
begin

nmessagebox (" Get approval from boss", 0);
end

You can run this rule from any scope in your map (e.g., pre-session, post-session, group
onbegin, field, etc.).
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Using Extended Rules

gueryobj ect
Introduction

Syntax

Example

queryobject

The queryobject function is used to request a different interface on an existing object.

object2 = queryobject(objectl, "{I1D}");

where: object2 isthe result that contains the requested interface to
the object
11D = istheinterfaceidentifier of the requested interface

objectl an existing object

obj ect ob, ob2;

ob = createobject("InternetExplorer. Application");

ob2 = queryobj ect (ob, "{EAB22AC1- 30C1- 11CF- A7EB- AOOOOCO5BAEOB} ") ;
//Uses the Interface ID of the desired interface to obtain another
/1 (different) interface of the existing object (objectl).
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readblock

readblock

I ntroduction

Syntax

Example

Using Extended Rules

The readblock function reads a block of data (segment or record) from the input file and
placesit into the argument of a string variable. The readblock and writeblock functions are
used in conjunction with each other to pass a block of datafrom theinput file to the output
file without compliance checking or testing for proper EDI syntax. Together these
functions provide a more efficient alternative of using “wildcard” segments, which are
typically implemented in build and break maps.

readblock(string_variable);

Note
You may not use an ActiveX property as the first parameter of the readblock function
because the length of the property is unknown prior to compilation.

whi | e readbl ock(tenp_buffer) do

begin
if left(tenp_buffer,3) = "IEA" then
begin
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
/I Read segnent frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. |f found, reset file pointer to where it was
/I before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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Using Extended Rules readbytes

readbytes

Introduction The readbytes function reads a number of bytes from the input file. Thisfunction is used
in conjunction with the writebytes function. Used together, the readbytes and writebytes
function provide an efficient method of passing data through a map if the data does not
need to be compliance checked or atered in any way.

Readbytesis similar to the readblock function, but readblock only works with entire
blocks (i.e., an entire segment or record), and readbytes works with any quantity of data,
whether it issmaller or larger than a block.

The readbytes function uses two parameters, first the string variable into which the data
being read will be stored, and second the number of bytes to read.

Syntax  readbytes(read_from_buffer, num_bytes);

where: read from_buffer= string variable into which the data being read will be
stored
num_bytes = integer value representing the number of bytesto read
from the input file.

Note
Readbytes returns the number of bytes it was actually able to read.

Example string [1024] tenpBuffer;
whi | e readbyt es(tenpBuffer,1024) do
begin
writebytes(tenpBuffer, 1024);
End
// Read 1024 bytes frominput file and place in string variable
[/ named tenpBuffer.

writebytes("*OD'OA", 2);
/1 Appends a CRLF to the end of the output file.
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right

right

I ntroduction

Syntax

Example

Using Extended Rules

Theright function extracts a specified number of characters from the right side of astring
variable or field.

string_variable = right(string_variable,num_char)

where: num _char = integer variable

Note
You may not use an ActiveX property as the first parameter of the right function because
the length of the property is unknown prior to compilation.

string [25] nane;

string [10]tenp_vari abl e;

nane = "Acme Shi ppi ng Conpany"
tenp_variabl e = right (nane, 7);

/1 "tenp_variable" would contain "Conpany"
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Using Extended Rules

select

I ntroduction

Syntax

Example

select

The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and "receiverlist” can be a string field, string
variable, or string literal. It isimportant to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

select fieldname into receiverlist from tablename where key = expression [and key =
expression];

string[10]tenp_varl,tenp_var2,tenp_var3;

select Text1l, Text2, Text3 into temp_varl, temp_var2, tenp_var3 Afrom
Partner| ookup where Tabl enane = "Test" and Item ="w dgit"

/| Exanpl e assunes that a Lookup table named "Test" has been
//created.
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set

I ntroduction

Syntax

Example

Using Extended Rules

The set function enables you to define individual components of a datetime variable.

set datetime_component (datetime_variable,integer_variable);

where: datetime_component = individual component of the datetime

variable
datetime variable = datetime variable of which you want to
access a component part
integer_variable = integer variable

i nteger tenp_days;

datetine d;

tenp_days = 15;

d = '12/25/2001";//A fields value in the map can be
/1 assigned to the datetine variable "d"

//or a hard coded val ue can be assigned.

set days (d,tenp_days);

/1 Defines the days of the datetine variable "d" fromvariable
/1" tenp_days".
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Using Extended Rules

strdate

strdate

Introduction The strdate function converts a datetime type into a string using aformat that you specify.
This function allows you to include static characters such as a slash (/), which gives you

accessto full date support.

Syntax  strdate(datetime,"format" ,string);

where: datetime

format
string

Example datetine d;
string[8] s;

d = #DateField;

= datetime variable (month specified as 1-12)
= desired date format
= string variable

strdate(d, "%/ % %", s);

/1 Converts a datetine variable into an eight character string in

//the fornmat

"year/ mont h/ day".

Format specifiers  Thistablelists the format specifiers.

Format Specifier

Description

%8

1SO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
secondsin Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z2)

Note
This date format cannot be combined with any other format
specifier.

%a

Abbreviated weekday name

%A

Full weekday name

%b

Abbreviated month name

%B

Full month name

Forms Integration User Guide
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strdate Using Extended Rules

(Contd)
Format Specifier Description

%d Day of the month as a decimal number (01 — 31)

%H Hour in 24-hour format (00 — 23)

%l Hour in 12-hour format (01— 12)

%j Day of the year as adecimal number (001 — 366)

%m Month as a decimal number (01 —12)

%M Minute as adecimal number (00 — 59)

%S Second as adecimal number (00 — 59)

%U Week of the year as a decimal number, with Sunday as the
first day of the week (00 —51)

%w Weekday as a decimal number (0 — 6, with Sunday as*“0")

%W Week of the year as a decimal humber, with Monday as the
first day of the week (00 —51)

%y Year without the century as a decimal number (00 — 99)

%Y Year with the century as adecimal number

%% Percent sign
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Using Extended Rules

Strstr

I ntroduction

Syntax

Example

strstr

The strstr function finds a substring inside a string. This function returns the position of
the first instance of the designated substring within the specified string. If this function
does not find the specified substring in the string, it returns avalue of -1. Thisfunctionis

zero-based.

integer = strstr("string","substring");

where: integer = integer variable
string = string
substring = part of the string
i nteger d;
d = 0;
d = strstr("m ssissippi","is");

//Finds the first instance of the substring "is" inside the string
//"m ssissippi" and returns the position of that first substring.

Forms Integration User Guide
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unreadblock

I ntroduction

Syntax

Example

Using Extended Rules

The unreadblock function provides a method of moving the input file-pointer back one
block (ablock of datais equivalent to one EDI segment or one positional record). This
function unreads the block of data that was just processed by the readblock function.

Note
Unreadblock should only be used in conjunction with the readblock function. The
unreadblock function will only unread the most recent block of data processed.

Unreadblock is provided as an alternative to using the fseek and ftell functions, and is the
preferred method of moving the file pointer back one block of data. Unreadblock allows
the trandator to correctly track the number of bytes read and number of segments read
during the trandation process by moving the file-pointer back and decrementing the
segment and byte counts accordingly.

unreadblock();

string[1024] tenpBuffer;

whi |l e readbl ock(tenpBuffer) do
begin
if left(tempBuffer,3) = "IEA" then
begi n
unr eadbl ock();
br eak;
end
writebl ock(tenpBuffer);

end

/I Read segnent frominput file and place in tenpBuffer variable.
//Look for the "I EA" segnent tag and, if found, reset the file-
/Il pointer to where it was |ocated before the "I EA" segnent was

/lread. Wite contents of tenpBuffer to output file.
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update

Introduction The update function allows information in the database tables to be updated. This
function is similar to the Update standard rule, except that it provides more flexibility.
Only thetables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It isimportant to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

This table describes how the update function is supported in Sterling Gentran: Server.

| F the map/form is of
type... THEN the update function is...

Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.
Break (Interchange, Only valid on the input side of the map.
Group, or Transaction
Set)
Build (Interchange, Only valid on the input side of the map.
Group, or Transaction
Set)
Print Not supported.
Screen entry Not supported.

ntax  update tablename set fieldname =expression [fieldname =expression] where key =
t date tabl field ion [field ion] where k
expression [and key = expression];

Example  string[15]tenp_vari abl e;
tenp_variable = "5 Pound Hamer";
update PartnerXref set Textl = tenp_variable where MyItem= " and
ATabl enane = "Tool s";
/| Exanpl e assunes that a cross-reference table named "Tool s" has
/I been created.
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while...do

I ntroduction

Example

Using Extended Rules

The while...do function executes a statement repeatedly until the specified termination
condition evaluates to zero. The system tests the terminating condition before each
iteration of the loop, so awhile loop executes zero or more times depending on the value

of the termination expression.

Note

Do not end conditions with a semicolon (;) — this terminating syntax is necessary for

statements only.

i nteger i
i =0;

Wil e i <10 do

Begi n
#Total = Total + 50;
=0 + 1

I f #Total > 100000
Br eak;
El se
Cont i nue;
End

/[/VWhile "i" is |ess than 10 execute the | oop.
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winexec

winexec

Introduction The winexec function enables you to execute another program while running the
tranglator. This program is executed asynchronously. You specify the program and
determine how you want the program window displayed. You can aso return an error
code, if desired. If the error code is greater than 32, the program ran without errors. If the
error code is less than 32, the program did not run because of an error. If the error codeis
“0,” the system is out of memory. If the error codeis“2,” you didn’t specify afile name.
The error code is not the return value from the program you executed.

Note

» If you specify aprogram on another machine or in another domain, you must have the
appropriate permission to access the specified folder.

» If trandation is executing from an unattended process control command, the user ID
under which that service isrunning must have the appropriate permission to access
the specified file.

Syntax  winexec("program",window_display)

where:

window_display

program = executable program name string (if necessary,

including UNC or direct file path)

number that indicates how you want the program

window displayed

Example wi nexec(" program exe", 3)

/1 Exits Sterling Gentran: Server and executes the "program exe"
/] program asynchronously. The system di spl ays the program w ndow
/I maximzed (3).

Window display  Thewindow_display numbers that control the appearance of the program window are as
numbers  follows (you must use the number to indicate how you want the program window

displayed, not the window_display value):

Number

Window_Display

Definition

0

SW_HIDE

Hides the window and activates another
window.

SW_SHOWNORMAL

Activates and displays awindow. If the
window isminimized or maximized, itis
restored to the original size and position.
Thisflag should be specified when
displaying awindow for the first time.

SW_NORMAL

Activates and displays awindow in the
original size and position.

Forms Integration User Guide

Sterling Gentran:Server — May 2011



winexec Using Extended Rules

(Contd)

Number Window_Display Definition

2

SW_SHOWMINIMIZED

Activatesthewindow and displaysitasa
minimized windows.

SW_SHOWMAXIMIZED

Activatesthe window and displaysit asa
maximized window.

SW_MAXIMIZE

M aximizes the window.

SW_SHOWNOACTIVATE

Displays the window in its most recent
size and position, but does not activate it
(the current active window remains
active).

SW_SHOW

Activates the window and displaysit in
its current size and position.

SW_MINIMIZE

Minimizes the window.

SW_SHOWMINNOACTIVE

Displays the window as a minimized
window without activating it (the current
active window remains active).

SW_SHOWNA

Displays the window in its most recent
size and position without activating it
(the current active window remains
active).

SW_RESTORE

Activates and displaysthe window. If the
window was minimized or maximized, it
isrestored to its original size and
position.

10

SW_SHOWDEFAULT

Activates the window and allows
Microsoft Windows to determine the
size and position.
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writeblock

I ntroduction

Syntax

Example

writeblock

Thewriteblock function writesthe data containsin the argument of astring variableto the
output file.The readblock and writeblock functions are used in conjunction with each other
to pass ablock of datafrom the input file to the output file without compliance checking
or testing for proper EDI syntax. Together these functions provide a more efficient
alternative of using “wildcard” segments, which are typically implemented in build and
break maps.

writeblock(string_variable);

whi | e readbl ock(tenp_buffer) do

begin
if left(tenp_buffer,3) = "IEA" then
begin
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
/1 Read segnent frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. |f found, reset file pointer to where it was
/I before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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writebytes

I ntroduction

Syntax

Example

Using Extended Rules

The writebytes function writes a specified number of bytes to the output file. This
function is used in conjunction with the readbytes function. Used together, the readbytes
and writebytes function provide an efficient method of passing data through amap if the
data does not need to be compliance checked or altered in any way.

Note
The system does not append a segment terminator to the end of the string value written to
the output file.

Writebytesis similar to the writeblock function, but writeblock only works with entire
blocks (i.e., an entire segment or record), and writebytes works with any quantity of data,
whether it issmaller or larger than a block.

The writebytes function uses two parameters, first the string variable containing the data
to be written to the output file, and second the number of bytes to write.

writebytes(write_to_buffer, num_bytes);

where:  write to buffer = string variable containing the data to be written to the
output file
num_bytes = integer value representing the number of bytesto read
from the write_to_buffer variable and write to the
output file

Note
If hex values are used in constants, use \Ox instead of .

string [1024] tenp_buffer;
whi |l e readbytes(tenp_buffer, 1024) do
begi n
writebytes(tenp_buffer, 1024);
End
writebytes("*OD'0OA", 2);

/1 Read 1024 bytes frominput file and place in string variable Snaned
tenmp_buffer.

/] Appends a CRLF after the while I oop finishes executing.
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Select and Update Available Options

I ntroduction

Document

The following section contains the database table names and the associated field names
that are available when using the select and update extended rules. Additional keys are
also available for certain tables. Where applicable, a description of the key follows the
field name.

Note

When you use extended rules to reference a Sterling Gentran: Server database table, the
syntax used is different from the actual table name. The appropriate referencing syntax is
outlined for each table in this section.

Example
To refer to the Document_tb in an extended rule, you would reference Document.

These are the field names that are available when using the select or update extended rules
on the Document Table (Document_tb).

Note
Refer to thistable as Document.

» TESTMODE

» AGENCY
» VERSION
» TRANSACTIONSETID
» RELEASE

» DOCUMENTTYPE
» REFERENCEDATA
» DOCUMENTNAME

» APPFIELD1
» APPFIELD2
» APPFIELD3

» APPFIELD4

» APPFIELDS

» APPFIELD6

» DOCUMENTPARTNERKEY
» CONTROLNUMBER

» PARTNERKEY
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Partner

Using Extended Rules

These are the field names that are available when using the select or update extended rules
for anon-division partner on the Partner Table (Partner_tb).

Note

Refer to thistable as Partner.

PARTNERNAME
EDICODE

APPLICATIONPARTNERKEY

These are the additional keys that are available for the Partner table.

PARTNERKEY

ALTERNATEKEY (refersto Application Key)

APPLICATIONPARTNERKEY (refersto Application Key)

Division  Thesearethefield namesthat are available when using the select or update extended rules
to reference the division partner on the Partner Table (Partner_tb).

Note
Refer to this table as Division.

PARTNERNAME
EDICODE

APPLICATIONPARTNERKEY

PartnerL ocation These are the field names that are available when using the select or update extended rules
for anon-division location on the Location Table (Location_tb).

Note

Refer to thistable as Partner L ocation.

CONTACTNAME
NAME

ADDRESS1
ADDRESS2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARY REFCODE
SECONDARY REFCODE
FAX

Sterling Gentran:Server — May 2011

Forms Integration User Guide



Using Extended Rules Select and Update Available Options

DivisionLocation  Thesearethefield namesthat are available when using the select or update extended rules
to reference a division location on the Location Table (Location_tb).

Note
Refer to thistable as DivisionL ocation.

» CONTACTNAME

» NAME

» ADDRESS1
» ADDRESS2
» ADDRESS3
» CITY

» STATE

» ZIP

» COUNTRY

» TELEPHONE

» PRIMARYREFCODE

» SECONDARYREFCODE
» FAX

PartnerLookup  Thesearethefield namesthat are available when using the select or update extended rules
for anon-division lookup on the Lookup Table (Lookup_th).

Note

Refer to this table as Partner L ookup.
» ITEM

» DESCRIPTION

» TEXT1

» TEXT2

» TEXT3

» TEXT4

Thisisan additional key that is available for the PartnerL ookup table.
» TABLENAME
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DivisonLookup  Thesearethefield namesthat are available when using the select or update extended rules
to reference a division lookup on the Lookup Table (Lookup_tb).

Note

Refer to this table as DivisionL ookup.
» ITEM

» DESCRIPTION

» TEXT1

» TEXT2

» TEXT3

» TEXT4

Thisisan additional key that is available for the DivisionL ookup table.
» TABLENAME

PartnerXref  Thesearethefield namesthat are available when using the select or update extended rules
for anon-division cross-reference on the Cross-reference Table (CrossReference _tb).

Note
Refer to thistable as Partner Xref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXT1
» TEXT2
» TEXT3
» TEXT4

Thisisan additional key that is available for the PartnerXref table.
» TABLENAME
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DivisionXref  Thesearethefield namesthat are available when using the select or update extended rules
to reference a division cross-reference on the Cross-reference Table (CrossReference th).

Note
Refer to thistable as DivisionXref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXT1
» TEXT2
» TEXT3
» TEXT4

Thisisan additional key that is available for the DivisionXref table.
» TABLENAME

Interchange  These are the field names that are available when using the select or update extended rules
on the Interchange Table (Interchange_tb).

Note

Refer to thistable as Inter change.
» TESTMODE

» CONTROLNUMBER

» VERSION

» APPFIELD1

» APPFIELD2

» APPFIELD3

» APPFIELD4

» APPFIELDS

» APPFIELD6

» AGENCY

» PARTNERKEY
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Group  Thesearethefield namesthat are available when using the select or update extended rules
on the Group Table (Group_th).

Note
Refer to thistable as Group.

» TESTMODE
» CONTROLNUMBER
» FUNCTIONALGROUPID

» VERSION

» APPFIELD1
» APPFIELD2
» APPFIELD3

» APPFIELD4
» APPFIELDS
» APPFIELD6
» AGENCY

GenericEnvelope  These are the field names that are available when using the select extended rule on the
Segment Generic Envelope Segment Table (GenericEnvel opeSegment _tb).

Note
Refer to this table as GenericEnvelopeSegment.

» CONTROLNUMBER
» SUBCOUNT

» FIELD1
» FIELD2
» FIELD3
» FIELD4
» FIELDS
» FIELD6
» FIELD7
» FIELDS
» FIELD9
» FIELD10
» FIELD11
» FIELD12
» FIELD13
» FIELD14
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GenericEnvelope

Segment

(contd)

Forms Integration User Guide

FIELD15
FIELD16
FIELD17
FIELD18
FIELD19
FIELD20
FIELD21
FIELD22
FIELD23
FIELD24
FIELD25
FIELD26
FIELD27
FIELD28
FIELD29
FIELD30

Select and Update Available Options
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Entry and Print Forms
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Introduction

Inthischapter  Thischapter describes how to customize screen entry and print forms.

Customizing  Onascreen entry form, you can customize the way datais arranged in fields, or the format
Screen Entry  of numbers, dates, or times. You can even prevent fieldsin the screen entry form from
Forms  being displayed when the translation object (compiled form) is used.

Customizing Print  After you select the segments, groups, and elements for the print form, you can customize
Forms theformat of the EDI data asit is generated by Sterling Gentran: Server.
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Screen Entry and Print Forms

Customizing Field L abels

I ntroduction

Procedure

Field labelsidentify the contents of the fields included in a screen entry or print form. The
system uses the element name from the EDI standard as the default to label afield. You
can customize the default field label to be any name you choose.

Recommendation

We recommend that you label every field. If you decide not to label afield, follow the
steps below, but delete the existing field |abel. For example, you might decide not to label
the fields of a company address to be entered in a standard address format, because it is
obviously an address. In thisinstance, the name of the company is on thefirst line; the
street address is on the second line; and the city, state, and zip code are on the third line
and do not need to be labeled.

Use this procedure to customize afield label.

Sep Action

1 Double-click the element for which you want to customize the field label.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Use thistable to determine your next step.
IF you want to customizeafield | THEN...
label on a...
Screen Entry form, Click the Display tab to access
Display options.Proceed to the next
step.
Print form, Click the Print tab to access Print
options.
3 In the Please enter alabel for thisfield, modify the text to customize the
label.
4 Click OK to save the new label and exit the Element Properties dialog
box.
5 Click Generate L ayout on the Main Toolbar to refresh the form display.
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Hiding Fields

Hiding Fields

Introduction Usually, you want all EDI data on a screen entry or print form to be displayed. However,
there may be times when you want to prevent the datain afield from being displayed.

Examplescenarios  You might want to hide afield when it contains a qualifier that is explained by the label of
the associated datafield. In thisinstance, you might set a constant for the field (so that the
field always contains the appropriate qualifier without it having to be entered each time),
then hide the field. You also might want to hide afield if it is a mandatory segment that
must be kept activated, but does not need to be displayed or printed.

Procedure  Usethis procedureto hide afield in a screen entry or print form.

Sep Action

1 Double-click the element that you want to hide on the form.
System Response
The system displays the Element Properties dialog box (Name tab).

2 Use this table to determine your next step.

3 IF you want to hideafield ona... | THEN...
Screen Entry form, » Click the Display tab to access

display options.

» Select the field should not
appear on the form option to
indicate that this field should
be hidden.

» Proceed to the next Step.

Print form, » Click the Print tab to access
print options.

» Clear the Check hereto
includethisfield in print
check box to turn the option
off.

» Proceed to the next Step.

4 Click OK to exit the Element Properties dialog box.
5 Click the Generate L ayout icon to refresh the form display.

Forms Integration User Guide

Sterling Gentran:Server — May 2011



Setting an Initial Value for aField Customizing Screen Entry and Print Forms

Screen Entry Forms

Setting an Initial Valuefor a Field

Introduction If you typically need the same valuein afield each time that field is used, you might want
to set an initial value for the field. After you set an initial value, that value displaysin the
field every time that field is used in the form.

For a screen entry form, the user can override the initial value for afield if you want to
enter data that is different from the initial value. If you do not want the user to be able to
override the field value, then you should use a constant value for the field, instead of an
initial value.

Example

If you know that one person at your company is nearly always the person who should be
contacted by telephone, you might set an initial value for a Telephone Contact field on an
invoice, by setting the telephone contact’s name as the initial value. There are occasions
when someone else at your company is the contact person, however, so you want to be
ableto override the initia value in the Telephone Contact field when those exceptions
occur.

Reference
See Using a Constant Value for a Field on page 7 - 7 for more information.
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Procedure  Usethis procedureto set aninitial value for afield.

Sep Action

1 Double-click the element for which you want to set an initial value.

System Response
The system displays the Element Properties dialog box (Name tab).
Element Properties

M ame |\~"alidati0n| Displa_l,ll Help | Extended Hulel Standard Flulel Eonditionsl

Please enter the name of this field :
|u12?

Pleaze enter a short description of this field :
REFEREMCE MUMEER

Cancel L ulli} Help
2 Click the Display tab.
System Response
The system displays display options.
Element Properties

Mame | Walidation Display IHeIp | Extended F!ulel Standard FIuIeI Condilionsl
Haow should this field be used on the form
% the field should be editable
" the field should be displayed but not editable
' the field should not appear on the form

Please enter the label for this field :

IHeference Mumber

Pleaze enter the masimum number of characters to be displayed : ISD

Please enter the initial valug of this field :

DK‘ Cancel &DD'}' HB||:I
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Customizing Screen Entry and Print Forms

(Contd)
Sep

Action

3

Intheinitial value box, type the value that you want to be the default

displayed for thisfield.

Click OK to savetheinitial valuefor this field and exit the Element

Properties dialog box.
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Using a Constant Value for a Field

I ntroduction

If you always use the same value in afield each time that field is used, you might want to
use a constant value for the field so the user does not have to enter the same information
each time. After you set the constant value, that value displaysin the field every time the
field is used.

CAUTION

YOU CANNOT OVERRIDE THE CONSTANT VALUE FOR A FIELD. IF
YOU WANT TO BE ABLE TO OVERRIDE THE FIELD VALUE, THEN
YOU SHOULD SET AN INITIAL VALUE FOR THE FIELD, INSTEAD
OF A CONSTANT VALUE.

Example

You might set a constant value for a qualifier field on an invoiceif you know that you
never need to override the value in the field. In thisinstance, you would probably hide the
field, aswell.

Reference
See Setting an Initial Value for a Field on page 7 - 4 and Hiding Fields on page 7 - 3 for
more information.
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Procedure  Usethis procedure to use a constant value for an element.

Sep Action

1 Double-click the element for which you want to set a constant value.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E
Ertended Rule I Standard Rule I Conditions I
Hame I W alidation | Dizplay | Summary List I Help

Please enter the name of this figld ;
|0235

Please enter a short description of this field :
FRODUCT/SERVICE 1D QUALIFIER

Cancel | Sl | Help |
2 Click the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select Use Constant
4 From the constant list, select the constant that you want to use. If the

constant that you want to use for thisfield isnot in the list, you need to
create or edit a constant.

Reference
Please see Editing Literal Constants on page 5 - 42 and Editing Literal
Constants on page 5 - 42 for more information.

5 Click OK and the data that was stored in the selected constant isloaded in
the field.
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Creating Definitionsfor a List Box

I ntroduction

Procedure

When Sterling Gentran: Server identifies a group in atransaction set, it creates a separate
frame on the Screen Entry form to contain the data within the group. It also creates alist
box on the parent frame to allow the user access to the itemsin the group. To identify the
item in the group, at least one field needs to be displayed in the list box. Each set of data
can be displayed as a column in the list box. For example, you might have alist box of
items on a purchase order. Within the Items list box, you can set up three columns of data:
» Quantity

» Description

» UnitPrice

To define the list box columns, you would perform the steps below for the Quantity field,
then repeat the steps for the Description and Unit Price fields.

Use this procedure to create a definition for alist box.

Sep Action

1 Double-click the element for which you want to define alist box.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Click the Display tab to access display options.
Element Properties E
Exrtended Rule I Standard Rule | Conditions
Mame | W alidation Display I Summary List I Help

How should this field be used on the form :
 the field should be editable
' the field should be displayed but not editable
" the field should not appear on the form

Please enter the label for this field :

(uantity Invoiced

Fleaze enter the maximum number of characters to be digplayed I'I 0

Please enter the initial value of this field :

Cancel | Lol | Help |

3 Select the display option to indicate that thisfield should be displayed as
not-editable on the form.
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(Contd)
Sep Action

4 Click the Summary List tab to access the summary list options.

5 Select Check hereif thisfield should be displayed on summary lists
check box.

6 From the column lit, select the sequence of this column in the list box.
For example, if thisisto be the first column in the list box, select 1.

7 In the width box, type the width of this column in number of characters
allowed.
Note
Ensure that the column width islong enough to accommodate the average
length (in characters) of the values expected for this column of data.

8 Click OK to savethe list box definition and exit the Element Properties
dialog box.

9 Repeat Seps 1 through 8 for each element in the group that contains data
you want to definein the list box.

10 To label the columns of data set up in the list box, you must add column
headings (static text) to the form.
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Creating Help Text for Fieldsand List Boxes

Introduction You can create context-sensitive Help text for afield or list box to aid screen entry
trangl ation object usersin entering the information required (in the Document Editor). The
Help text displays during data entry when the a user selects afield or an entry in the list
box and presses F1.

HowtocreateHelp  Usethisprocedure to create Help text for afield.
text for fields

Sep Action

1 Double-click the element for which you want to create Help text.

System Response
The system displays the Element Properties dialog box (Name tab).

2 Select the Help tab to access the help options.
3 In the help text list, type the Help text.
Note

Sterling Gentran: Server does not automatically wrap Help text when users
access context-sensitive help in Document Editor. Therefore, you may
want to insert a hard return each time the Hel p text you are typing reaches
the right side of the help text list, rather than allowing the list to scroll to
the right.

4 Click OK to save the Help text and exit the Element Properties dialog
box.

How to create Help List boxes contain information from selected elements in arepeating group. The
text for list boxes  information from each element displays as a column in the list box.

Use this procedure to create Help text for alist box.

Sep Action

1 Right-click the group for which you want to create Help text to access the
shortcut menu. Select Properties... from the shortcut menu.

System Response
The system displays the Group Properties dialog box (Name tab).
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(Contd)
Sep Action

2 Click the Display tab.

System Response

The system displays the options.

Mame Display I Loopingl Loop Extended Flulesl

I | Framnte: aroup bo parent fame

Frame Caption |0400_| ]

List Captiors  [0400_IH1

Frame Help Text

[~
5] _'ILI
Ligtbox Help Text
[~
[ _'ILI
Cancel | Sl | Help |
3 In the Help Text list, type the Help text.
4 Click OK to save the Help text and exit the Group Properties dialog box.
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Creating Help Text for Frames

Creating Help Text for Frames

Introduction The Help text displays during data entry when the a user clicks FRAVE? or selects Frame
Help from the Document Editor Help menu, when the frameis currently in focus.

Procedure  Usethis procedure to create Help text for aframe.

Step

Action

1

Right-click the group for which you want to create Help text to access the
shortcut menu.

Select Properties from the shortcut menu to access either the File Format
Properties dialog box or the Group Properties dialog box (depending on
the level of the group).

Click the Display tab to access display options.

In the Frame Help Text list, type the Help text. For groups, the Frame
Help Text list isonly be active if the Max Usage (found on the Group
Properties dialog box, Looping tab) is greater than “1.”

Click OK to save the Help text and exit the Properties dialog box.
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Formatting Entry Fields

Introduction  Anentry fieldisafield that can be edited. When you create aform, Sterling
Gentran: Server makes every field an entry field by default. For entry fields, you can
change the field type to Display (the field is display-only) or Hidden (the field is not
displayed at all).

Procedure  Usethis procedure to change a display-only or hidden field to an entry field.

Sep Action

1 Double-click the element for which you want to define alist box.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties E2
Extended Rule | Standard Rule | Conditions
MName I Yalidation I Dizplay I Summary List | Help

Fleaze enter the name of this field :
|0358

Fleaze enter a short description of this figld ;
QUANTITY IMVOICED

Cancel | Lppli Help
2 Click the Display tab to access display options.
3 Select the editable option to indicate that this field can be edited.
4 Click OK to exit the Element Properties dialog box.
5 Click the Generate L ayout button on the Main Toolbar to refresh the

display of the screen entry form.
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Formatting Display-Only (Non-Editable) Fields

I ntroduction

When you create a form, Sterling Gentran: Server makes every field an entry field by

default. You can change the default to Display if you want afield to be display-only (non-
editable). Data can be viewed but not edited in display-only fields.

Procedure

Use this procedure to format a display-only field.

Sep

Action

1

Double-click the element for which you want to define alist box.

System Response
The system displays the Element Properties dialog box (Name tab).

Element Properties
Extended Rule | Standard Rule I Conditions
Name | Yalidation I Display I Summary List | Help

Pleaze enter the name of this field :

|0358

Fleasze enter a short degcription of this figld ;
QUANTITY INVOICED

T Cancel pply Help

Click the Display tab.

System Response
The system displays the display options.

Select the display option to indicate that thisfield should be displayed as
not-editable on the form.

Click OK to exit the Element Properties dialog box.

Click the Generate L ayout button on the Main Toolbar to refresh the
display of the screen entry form.
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Introduction Formatting Screen Entry and Print Forms

| ntroduction

In this chapter After you customize screen entry and print forms, you can format the organization and
size of the fields in the form. This chapter explains how to format screen entry and print
forms.
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Selecting One or More Fields or Field Labels

Selecting Oneor More Fieldsor Field Labels

Introduction You must know how to select one or more items (fields and field labels) in aform to be
able to move, resize, align, or change the spacing between them.

Referenceitems  Thelastitem you select is outlined by diagonal lines. Thisitem is called the reference. All
other items you selected are now outlined by a solid line.

When you arrange a group of items, the reference item is significant because the
alignment, size, and spacing between all other itemsin the group is relative to the
alignment, size, and spacing of the reference item.

Procedure  Usethis procedure to select afield or afield label.

Step

Action

In the Layout Window, click anywhere on the field or field label.

Note

The Lock Labelsicon on the Main toolbar enables you to specify that
when you click afield (in the Layout Window), its corresponding label is
selected at the sametime.

System Response
Thefield or field label is outlined by diagonal lines. The selected field
al so displays handles, which mark the corners and sides.

T i
= Almquired el [+
Imoice Dok m = = Fibauitd Fiekd  Cash -
[ecounk ae Givmn
Immice Nunbe: | &= Roquikel Fikd ¥
PO, Momher : Lirika Shipped i Lleed
e o I L |
* ShipToMane | |
e | |
Ciy [ |
Gt ] Tpcode [ ]
¥

Do you want to select more fields or field |abels?

If yes, proceed to the next Step.
If no, continue with another formatting task.
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(Contd)
Sep

Action

3

Press CTRL and click another field or field label.

4

Repeat these stepsfor all other fieldsand field 1abelsin the form you want

to select.

CAUTION

WHEN YOU SELECT TWO OR MORE ITEMS, MAKE
SURE THE ITEM YOU WANT ASTHE REFERENCE IS

THE LAST ITEM YOU SELECT.

10 Imynlce
*=Aequied Field i
. . ] B = Fequred Feld ¥ Cech =
Inica e ::E . o - Discourly e Given
* - Irevvice Nunber tE=H="iE|F'£I
1 PO Nurbe 'm Liks Shipped & Lied
L
T Duaie [ [ - oo |
*  ShpTolme | |
hdrez [ |
Gy | |
w0 o —
L

Did you select any fields by mistake?

» Ifyes, pressCTRL, and click the item you want to deselect.

Note

If the item you deselect is the reference, the item that was selected
immediately prior to the last item (the reference) becomes the new

reference.

» If no, continue with another formatting task.
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Grouping Fieldsand Field Labels

I ntroduction

Procedure

Grouping Fields and Field Labels

You can group fields and field labels that are in the same area of aform.

Use this procedure to group fields or field labels.

Sep Action
1 In the Layout Window, click and drag the mouse across the form items
that you want to group.
Note
Asyou drag the mouse, the grouped area is designated by dotted lines
similar to the following illustration.
B0 Immice
! " Recuied Fiekd |+
e [ e[
o Imecis Hunter | | 5k Ragind Fud
. P, Huibier I:l Linit= Shipped i Llo=d
’ 5
* Oudiir [ [ oo | |
* - SHpToName | |
Pbiges: [ |
Gy I |
s [ CT —
L&]
2 Rel ease the mouse button.

System Response

All items completely contained within the selection area are selected. The
last item in the group is the reference. All the selected items are now a
group, and can be moved together, as well as resized or spaced relative to
the reference.
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Resizing Fields
Overview

Introduction ~ When you generate aform, each field is automatically sized to the length specified in the
Display Length field on the Display Properties dialog box. If you change the display
length of afield after the form is generated for the first time, you must resize that field in
the Layout Window.

Resizing fields  You can resize afield in one of these two ways:
» Usethe Sizeto Length function.
» Usethe mouse to reshape the field manualy.

In addition, you can resize groups of fields or field labels so that they are all the same size.

Note
Resizing the field graphically maintains the integrity of the form.
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Using Sizeto Length

Using Size to Length

Introduction You can resize one or more fields according to the display length specified on the Display
Properties dialog box.

Procedure  Usethis procedureto resize afield or group of fields with the Size to Length function.

Sep Action
1 In the Layout Window, select the form fields that you want to resize.
Reference
See Grouping Fieldsand Field Labels on page 8 - 5 for more information.
2 Select Size To Length from the Display menu to resize according to the

display length specified on the Display Properties dialog box for each
selected item.
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Resizing a Field Manually

Formatting Screen Entry and Print Forms

Procedure  Usethis procedure to manually resize one field.

Sep

1

Action
In the Layout Window, select aform field.
Click and drag one of the handles.
B10 Invmice
== Hagid Fsd ki
- = - Requied Fl i Caih =
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Resizing Groups of Fields Manually

Introduction You can resize severa fields at the same time if you want them all to be the same size.

Example
You might want to resize agroup of fields that are similar in size to give the form amore

consistent appearance.

Reference
See Grouping Fields and Field Labels on page 8 - 5 for more information.

Procedure  Usethis procedure to resize a group of fields manually.

Sep Action

1 In the Layout Window, select the form fields you want to resize.

Note
Ensurethat thefield that isto be used asthe referencefor resizing all other
selected fields is selected last.

2 Select Size Equally from the Display menu.

System Response
The system equally resizes all selected items. The referenceis used asthe
basis for determining the size of al other selected items.
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Arranging Fields
Overview

Introduction To arrange thefields and field labels in a screen entry or print form, you must move, align,
and space the fields and field labels in the Layout Window.
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Changing Grid Settings

I ntroduction

Sterling Gentran:Server provides agrid, indicated by the dots in the background of the

form, that you can use to assist you in formatting the layout of a screen entry or print form.
The dots on the grid form horizontal and vertical lines that guide you in aligning and
spacing fields and field labels. The dots on the grid are evenly spaced, with the spacing
between them measured in pixels. The grid is not printed (for print forms) —it is only
displayed in the background of the template to aid you in arranging fields and field labels.

SnaptoGrid  Sometimesit is useful to haveitems snap to the grid when you move them. With the *“ Snap
Controls  controlsto the alignment grid” feature turned on, as you move, align, or space items, they
snap to the lines of the grid. Thisfeature can help you align items with one another or
evenly space them.

Procedure

Use this procedure to change the grid settings.

Step

Action

Select Preferences from the Options menu.

System Response

The system displays the Preferences dialog box (the Tree tab displays by
default). The Preferences dialog box is aproperty sheet that enablesyou to
set global defaults for Sterling Gentran: Server.

Click the L ayout tab.

System Response
The system displays the layout options.

Do you want the grid to display?
» If yes, click Show alignment grid.
» If no, continue with step 6.

Do you want the fields and field labels to snap to the grid?

» If yes, click the Snap controlsto the alignment grid check box to
turn the option on. Proceed to the next Step.

CAUTION

IF YOU ARE USING ALIGNMENT LINES, YOU SHOULD
NOT USE THE “SNAP CONTROLSTO THE ALIGNMENT
GRID” FUNCTION, ASTHISHINDERSTHE
EFFECTIVENESSOF THE ALIGNMENT LINES.
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(Contd)
Sep Action
5 Do you want to change the spacing between the dots on the grid?

» If yes, type the number of pixelsin the Grid spacing box. The default
setting isfive pixels. Increasing the number of pixelsincreasesthe
spacing between the dots; decreasing the number of pixels decreases
the spacing between the dots.

» If no, proceed to the next Step.

6 Click OK to exit the Preferences dialog box.
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Using Alignment Lines

Using Alignment Lines

Introduction Sterling Gentran: Server enables you to create alignment lines (lines that guide you in
aligning the components of the Layout Window).

Procedure  Usethe procedure to display, move, or remove aignment lines.

Sep

Action

1

In the Layout Window, double-click the vertical or horizontal ruler just
below the graduation where you want the alignment line to be located.

WARNING

IF YOU ARE USING ALIGNMENT LINES, YOU SHOULD
NOT USE THE SNAP CONTROLSTO GRID FUNCTION
(ON THE GRID SETTINGSDIALOG BOX), ASTHIS
HINDERSTHE EFFECTIVENESS OF THE ALIGNMENT
LINES.

System Response
The the system displays the alignment line.
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Do you want to move the alignment line to another position?

» If yes, click and drag the black triangle that connects the alignment
lineto theruler.

» If no, proceed to the next Step.

Do you want to remove an alignment line?

» If yes, double-click the black triangle that connects the alignment line
to the ruler. Proceed to another formatting task.

» If no, proceed to another formatting task.
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Moving Fieldsand Field L abels

Introduction You can move fields or field labels from their default positionsto other locationsin a
form. You can move either individual items or groups of items.

Recommendation
If you intend to resize fields, we recommend that you do so before moving them, since the
arrangement of the fields might depend on the size of the fields.

Example

You might be able to arrange more fieldsin arow if the fields are smaller. Therefore, you
should resize the fields before you arrange them, so you can accurately determine how
many fields can fit in arow.

Reference
See Using Sze to Length on page 8 - 7 or Resizing a Field Manually on page 8 - 8 for
more information about resizing fields.

Procedure  Usethis procedure to move afield or field label.

Sep Action
1 In the Layout Window, click the field that you want to move and drag it to
the new location in the form.
Note
You can use Lock Label icon on the Main toolbar to move alabel with its
associated field.

If you are moving a group of selected items, all itemsin the group stay in
position relative to each other as they are moved from one location to the
next.
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Aligning Fieldsand Field L abels

Introduction  When fields and field labels are created, they are automatically |eft-aligned in the screen
entry or print form, with one field per line. However, you can align particular fields and

field labels with one another in different ways to change the way they are arranged in the
form.

If you intend to resize or move fields or field labels, we recommend that you do so before
you align them. If you align fields first, then move or resize them, the fields might move
out of alignment.

Reference

See Using Sze to Length on page 8 - 7 or Resizing a Field Manually on page 8 - 8 for
more information about resizing fields. See Moving Fields and Field Labels on

page 8 - 14 for more information about moving fields or field labels.

Align Controls  You use Align Controls to specify how you want items on your form to appear. Thistable
Options  describesvalid Align Control options.

Align Control Description

Top Alignsall selected items with the top of the reference item.

Bottom Aligns all selected items with the bottom of the reference
item.

Left Aligns al selected items with the | eft side of the reference
item.

Right Alignsall selected items with the right side of the reference
item.

Horizontal Centre Alignsall selected items horizontally in the frame.

Vertical Centre Aligns all selected items vertically in the frame.

Procedure  Usethis procedureto align fields and field labels.

Sep Action

1 Select two or more fields that you want to align in aform.

Note
Ensure that the field or field label to be used as the reference for aligning
all other selected itemsis selected last.

2 Select Align Controls from the Display menu.
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(Contd)
Sep Action
3 From the Align Controls cascading menu, select how you want the
selected items to be aligned.
CAUTION

USE CAUTION IN SELECTING THE ALIGNMENT
METHOD TO ENSURE THAT ITEMSDO NOT OVERLAY
EACH OTHER. USE TOP, BOTTOM, OR HORIZONTAL
CENTRE ALIGNMENT FOR ALIGNING A HORIZONTAL
ROW OF ITEMS; USE LEFT, RIGHT, OR VERTICAL
CENTRE ALIGNMENT FOR ALIGNING A VERTICAL
COLUMN OF ITEMS.
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Spacing Fieldsand Field L abels

Introduction  Whenfieldsand field |abels are resized and moved, the spacing between them can become
uneven. You can change the spacing between items to give the form a more consistent

appearance.

Recommendation

If you intend to resize or move fields or field |abels, we recommend that you do so before
you space them. If you space fields first, then move or resize them, the spacing between

the fields might change.

Reference
See Using Sze to Length on page 8 - 7 or Resizing a Field Manually on page 8 - 8 for
more information about resizing fields. See Moving Fields and Field Labels on

page 8 - 14 for more information about moving fields or field labels.

Spacing Options  You use the Space Evenly cascading menu to specify how far apart fields display
vertically or horizontally on the form. This table describes valid spacing options.

Method

Description

Across

Evenly spaces all selected items with the next selected
item to the | eft or right (horizontal spacing).

Down

Evenly spaces all selected items with the next selected
item above or below (vertical spacing).

Procedure  Usethis procedure to evenly space several fields and field labels.

Sep

Action

1

Select three or more items that you want to be evenly spaced in aform.

Note
Ensure that the field or field label to be used as the reference for evenly
spacing all other selected itemsiis selected last.

Select Space Evenly from the Display menu.

From the Space Evenly cascading menu, select the type of spacing you
want for the selected items.

Forms Integration User Guide
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Resizing and Positioning a Frame

Introduction You can define how aframeis sized and positioned in the Document Editor by resizing
and positioning that frame in the Forms Integration subsystem. When aform is created,
the default location for framesis the upper left corner of the Layout Window. When a
screen entry tranglation object is opened in Document Editor, its frameis sized and
positioned the same as it was when the source form was last compiled.

Example
If you want the frame to be centered on the user’s desktop, then you must center the frame
in the Layout Window in the Forms Integration subsystem before compiling it.

Warning  When you resize the frames of a screen entry form, you must resize based on the
resolution of the target monitor (i.e., the monitor on which the end user views the
tranglation object). For example, if you size the frames of a screen entry form on a Super
VGA monitor, the compiled translation object may not fit in the display area of aVGA
monitor.

Procedure  Usethis procedure to resize and position aframe.

Sep Action

1 In the Layout Window, point to the frame border, when the pointer
becomes a t drag the border to resize.

2 To position the frame in the Layout Window, click and drag the frametitle
to the new position in the Layout Window.
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Resizing Drop-Down Combo Boxes

Introduction A drop-down combo box consists of atext box and adrop-down list. When the combo box
is closed, the text box and the drop-down arrow are displayed. When the combo box is
opened, the available field values (and a scroll bar, if there are more values than can fit in
the drop-down list) are displayed. You can resize a drop-down combo box in a screen
entry form to make the size appropriate for the field values contained in the list.

Resizing  Please remember the following tips about drop-down combo boxes:

Drop-Doyvn » When you change the width of the combo box, the width of the text box changes.
Combo Box Tips (The width is the same whether the drop-down combo box is opened or closed.)

» When you change the height of the combo box, the height of the drop-down list is
changed. When closed, the drop-down combo box islong enough to contain one item.
When opened, the drop-down combo box is long enough to contain several items.

» Thewidth of the drop-down combo box should be appropriate to the width of the
values availablein thelist. You should make the width a few spaces wider than the
longest value available. For example, if the values available are two-character codes,
the combo box does not need to be twenty characters wide. However, if the valuesin
thelist consist of several words or along string of characters, then the combo box
should be wide enough for usersto read the longest field value.

» The height of the drop-down combo box should be appropriate to the number of
values availablein thelist. For example, if there are just four values available, you
might make the drop-down combo box long enough to contain all of the values, so
that users do not have to scroll through a short list. However, if there are one hundred
values available, you might make the drop-down combo box long enough to view up
to eight values at once.

Note
The scroll bar is automatically added to the drop-down combo box when the number of
available values exceeds the vertical space provided in the combo box.

Procedure  Usethis procedure to resize a drop-down combo box.

Sep Action

1 In the Layout Window, click the drop-down combo box you want to resize
in the form.
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(Contd)
Sep Action
2 Drag a handle of the combo box.
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Setting Tab Sequences

I ntroduction

Procedure

The tab sequence is the order in which the cursor moves from field to field in a screen
entry form when a user presses TAB. When you create a screen entry form, the system

automatically

positions the fields and sets the tab sequence for those fields. However, you

usually want to modify the tab sequence of the fields to meet your screen entry

requirements.

Note

You can set tab sequences for screen entry forms only.

Use this procedure to set the tab sequence of fieldsin a screen entry form.

Sep

Action

1

Select Set Tab Order from the Display menu. Numbers are displayed in
the fields in the form to indicate the current tab sequence.
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Click the fields sequentially, in the order in which you want the tab
seguence to be set. For example, if you want afield that is currently set as
third in the tab sequence to becomefirst in the tab sequence, then click
that field first. The field that was first in the tab sequence is now the
second, the second is now the third, etc. After you have clicked all the
fields, the tab sequence numbers are no longer displayed in the fields.

Note

If you want to change the tab sequence for some of the fields without
having to click them all, then select Set Tab Order from the Display menu
when you have finished setting the tab sequence for the fields you want to
change. The tab sequence numbers are no longer be displayed.

Forms Integration User Guide

Sterling Gentran:Server — May 2011



Adding and Positioning Static Text Formatting Screen Entry and Print Forms

Adding and Positioning Static Text

Introduction Static text istext that is always included in the screen entry or print form. Examples of
static text include legends and column headings. Field labels, which usually accompany
fieldsto identify the contents of the fields, are not considered static text.

Procedure  Usethis procedure to add and position static text to a screen entry or print form.

Sep Action

1 Click Add Text from the Display menu. Text is added to the current
frame, displayed in the upper left corner of the frame. If the translation
object is larger than the frame (there is a scroll bar on the right side of the
frame), the static text displays in the upper left corner of the part of the
translation object that displays, not at the top of the trandlation object.

2 Type the static text in the new selected text field.

System Response
The system displays the Text Properties dialog box.

Text Properties E2

Edit Text |

ITth

Cancel el Help |
3 Click OK to add the static text.
4 To move the static text, click and drag it to a new location in the frame.
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Modifying Frame Titles

Introduction The system automatically titles the framesin a screen entry form when the form is created,
based on the name of the file, segments, or groups. You can modify the frame title of any
repeating group (EDI file, segment, or group) in a screen entry form. For example, if you
use several purchase order forms, each for adifferent trading partner, you might give each
purchase order form a dlightly different title to distinguish one form from the others.

Procedure  Usethis procedure to modify aframetitle.

Sep Action
1 Highlight the form component (EDI file, ssgment, or group) of the frame
title you want to modify.
2 Select Properties from the Edit menu to display the appropriate dialog
box for the form component you selected.
» If you select the EDI file, the system displays the File Format
Properties dialog box.
» If you select asegment, the system displays the Segment Properties
dialog box.
» If you select agroup, the system displays the Group Properties dialog
box.
3 Click the Display tab to access display options.
4 In the Frame Caption box, type the new frametitle.
5 Click OK to display the new frame title in the appropriate frame.
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Modifying List Box Names

Introduction  When Sterling Gentran: Server identifies a group in atransaction set, it creates a separate
frame to contain the data within the group. It also creates alist box in the parent frame to
allow the screen entry translation object user access to the items in the group. The system
automatically sets the names for list boxesin aform when the form is created, based on
the name of the segment or group. You can modify the names of the list boxesin screen
entry forms. For example, you might want to modify alist box hameto give it aname that
is more meaningful to you than the default name that the system givesit.

Procedure  Usethis procedure to modify alist box name.

Sep Action

1 Highlight the form component (segment or group) containing the list box
name you want to modify.

2 Select Properties from the Edit menu to display the appropriate dialog box
for the form component you selected.

» If you select a segment, the system displays the Segment Properties

dialog box.
» If you select agroup, the system displays the Group Properties dialog
box.
3 Click the Display tab to access display options.
4 In the List Caption box, type the list box name.
5 Click OK to display the new list box name in the form.
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Adding Column Headingsto List Boxes

Introduction A singlelist box in aform may contain two or more columns of data, depending on which
fields have been designated list box fields. Although the system automatically generates
field labels for list boxes, it does not automatically generate column headings for them. If
you want the columnsin alist box to be labeled, you must add the column headings by
using static text.

Procedure  Usethis procedure to add column headingsto alist box.

Step

Action

1

In the Layout Window, click Add Text from the Display menu.

System Response

Text is added to the current frame, displayed in the upper left corner of the
frame. If the tranglation object islarger than the frame (thereisascroll bar
on theright side of the frame), the static text displays in the upper left
corner of the part of the trandlation object displays, not at the top of the
tranglation object.

Type the static text in the new selected text field.

System Response
The system displays the Text Properties dialog box.

Click OK to add the static text.

To move the column heading, click and drag the column heading to a new
location in the frame.

Forms Integration User Guide

Sterling Gentran:Server — May 2011



Adding Column Headings to List Boxes Formatting Screen Entry and Print Forms

Sterling Gentran:Server — May 2011 Forms Integration User Guide



APPENDIX

A

Error Messages

Contents D OVEIVIBW . o oottt A-2
P CompileError MeSsages. . . ..o oo A-3
» Sterling Gentran:Server Error MeSSages. . .. oo oo vve e it A-16

Forms Integration User Guide Sterling Gentran:Server — May 2011



Overview Error Messages

Overview

Introduction The Sterling Gentran: Server error messages and other informational messages are noted in
the Compile Errors dialog box when you compile the trand ation object or in the Error
section of the Extended Rul es dial og boxes when you compile an extended rule containing
errors prior to compiling the transl ation object, and when you commit an erroneous action
in Sterling Gentran: Server.

Theinformational messages are dependent on the context of the program, and are intended
to be self-explanatory. The error messages are described in the topics accessed below,
along with the actions you can take to correct the problem.

Inthisappendix  This appendix explains how to determine the action you should take when you receive an
error message.
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Compile Error M essages

Introduction The Compile Error Messages are displayed in the Compile Errors dialog if you compile a
tranglation object with errors. Or, error messages are displayed in the Error section of an
Extended Rule dialog if you compile the extended rule containing errors prior to
compiling the translation object. After you correct the cause of the errors, click the
Compile button again to ensure that the ruleis error-free.

Messages  The compile error messages are listed by the four- or five-digit message number and the
error message text. The error definitions contain the actions that you can take to correct
the problem (if appropriate) and a description that includes possible causes of the error.

Msg ID M essage Text Explanation/Your Action

1000 expected "' Explanation
The rule does not have the required “.”

between a group name and afield name.

Your action
Insert a“.” between the group name and field

name.

1001 no statement to compile Explanation
Theruleis does not contain any statements.

Your action
Add a statement or statements to the rule.

1002 unexpected end of Explanation
program The rule was not complete.
Your action
Finish therule.
1003 expected ', Explanation

The rule does not have the required “,
between parameters.

Your action
Insert a“,” between parameters.

1004 expected *;’ Explanation
A statement was not terminated properly.

Your action
Terminate the statement in an appropriate

manner.

1006 no statements to compile Explanation
The body of an IF/ELSE or WHILE condition

was empty.

Your action
Complete the body of the unfinished condition.
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Msg ID M essage Text Explanation/Your Action

1007 syntax error ... Explanation
The map component contains a syntax error.

Your action
Correct the syntax error.

1008 expected ‘# Explanation
The rule does not have the required “#” before

afield name.

Your action
Insert a“#" before the field name.

2000 group ... undefined Explanation
The rule references a group that does not exist.

Your action
Change the reference to an existing group or

delete the reference.

2001 ... iIsnot amember of ... Explanation
Therule references afield that does not belong

to the specified group.

Your action

Change the reference to an existing field in the
specified group.

2002 insufficient indices to Explanation
access group ... The rule does not give the full addressing for a

group.

Your action
Compl ete the addressing for the group.

2003 too many indicesto access | Explanation
group... The rule uses too many addresses for the

group.

Your action
Address the group correctly.

2004 ... has not been defined Explanation
The rule references an undefined variable.

Your action
Define the variable in the declarations section.

2005 out of temporary variables | Explanation
The rule could not be compiled because some

expressions are too complex.

Your action

Simplify the expressions and compile the rule
again.
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Msg ID M essage Text Explanation/Your Action
2008 field type unknown Explanation

The compiler was unable to determine the type
of afield.

Your action
Verify that a Data Type is selected for this

field.

2009 cannot reference alocal Explanation _
field with no current group | Therule (probably pre- or post-session)
references alocal field, but is not associated
with any group.
Your action
Reference the field using the proper
addressing.
2010 instances of '%1' are Explanation
transient and cannot be The rule references an output group using full
accessed addressing. Thisform of addressing isonly
appropriate for input groups.
Your action
Reference the output group with the proper
address.
2011 no field specified Explanation
The rule omits afield reference.
Your action
Add the field reference to the rule.
2012 group ... is promoted and Explanation
cannot be accessed in this | You attempted to access a promoted group in a
manner COUNT or DELETE rule.
Your action
Do not COUNT or DELETE a promoted
group.
2100 ...isnot an array variable | Explanation
Therule uses array indexing for avariable that
isnot an array.
Your action
Use the proper indexing for the variable.
2101 .... array index required Explanation

The rule uses an array variable without using
the necessary array indexing.

Your action

Add the necessary indexing to the array
variable.
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Msg ID

M essage Text

Explanation/Your Action

2102

.... array overflow

Explanation
Therule uses an invalid array index.

Your action
Use the proper array index for the array

variable.

2103

only one wildcard index is
permitted

Explanation
The rule uses more than one wildcard index.

Your action
Only one wildcard index is permitted per rule.

2104

awildcard index must be
specified

Explanation
The rule does not specify awildcard index

when required.

Your action
Add awildcard index where necessary.

2200

expected a string

Explanation
A required string or string variable is not

supplied.

Your action
Add the required string or string variable.

2201

string overflow

Explanation
A string overflow occurred.

Your action
Verify that the size of atarget string isequal to

or greater than the source string.

3000

array size expected in
declaration of ...

Explanation
Invalid array declaration.

3001

declaration of ... missing "'

Explanation
Invalid array declaration.

3002

string size expected

Explanation
Invalid string declaration.

3003

string size missing '

Explanation
Invalid string declaration.

3004

variable name expected

Explanation
Invalid variable declaration.

3005

... dready defined

Explanation
Two variables with the same name are defined

at the same scope.

Your action
Rename one of the two variables.

Sterling Gentran:Server — May 2011

Forms Integration User Guide




Error Messages Compile Error Messages

(Contd)
Msg ID M essage Text Explanation/Your Action
3006 expected an accumulator Explanation
number, found ... Invalid accumulator reference.
3007 ...isnot avalid Explanation
accumulator number Invalid accumulator reference.
4000 expected a numeric Explanation
expression, found ... You specified something other than the

expected numeric expression.

Your action
Specify the correct numeric expression.

4001 expected aterm, found ... | Explanation
You specified something other than the

expected term.

Your action
Specify the correct term.

4002 expected '+' or *-' Explanation
You specified something other than the
expected “+” or

Your action
Specify " +!l Or " _H .

4003 expected ** or /' Explanation
You specified something other than the

expected “*” or
“/H i

Your action
SpeCIfy [[TRR 1} Oru/u .

4004 expected )’ Explanation
You specified something other than the

expected “)”.
Your action
Specify “)".

4005 expected afactor, found ... | Explanation
Invalid numeric expression.

4006 expected ‘(' Explanation
You specified something other than the

expected “(”.

Your action
Specify “(".
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(Contd)
Msg ID

M essage Text

Explanation/Your Action

4007

... isof incorrect type

Explanation
The specified expression is of an incorrect

type.

Your action
Specify the correct type for the expression.

4008

expected arelational
operator

Explanation
You specified something other than the

expected relational operator.

Your action
Specify the correct relational operator.

4009

missing argument

Explanation
A required parameter was omitted.

Your action
Add the required parameter.

4010

gnment expected

Explanation
The assignment operator was omitted from an

assignment statement.

Your action
Add the correct assignment operator to the

statement.

4011

operator ... requirestwo
arguments

Explanation
Only one parameter was supplied for abinary

operator.

Your action
Supply a second parameter for the binary

operator.

4012

converting real to integer
may lose significant digits

Explanation
You are converting areal number to an integer.

Your action
Verify that losing decimal placesis acceptable
in thisinstance.

4013

expression too complex,
use sub-expressions

Explanation
A mathematical expression contains too many

terms.

Your action
Group some of the terms of the mathematical
expression in parentheses.
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Msg ID M essage Text Explanation/Your Action

4014 expected an integer, found | Explanation
B The compiler expected to find an integer

instead of [...].

Your action
Supply the correct value for [...].

4015 no valid condition Explanation
specified You did not specify avalid IF or WHILE
condition.

Your action
Supply avalid condition in the IF or WHILE
Statement.

4100 expected a date, found ... Explanation
A date isrequired but not supplied.

Your action
Specify a date.

4101 expected a date modifier, Explanation
found ... A date modifier was required but not supplied.

Your action
Specify a date modifier.

4102 ... isnot adate Explanation
Invalid date expression.

5000 THEN expected Explanation
The compiler expected a THEN condition.

5001 DO expected Explanation
The compiler expected a DO condition.

5002 END expected Explanation
The compiler expected a END condition.

5004 FROM expected Explanation
The compiler expected a FROM condition.

5005 INTO expected Explanation
The compiler expected aINTO condition.

5006 END without BEGIN Explanation
An END statement was found without a

corresponding BEGIN statement.

Your action
Insert aBEGIN statement in the correct

|ocation.
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Msg ID

M essage Text

Explanation/Your Action

5016

misplaced ‘BREAK’

Explanation
The compiler found BREAK outside of aloop.

Your action
Remove the BREAK or placeit inside aloop.

5017

misplaced ‘ CONTINUE’

Explanation
The compiler found CONTINUE outside of a

loop.

Your action
Remove the CONTINUE or placeit inside a
loop.

5018

too many parameters

Explanation
Too many parameters were supplied for a

function.

Your action
Remove the unnecessary parameters.

5019

too few parameters

Explanation
Too few parameters were supplied for a

function.

Your action
Add the necessary parameters.

6000

expected a database table
name

Explanation
The compiler expected a database table name.

Your action
Insert a database table name in the necessary

location.

6001

expected a database
column name

Explanation
The compiler expected a database column

name.

Your action
Insert adatabase column name in the necessary

location.

6002

too many column receivers
specified

Explanation
The number of columns specified did not

match the number of receiversin a SELECT
statement.

Your action
Correlate the number of columns specified in

the SELECT statement to the number of
receivers.
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Msg ID M essage Text Explanation/Your Action
6003 too few column receivers | Explanation

specified

The number of columns specified did not
match the number of receiversin a SELECT
statement.

Your action
Correlate the number of columns specified in

the SELECT statement to the number of
receivers.

6004

WHERE expected

Explanation
The compiler expected a WHERE statement.

6005

expected a database key

Explanation
Aninvalid database key was specified in a

WHERE statement.

Your action
Specify the correct database key in the

WHERE statement.

6006

WHERE not allowed with
this database table

Explanation
A WHERE statement is not necessary to

access the specified database table.

Your action
Remove the WHERE statement.

6007

invalid key combination

Explanation
The combination of keys specified in the

WHERE statement is not avalid unique
compound key to the table.

Your action
Specify avalid combination of keysin the

WHERE statement.

7000

... isnot avalid seek type

Explanation
You used an invalid seek type in FSEEK.

Your action
Use BEGIN, END, or CURRENT.

20001

Record ..., Field ... : date
field missing date format

Explanation
The specified field does not have a date

format.

Your action
Edit the field and choose a date format.

20003

Field ... : constant used in
standard rule does not exist

Explanation
The standard rule for the specified field usesan

invalid constant.

Your action
Correct the standard rule or create the constant.
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Msg ID

M essage Text

Explanation/Your Action

20004

Field ... : codelist used in
standard rule does not exist

Explanation
The standard rule for the specified field usesan

invalid code list.

Your action
Correct the standard rule or create the code list.

20005

Field ... : thequdifier field
specified in a use constant
standard ruleisinvalid

Explanation
The standard rule for the specified field usesan

invalid qualifier.

Your action
Correct the standard rule.

20006

Field...: thefield specified
to store the code
description in a use code
standard ruleisinvalid

Explanation
The standard rule for the specified field

designates an invalid field for the description.

Your action
Correct the standard rule.

20007

Record ... : the specified
key field ... : usesan
undefined constant

Explanation
The key field for the specified record uses an

invalid constant.

Your action
Correct the key field.

20008

Record ... : the specified
key field ... : usesan
undefined code list

Explanation
The key field for the specified record uses an

invalid code list.

Your action
Correct the key field.

20010

Record ... : the specified
key field ... : isinactive

Explanation
The key field for the specified record is

inactive.

Your action
Activate the key field.

20700

only one binary dataand
one binary length field are
permitted

Explanation
You have more than one binary data and/or

more than one binary length element in one
segment.

Your action
Remove the additional binary data and/or

binary length elements from the segment.
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Msg ID

M essage Text

Explanation/Your Action

20701

binary length must precede
binary data

Explanation
The binary length element must be sequenced

before the binary data element in the segment
so the translator knows how much data to
expect.

Your action
Move the binary length element to before the

binary data element.

20702

incomplete binary data

Explanation
You marked a segment as binary, but did not

include either a binary length element or a
binary data element (or both).

Your action
Add abinary length element and/or a binary

data element to the segment.

20703

group ... has no active
child objects

Explanation
You tried to compile the trandlation object, but

the specified group is empty.

Your action
Activate at least one child object in the group.

20704

Element ..., Attribute ...
enumerated attribute
declared without
accompanying standard
rule

Explanation
The specified XML attribute is configured to

use an enumeration but there is no code list
standard rule that defines the allowed values.

Your action
Define a use code list standard rule for the

specified attribute.

20705

Element ..., Attribute ...
codelist usedin
enumerated attribute does
not exist.

Explanation
The code list for the specified enumerated

XML attribute does not exist.

Your action
Define the code list.

20706

Element ..., Attribute....:
default valueis not valid ...

Explanation
The specified default value is not in the code

list for this XML attribute.

Your action
Ensure that the specified default valueisin the

codelist.
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Msg ID M essage Text Explanation/Your Action
20707 | Codelist ..., Attribute ... Explanation
value used in enumerated | A valuein the enumeration code list is not
attribute code list does not | valid for XML.
production Verify that al the value specified in the code
list are valid (legal) for an XML attribute.
20708 | Entity ... : Entity valueis Explanation
invalid The value of the specified entity is not valid
(legal) in XML.
Your action
Correct the entity value.
20709 | ...:lllega useof reference | Explanation
character An entity reference was not terminated
properly.
Your action
Correct the entity reference.
20710 | ...: Malformed character Explanation
reference encountered An XML character reference was not
terminated properly.
Your action
Correct the character reference.
20711 ... - Invalid character Explanation
referenced An XML character referenceisinvalid.
Your action
Correct the character reference.
20712 ... . Referenceto undefined | Explanation
entity encountered The referenced entity is not defined.
Your action
Define the correct entity.
20713 | ...: Circular entity Explanation
references encountered An entity references an entity that in turn
references the original entity.
Your action
Do not reference the original entity ina
circular manner.
20714 | ...: default doesnot match | Explanation
the attribute type The default value is the wrong type for the
attribute.
Your action
Either correct the type of the attribute or the
default value.
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20715 | ...: Containsillegal Explanation
character (‘<") The default value containstheillegal character

1<n.

Your action
Correct the default value.
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Serling Gentran:Server Error M essages

I ntroduction

M essages

The Sterling Gentran: Server error messages are displayed when you commit an erroneous
action. When the system displays an error message, you must first acknowledge the
message by either clicking OK, and then take the appropriate action.

The error messages are listed alphabetically below by thefirst |etter of the error message
text. The error definitions contain the actions that you can take to correct the problem (if
appropriate) and a description that includes possible causes of the error.

M essage Text

Explanation/Your Action

A codelist entry must have a code
value

Explanation
You attempted to add a code without an

associated code value.

A code list must have an e ement id

Explanation
You attempted to create a code list without an

element ID.

A codelist for this element already
exists. You must use another element
id or delete the original code list first

Explanation
You attempted to create a code list with the

same element ID as an already existing code
list.

Your action

Either change the element ID or delete the
original codelist.

A condition field is required

Explanation
You established a conditional relationship that

requires acondition field, but did not specify a
condition field.

A datatypeisrequired.

Explanation
You did not specify the Data Type of afield.

A field must have anamethat is
unique within its parent group

Explanation
You tried to give afield aname that is already

in use by another field within the same group
(not necessarily the same record).

A group must have a unique name

Explanation
You tried to give agroup anamethat is already

used by another group or record.

A group or record with a maximum
usage of 1 cannot be split or promoted

Explanation
You attempted to split or promote a single-

occurrence group or record. Thisisnot avalid
action.
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M essage Text

Explanation/Your Action

A key field has been selected but no
key value has been specified.

Explanation
You established akey field without specifying

akey value.

A Memory Exception has occurred.

Explanation
A system error occurred.

Your action
Exit Sterling Gentran: Server and restart

Microsoft Windows.

A name must be entered

Explanation
You did not specify a name for an object.

A problem occurred while attempting
to closeloop .... Thisis probably due
to incorrect standards.

Explanation
An error occurred when reading from the

standards.

A record must have a unique name

Explanation
You tried to give arecord aname that is

aready used by another group or record.

A Resource Exception has occurred.

Explanation
A system error occurred.

Your action
Exit Sterling Gentran: Server and restart

Microsoft Windows.

A serious error was encountered
whilst accessing the clipboard and the
action was abandoned

Explanation
The system aborted a cut, copy, or paste

operation because a serious error occurred.

Your action
Perform the cut, copy, or paste operation again.

A system error was encountered
while compiling the tranglation object

Explanation

While compiling atranglation object, a system-
related problem, such as lack of memory,
prevented the compile from completing.

Your action
Close unnecessary applicationsto free

memory, and reboot your computer (if
necessary), and then recompile the tranglation
object.

A TDF could not be generated due to
alack of available memory. Either
restart Microsoft Windows or close
down other applications, then try

again

Explanation
While generating a TDF, the system ran out of

memory.

Your action
Exit Sterling Gentran: Server, restart Microsoft

Windows and regenerate the TDF.
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M essage Text

Explanation/Your Action

An accumulator must be chosen for
thisentry

Explanation
You did not specify the accumulator to be used

in aUse Accum standard rule.

Aninvalid usage count has been
entered

Explanation
You entered an invalid usage count for arecord

or group.

No actions have been chosen for this
accumulator entry

Explanation
You selected an accumulator but did not

specify any actionsfor it in aUse Accum
standard rule.

No alternate accumulator has been
selected

Explanation
In aUse Accum standard rule, you attempted

to create an accumulator entry that used an
alternate accumulator, but did not specify
which alternate accumulator should be used.

No character ranges have been
specified for this token.

Explanation
You did not specify the characters allowed for

asyntax token.

No fields have been used in this
relationship

Explanation
You established a conditional relationship but

did not specify the fields involved.

No more accumulator entries can be
created

Explanation
You attempted to create more than six

accumulator entriesin a Use Accum standard
rule.

No more field mappings can be
created

Explanation
You attempted to create more than eight field

mappings for a Select standard rule.

The constant |D must be unique.

Explanation
You entered aliteral constant identifier in the

ID field that is already used in an existing
constant.

Your action
Type aunique literal constant identifier in the
ID field.

The contents of the clipboard cannot
be pasted into the trand ation object at
this point

Explanation
Either the Clipboard does not contain copied or

cut data, or you are trying to paste XML
information into a positional file format or
paste position information into an XML file
format.

Thefile format cannot be deleted

Explanation
You tried to delete afile format object.
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M essage Text

Explanation/Your Action

The Maximum Usage must be greater
then zero and not less than the
Minimum Usage.

Explanation
You entered an invalid maximum usage count.

The number of entriesto be split must
be greater than zero and less than the
maximum number of entriesin the
original

Explanation
You entered an invalid number in the Split

dialog box. The number to be split must be
greater than zero and less than the maximum
number of entriesin the original.

The translation object could not be
compiled

Explanation
The tranglation object is not ready to be

compiled.

The token code must be unique.

Explanation
You attempted to create a syntax token with the

same token identifier as an existing syntax
token.

Your action
Type aunique token identifier in the Token

field.

These fields cannot be linked because
theinput field is deeper than the
output field. The translator would be
unable to address the input field.

Explanation
You are attempting to create an invalid link. A

valid link involvesan Input field and an Output
field that are at the same level.

This code already exists. You must
use another code or delete the original
codefirst

Explanation
You attempted to add a code to a code list that

already contained that code.

Thisfield cannot be linked to another
field

Explanation
Due to an unknown error, Sterling

Gentran: Server was unable to begin creating
the link.

Thisfileisnot avalid Gentran
translation object

Explanation
You attempted to open (load) afilethat isnot a

translation object.

You have entered an invalid character
or character code in Record
Delimiter 1

Explanation
You entered an invalid Record Delimiter 1 on

the Positional File Format Properties dialog
box.

You have entered an invalid character
or character code in Record
Delimiter 2

Explanation
You entered an invalid Record Delimiter 2 on

the Positional File Format Properties dialog
box.

You have entered an invalid decimal
separator or character code.

Explanation
You entered an invalid decimal separator.
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M essage Text

Explanation/Your Action

You have entered an invalid element
delimiter character or character code

Explanation
You entered an invalid element delimiter.

You have entered an invalid Pad
character or character code

Explanation
You entered an invalid pad character for a

positiona field.

You have entered an invalid release
character or character code

Explanation
You entered an invalid release character.

You have entered an invalid sub-
element delimiter character or
character code

Explanation
You entered an invalid sub-element delimiter.

You have entered an invalid tag
delimiter character or character code

Explanation
You entered an invalid tag delimiter.

You must enter a description of the
translation object.

Explanation
You attempted to save the translation object

without entering the translation object
description on the Trand ation Object Details
dialog box.

Your action
Type the translation object description in the

Description field on the Translation Object
Details dialog box. This field must be unique
because it is used by the system to identify the

map.

You must enter a subtable name.

Explanation
For a Select or Update standard rule, the

selected table requires you to specify atable
namein the Sub Tablefield.

You must enter avalid character
range.

Explanation
You entered an invalid character range for a

syntax token.

You must enter avalid syntax token.

Explanation
You did not enter avalid token identifier in the

Token field when creating or editing a syntax
token.

You must enter avalue for this
constant.

Explanation
You did not specify avalue for the constant in

the Value field when creating or editing a
syntax token.

You must enter an ID.

Explanation
You did not specify aliteral constant identifier

for the constant in the ID field when creating
or editing a syntax token.
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M essage Text Explanation/Your Action

You must enter the name of theauthor | Explanation
of this translation object You attempted to save the translation object

without entering the name of the translation
object author on the Trandation Object Details
dialog box.

You must select a constant type. Explanation
You did not select a constant type from the

Type list when creating or editing a constant.

You need to specify Input and Output | Explanation

File Typesfor the new trandation You clicked OK on the Create New

object Translation Object dialog box without
selecting both the Input Format Type and
Output Format Type.
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Overview

Assumptions  Use of this appendix assumes that you:

» Arefamiliar with the use of ActiveX Automation Servers and languages such as
Visual Basic.

» Know the Trandator Programming Language (TPL) constructs for creating,
manipulating, and deleting ActiveX objects.

» Know the ProgID of the ActiveX object and all its exposed interfaces.
» Understand how and when extended rules are invoked and their scope.
Advanced feature

User exits are an advanced feature of Sterling Gentran: Server that should only be used
with the above prerequisites.

Restrictions  Sterling Gentran: Server extended rules selectively support ActiveX technology.

Supported
Sterling Gentran: Server extended rules support:

» ActiveX Automation Servers.
» Some ActiveX Controls, but only those that work as Automation Servers.

Not supported
Sterling Gentran: Server does not support:

» ActiveX controlsthat are not ActiveX Automation Servers. Such ActiveX controls
must be hosted in a graphical user interface (GUI) display, and therefore cannot be
used from extended rules.

» ActiveX Arrays(e.g., the VT_ARRAY datatype modifier)

» References(e.g., the VT_BY REF datatype modifier) except for output parametersin
method calls. In thisinstance, references are only valid for the duration of the method
cal.

»  Sterling Gentran:Server does not read registry entries or type libraries when
compiling extended rules to verify the accuracy of programmatic identifiers
(ProglDs) or interfaces.

» Extended rulesthat compare two ActiveX properties or method results, or any
combination of properties or method results. This type of comparison isinvalid
because property and method types are unknown prior to compilation and thusit is
not possible to generate the correct comparison code.
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Definition of ActiveX Terminology

What is Activex?

What isan
ActiveX
automation
server?

What isthe
I Dispatch
interface?

What isa method?

What isa
property?

What are ActivexX
controls?

Forms Integration User Guide

ActiveX isaterm that encompasses a set of rules that define how applications should
shareinformation. ActiveX grew out of technologies developed by Microsoft, specifically
Object Linking and Embedding (OLE) and Component Object Model (COM).

An ActiveX automation server isan ActiveX component (a.DLL or .EXE program) that
can expose part of its functionality, specifically properties and methods, via the I Dispatch
interface to another program on the system.

Some ActiveX controls function as automation servers.

The|Dispatch interfaceisastandard COM interface. Automation Serverstypically expose
their methods and properties through this interface.

A method is an action or function that is performed by an object (e.g., acalculation or a
search).

A property is acharacteristic or parameter of an object (e.g., type, size, or creation date).

ActiveX controls are a specifically defined method of implementing ActivexX
technologies. Basically an ActiveX control is a software component that executes
common tasks and can integrate into the user interface of an application that provides the
necessary ActiveX control host functionality.

The ActiveX control specification enables you to build component software that interacts
with your application and Sterling Gentran:Server. ActiveX controls require a user
interface, so they are not appropriate for tranglation user exits. These controls can be
developed in avariety of programming languages, including Visual Basic.
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Serling Gentran: Server User Exit Overview

Why use user User exits allow you to enhance your functionality or fulfill specific requirements that
exits?  Sterling Gentran:Server does not perform during normal translation.

User exitswith  Sterling Gentran:Server supports user exitsin all types of translation objects through
Gentran  extended rulesthat enable the use of Microsoft’s ActiveX technology. This feature allows
you to use extended rules to invoke custom functionality that was created as an ActiveX
Automation Server.

Specifically, you can:

» create objects,

» delete objects,

» query objects,

D  access properties, and
» invoke methods.
Note

You can create your own custom functionality as an ActiveX Automation Server, or you
can use third party Automation Servers.

Sterling Gentran: Server supports ActiveX indexed properties, specifically these types of

index:

» variant
» numeric
» string

Theindex support alows you to use these syntaxes (if they are supported by your
Automation server):

n
n
n

ob. property[1];
ob. property[“Count”];
ob. property[ob. nethod()];

Sterling Gentran: Server also supports chaining of ActiveX method calls and properties,
which simplifies extended rules for Automation servers with moderately complex object
models (e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.iten]“Mssageld’].val ue
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supported
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conversion

Objects
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Sterling Gentran:Server User Exit Overview

User exits may be used in the following manner.

» To accessyour database table to perform cross-reference or lookups instead of using

the Sterling Gentran: Server tables.

» To perform complex pricing calculations (e.g., involving multiple customers, where
they are located, and where the product is sold).

The following table lists the extended rule data types and the corresponding ActiveX data
types that are supported for use with user exits:

Extended Rule Data Type ActiveX Data Type
INTEGER VT_14
REAL VT_RS8
DATETIME VT_DATE
STRING VT_BSTR
OBJECT VT_DISPATCH

The Sterling Gentran: Server translator automatically converts the extended rule data type
to the ActiveX datatype, whenever possible. If the conversion cannot be performed, a
type mismatch error is written to the Audit Log and the extended rule isimmediately
terminated. An error is also written to the translator report, if oneis used by the operation.
Since an export operation does not generate a translator report, any conversion errors
during export translation are only written to the Audit Log.

ActiveX automation servers use the datatype OBJECT, which consists of two elements:
properties (a defined set of data) and methods. A method is afunction that is defined by
the interface of the object.

All objects that are automation servers provide the default interface | Dispatch, which
exposes the internal functions of an application to Sterling Gentran:Server. You can aso
expose other interfaces.

Example
Internet Explorer exposes the interface |WebBrowser2.
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Syntax  The object must be declared and then created viathe CREATEOBJECT command, by
pointing to the object’s I Dispatch interface. Then, the object’s methods may be invoked
using the syntax object.method(parameters).

The user may specify the Progl D and an optional InterfacelD (11D). If you just specify the
ProgID, Sterling Gentran: Server uses the default IDispatch interface. ThelID isa
machine-readable identifier that uniquely identifies the interface of an object (e.g.,
{00020300-00B000-C00004005300}). Interfaces can also be identified by their human-
readable name (e.g., | Dispatch).

Note
Each 11D must be enclosed in braces{}.

L ocation The location of the user exit in the map depends on what the user exit needs to do and
what you want the scope of the rule to be. Typically, you might:

» declare an object in the On Begin rule of the Input side of the map (Loop Level
Extended Rules dialog box of Input positional file),

» create and use the object in the On Begin rule of the Input side of the map (Loop
Level Extended Rules dialog box of Input positional file), and

» deletethe object in the On End rule of the Output side (Loop Level Extended Rules
diaog box of Output EDI file).

Note

The sample above isintended as an example only. You can declare, create, use, and delete
an object in an extended rule for a map component at any hierarchical level, including
field level extended rules, if appropriate.

Reference
See Defining a Form Component Extended Rule on page 6 - 11 for more information
about creating extended rules for various form components.
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Examples of User Exits

I ntroduction

Defining object
variable

Creating a default

interface

Creating a specific
interface

This section contains examples of the construction of user exits. In this section the
following conventions apply:

» Boldtypefaceis used to express what you need to type.

» Linesthat aretoo long to fit on one line in this section may be continued on the next
line using a line-continuation character (A).

» A double dash (//) introduces comments.

This example defines a variable that represents an ActiveX Automation Server:

object ab;

This example creates an instance of the default interface of the Internet Explorer ActiveX
Automation Server:

obj ect ob;

ob = createobject(“Internet Explorer. Application”);

// Creates an instance of the default interface of an ActiveX
/] Aut omati on Server.

This example creates an instance of the Internet Explorer ActiveX Automation Server and
requests a specific interface:

obj ect ob;

ob = createobject(“InternetExplorer. Application”, “{EAB22AC1-30Cl1

A- 11CR- A7EB- 000C05BAEOB} ") ;

/Il Creates an instance of a specific interface of an ActiveX Autonation
//Server. In this case, the IIDis known (specified in braces).

/] Not e:

/1 The createobject command is nore efficient if you use the 11D
/linstead of the interface nane.

This example creates an instance of the Internet Explorer ActiveX Automation Server,
where the interface identifier of the desired interface is unknown, but the name of the
interfaceis IWebBrowser:

obj ect ob;

string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2");
ob = createobject(“InternetExplorer. Application”, iid);

/Il Creates an instance of a specific interface of an ActiveX

/1 Automation Server. In this case, the IIDis not known, so the

/1 Progl D and name of the interface (IWbBrowser) are specified and
/1 Gentran: Server |looks up the IID. The IIDis l|loaded into the
/Istring variable “iid” and then that value is used to create the
/] obj ect .
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Deleting an object  An object must be deleted before the end of the map that usesiit. It is more efficient to
delete the object immediately when you no longer need it, although the Sterling
Gentran: Server translator deletes the object automatically at the end of the map. Also, if
you assign one object to another one, both copies of the object must be deleted for that
object to be properly unloaded.

This example deletes the object “ob” that was used in the previous examples:
del et eobj ect (ob);

Gettingaproperty  This example obtains a property value from an ActiveX Automation Server:

value obj ect ob;
string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2”);
ob = createobject(“InternetExplorer.Application”, iid);

IF ob.Visible = 1 THEN

BEG N

/1 The property value is accessed.

END

//Test to see if the systemdisplays the Internet Explorer.

Setting a property  Thisexample sets a property valuein an ActiveX Automation Server:

value obj ect ob;
string[50] iid;
iid = getiid(“lInternetExplorer.Application”, “lWbBrowser2");
ob = createobject(“InternetExplorer. Application”, iid);
ob. Visible = 1;
/1 The property value is set.
/1 Display Internet Explorer on the desktop.
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To pass parameters to a method, use the syntax objectname.methodname(parameters).
The Sterling Gentran: Server trandator automatically converts the extended rule data type
of the property to the ActiveX datatype, whenever possible. If thereis no directly
corresponding type in the extended rules, the conversion is performed as well as possible
by the operating system.

Note

Sterling Gentran:Server relies on default data types. For example, Sterling Gentran: Server
convertsVT_CURRENCY (which isan unknown datatype to the translator programming
language) to areal or numeric data type. If the conversion cannot be performed, atype
mismatch error iswritten to the Translator Report and the extended rule is immediately
terminated.

Example
This example navigates to aweb page by passing the URL to the Navigate method of
Internet Explorer:

obj ect ob;

string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2”);
ob = createobject(“InternetExplorer. Application”, iid);

ob. Navi gat e(“ww. st erl i ngconmer ce. cont) ;

/I Navigates to the IBM Sterling web page by passing the URL to
//the Navigate nmethod of Internet Explorer. Note: URL nust be
/lenclosed in quotation marks.

To return values in output parameters, use the syntax
objecthname.methodname(l nputParameter, OUT OutputParameter).

Note

» Input and output parameters may occur anywhere in the parameter list.

» Output parameters must be preceded by the OUT keyword.

» When an extended rule variableis used as an output parameter, the ActiveX datatype
must match exactly.

Reference
See Data types supported on page B - 5 for alist of ActiveX datatypes and the analogous
extended rule data type for each.

Example
This example decrypts datain afield:

obj ect ob;
ob = createobj ect (“Your Conpany. DecryptionUserExit");
ob. Decrypt (“Encrypti onKey”, OUT #Fi el d_Nane);
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Testing successful ~ This example tests the value of an object against zero to determineiif it was correctly
object creation  created:
obj ect ob;

ob = createobj ect (“Your Conpany. DecryptionUserExit”);
IF ob = 0 THEN

BEG N

/] Qoj ect not created properly; performtask X

END

//Test to see if the object was created successful. If it was not

//created, performthe specified task.

Obtaining another ~ Thisexample usesthe 11D of an object to obtain a different interface of an existing object
interfaceof an  (objectl):
existing object  opject ob, ob2:
ob = createobject("InternetExplorer. Application");
ob2 = queryobj ect (ob, "{EAB22AC1-30C1- 11CF- A7EB- 0000C05BAEOB} ") ;
If the I Dof the desired interface is unknown, use the getiid function
to determne the correct |ID and then use the queryobject function, as
this exanpl e denonstrates:
obj ect ob, ob2;
string[50] iid;
ob = createobject("InternetExplorer. Application");
iid getiid("InternetExplorer. Application", "I|WDbBrowser2");
ob2 queryobj ect (ob, iid);

Accessinga  Thisexample uses a user exit to cross-reference a UPC code with avalue in a database to
database  return an SKU number. This example adds the user exit to an invoice (import) map (refer
to the Sterling Gentran:Server TUTORIAL folder, PET_810.MAP for an example). The
user exit code isimplemented by increments in the map, with each section added to the
logical map component.

On Begin Extended Rule
Type the following code into the On Begin extended rule of the INPUT positiona file:

/1 Decl are the object

obj ect ob;

// Create an instance of the Visual Basic Active X Automation Server
ob = Creat eQbj ect (" SCUPCSKU. SKUResol ve");

/1 To create an instance of the C++ ActiveX Automati on Server

/luse the follow ng command i nstead:

/1ob = CreateCbject(“UpcSku. Application”);

if ob =0 then

begin

MessageBox (" Create Object failed",0);
end
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Accessinga INVDETAIL.UPCCODE Field Extended Rule
database  Typethefollowing code into the UPCCODE field extended rule on the Input side of the
(contd) map (INVDETAIL record):

string [100] nmsg;
msg = "UPC Code = ";
concat ( nmsg, #UPCCODE, 12) ;

//Call the automation server
#UPCCODE = ob. Resol veSKU( #UPCCODE) ;
concat (nsg, ", SKU Code = ", 13);
concat ( nsg, #UPCCODE, | en( #UPCCODE) ) ;

/1 Di splay nessage box to user listing UPC code and SKU mat ches
MessageBox(nsg, 0) ;

On End Extended Rule
Type the following code into the On End extended rule of the INPUT positional file:

/1 Del ete the object
del et eobj ect (ob) ;

Note

See Examples of Automation Servers on page B - 12 for sample automation servers
(written in Visual Basic and C++) that access a Microsoft Access Database to cross-
reference a UPC code with an SKU code.
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Examples of Automation Servers

Introduction The following pages contain sample automation servers that access a Microsoft Access
Database to cross-reference a UPC code with an SKU code. Thefirst exampleiswrittenin
the Visual Basic programming language and the second onein C++.

Note
Both of the following automation servers could be used with the “ Accessing a database”
user exit extended rules described in Accessing a database on page B - 10.

Visual Basic  This sample automation server was written in the Visual Basic programming language. It
Automation Server accesses a Microsoft Access Database to cross-reference a UPC code with an SKU code.
The syntax is: ResolveSKU(UPCCode as Sring). Note that after compiling the
Automation Server (SCUPCSKU.EXE), it was registered using REGSRV 32.EXE because
it was not self-registering.

/1 This is a Visual Basic Active X EXE project. Al code shown here
//resides
//in the SKUResol ve class. (Class 1 was renaned to SKUResol ve).
/1 To access the database, the follow ng reference was included in
//the project: Mcrosoft DAO 2.5/3.5 Conpatibility Library.
/1 The following line forces the conpiler to nmake sure all variables
//are declared prior to use within the program
Option Explicit
/1 This function receives a UPC code as it’s only paraneter and
/lcross-references it with a value in the database to get the
/I correspondi ng SKU code.
Publ i ¢ Functi on Resol veSKU(UPCCode As String) As String
Dim DB As Dat abase, RS As Recordset
Set DB = DBEngi ne. Wr kspaces(0) . OpenDat abase
A("c:\ GENSRVNT\t ut ori al \ upcsku. ndb")
Set RS = DB. OpenRecordset (" UPCSKU', dbQpenDynaset)
/1 Make sure there are no trailing spaces on the paraneter passed
//to this function.
UPCCode = Tri m{ UPCCode)
/1Since the database is case-sensitive nake sure that the paraneter
/lhas all capitalized letters init.
UPCCode = UCase( UPCCode)
RS. MoveFi r st
//Loop until we find the UPC code or until the end of the recordset
/1is found.
Whi | e Not RS. ECF
//1f we find the UPC code, return the 'SKU code associated with it.
If RS("UPCCode") = UPCCode Then
Resol veSKU = RS(" SKUCode")
Exit Function
End If
RS. MoveNext
Wend
/1 No mat chi ng UPC code was found for the paraneter passed to the
//function. Returnaval uestatingthat therewas no SKUf ound.
Resol veSKU = "No Record Found"
End Function
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This sample automation server was written in the C++ programming language. It performs
exactly the same function as the previous Visual Basic sample user exit—accessing a
Microsoft Access Database to cross-reference a UPC code with an SKU code. Note that
after compiling the Automation Server (UPCSKU.DLL), it was registered using

REGSRV 32.EXE because it was not self-registering.

/1 This is a MFC AppW zard (dll) project with the Automati on option
/lselected. Al code shown here resides in the CUpcSkuMai n cl ass
/Iwhich is derived from CCnrdTarget. Wien the class was created in
/1 Cl assWzard, the ProglD

/1" UpcSku. Appl i cation" was specified in the "Createable by type
/11D field.

/1 This ProglDis different than the one used for the VB exanple so
//that both Autonmtion servers can co-exist in the registry.

/1 To access the database, a class (CUpcSkuDaoRecordset) derived
/1from CDaoRecordset is needed. DAO and Snapshot options were
//selected and the location of the database (Upcsku.ndb) was
//specified during the creation of the class in C assW zard.

/1 Include the header file for the derived recordset class

#i ncl ude "UpcSkuDaoRecordset. h"

/1 This function is called when the |ast reference for this

/' aut omati on object is released

voi d CUpcSkuMai n: : OnFi nal Rel ease()

{
CCndTar get : : OnFi nal Rel ease();
/1 Since we used DAO to access the database,
/1 term nate DAO now so the DLL can unl oad.
if (Afxd eCanExitApp())
Af xDaoTern() ;
}

/1 This function receives a UPC code as it’'s only paraneter and
/lcross-references it with a value in the database to get the
/I correspondi ng SKU code.

BSTR CUpcSkuMai n: : Resol veSKU( LPCTSTR UPCCode)

{
CString strResult;

CString sUPCCode = UPCCode;

CDaoDat abase DB;
DB. Open(" C:\\ GENSRVNT\\ Tut ori al \\ Upcsku. mdb", FALSE, TRUE);

CUpcSkuDaoRecor dset RS( &DB) ;
RS. Qpen() ;
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C++ Automation  // Make sure there are no trailing spaces on the parameter passed
Server (Contd) //to this function.

sUPCCode. Tri nRi ght () ;

/1l Since the database is case-sensitive nake sure that the
// parameter has all capitalized letters init.

sUPCCode. MakeUpper () ;
RS. MoveFirst();

/1 Loop until we find the UPC code or until the end of the recordset
/1is found.

while ( !'RS.ISEOF() )

{
/1 1f we find the UPC code, return the SKU code

/! associated with it.

if ( RS.mUPCCode == sUPCCode )

{
strResult = RS. m SKUCode;

RS. d ose();
DB. C ose();

return strResult.AllocSysString();
}

RS. MoveNext () ;
}

/1 No matching UPC code was found for the paraneter passed to the
/1 function. Return a value stating that there was no SKU found.

strResult = "No Record Found";

RS. d ose();
DB. d ose();

return strResult. Al ocSysString();
}
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How to Create a User Exit

Beforeyou begin  The ActiveX Automation Server must be installed on the same machine as the Sterling
Gentran: Server trand ator (where you are using the translation object that contains the user
exit).

Procedure  Usethis procedure to create a user exit.

Sep Action
1 Start the Sterling Gentran: Server Application Integration subsystem.
2 Open the map in which you want to apply a user exit.
3 Determine where the user exit will be located in the map (e.g., session
rule or extended rule).
Note

When you apply a user exit to amap component, subordinate map
components may also be able to execute the same user exit.

4 Construct the user exit.
Reference

» See Defining a Form Component Extended Rule on page 6 - 11 for
more information about creating extended rules for various form
components.

» See Alphabetic Language Reference on page 6 - 41 for more
information about the createobject, deleteobject, and getiid
commands.
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| ntroduction

Inthisappendix  This appendix describes how to use translator command line interface to invoke the
services of TXDE.EXE (print and screen entry trandlator).

Note
Thisinterfaceis currently used by all applications that invoke the services of the
TXDE.EXE trandlator.
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Command L ine Syntax

Introduction  The syntax of the command lineis:

txde[-r] [-n]

-a server]

-e eventid]

-p fil enane]

-d [dockey] ]

-u param -u param .}

—_————

Syntax parameters  Thistable describes the command line syntax parameters.

Parameter Description
-r Read-only mode
-n Do not move document to InDrawer after print or export
-a Server (name of audit server to which TXDE.EXE connects)
-e EventID (identifier of an audit event to which this translator belongs)
-P Print mode
Subparameter Description
filename Path to file containing document keys (one
per line)
-d Screen entry mode
Subparameter Description
dockey Key of document to edit, if modifying an
existing document
-u User-defined parameters accessible from extended rules
Subparameter Description
param Parameter value
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.
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1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

Trademarks I1BM,thelBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.
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IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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GLOSSARY

Glossary

?In Documents  This Sterling Gentran: Server browser contains alist of documents that were received by
the system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Sterling Gentran: Server browser contains alist of documents that were imported into
the system via unattended processing but are invalid.

acknowledge-ment  Thisterm is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When trandlating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  The Automotive Industry Action Group (AIAG) is the standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committeeisthe
chief EDI standards-setting organization for the United States.

application file  If you are creating an import or export map, you must define your application to the
Application Integration subsystem. In Sterling Gentran: Server terminology, your
application fileis also referred to as a fixed-format file or a positional file. Your
application file must contain all the information that you either need to extract from your
partner’s document (if the map isinbound) or need to send to your partner (if themapis
outbound), so that your system can accurately process the data.
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application system

application system

codelist tables

colours

communications
session

Communicator
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compliant

component data
element

composite data
element

conditions

constant

Glossary

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visualy define
the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one continuous period of
connection. This could include sending two or three interchange envelopes to a network,
each for adifferent trading partner.

Thisisthe Sterling Gentran: Server communications software. The Communicator enables
you to send, receive, resend, establish communication port definitions, establish
communication profiles, establish communication scripts, and view and delete
communication sessions.

This function compiles the form and creates a tranglation object. The form that you create
using Sterling Gentran: Server is a source form. When that source form is compiled, the
result is a compiled translation object. This translation object must be registered with the
Sterling Gentran: Server system before you can useit.

This means that the document conformsto the EDI standards as defined by the translation
object.

A simple data element that belongs to a composite data element. Component data
elements are also called sub-elements.

A contains two or more component data elements or sub-elements. Composites are
defined by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

Seerelational conditions.

This standard rule enables you to move aliteral constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.
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cross-reference
table

date/time

deactivation

default

document

EANA

EDI

EDI File Format
Window

EDI standard

EDIA

Forms Integration User Guide

cross-reference table

Thistable is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

Thistype of field or element contains adate or time. If you specify that afield or element
is adate/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
asasingle entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If atrading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

The EDI File Format Window contains the EDI file format. When you click a segment or
group in the EDI file format, the corresponding frameis displayed in the Layout Window.
When you click an element in the EDI file format, the corresponding layout component is
highlighted in the Layout Window.

Thisisthe rules for turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).
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EDIFACT Glossary

EDIFACT  Thisisthe standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

element The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition
Simple data element A single piece of information defined by the
standards.
Composite data element A data element that is made up of multiple

component elements.

Component data element A simple data element that belongsto a
composite data el ement. Component data
elements are also called sub-elements.

envelope A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and a trailer segment, which separate the envel ope from other
envel opes and provide information about the contents of the envelope.

There are three levels of envelopes, asfollows:

» Transaction Set
Each transaction set (business document) is contained within a transaction set
envelope.

» Functiona Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

» Interchange Envelope
All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term Transmission
Envelope to refer to this level of envelope. Since we use the term transmission for
other uses, we refer to Interchange Envelope only.

Note

A communications session could easily include a number of interchange envel opes. For
thisreason, the standards-setting bodies are considering afourth level of envelopeto cover
an entire communications session.
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equalize

This function enables you to reinstate the two sides of the map with focusin equal
dimensions. The use of the Equalize function is optional.

This map defines how to move data from the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map.

These rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application file.

A formisaset of instructions you define in the Forms Integration subsystem that indicates
how the system should format data

A frame contains the groups, repeating segments, and elements at that level (single
segments are not represented on the frame). Sterling Gentran: Server uses framesto format
the EDI file for the translation object.

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.

A looping structure that contains related records/segments and/or groups that repeat in
seguence until either the group data ends or the maximum number of timesthat theloopis
allowed to repeat is exhausted. If you create agroup that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (aloop within aloop). The
application (positiona) file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and sub-groupsin Sterling Gentran: Server.
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import trandation
object

In Documents
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Glossary

This command enables you to import datafrom an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map.

This Sterling Gentran: Server browser contains alist of documentsthat the system received
but that have not yet been processed by the user. Once the documents are processed
(printed or exported) the documents are transferred to the In Drawer.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To trandate
inbound data, you need to create an export map.

This Sterling Gentran: Server browser contains a list of documents that were received and
processed.

An integer is a number that has an implied decimal point (e.g., “2.01” isformatted as
“ 201”).

Theinterchange contains all the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.

This Sterling Gentran: Server browser enables you to view a hierarchical list of all the
interchanges that were sent or received. It contains status information about the
interchanges, (e.g., whether or not a functional acknowledgement was received and the
status of that acknowledgement). This browser also enables you to access the documents
within the interchanges. The I nterchanges browser can always be accessed.

The Layout Window contains the actual format of the translation object. Each group (with
amaximum usage greater than one) and repeating segment has a corresponding frame in
the Layout Window. When you click a segment or group in the EDI file format, the
corresponding frame is displayed in the Layout Window. When you click an element in
the EDI file format, the corresponding layout component is highlighted in the Layout
Window.
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list

literal constant

|location table

lookup table

loop count

loop start/loop end

map

networ k

number

ODETTE

list

A list displaysalist of choices. Scroll bars are provided if there are more choices than can
fit in the box.

These are used by the system as arepository to store information that is used at alater
point in the map. Typically, constants are used in an outbound map to generate a qualifier.

Thisisatable created in Partner Editor that is used to contain address-related information
about the partner.

Thisisatable created in Partner Editor that is used to select information related to avalue
in inbound or outbound data.

This standard rule enables you to count the number of times aloop is repeated, if the
element or field is part of aloop. If theloop isanested loop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the“3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LSand LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map isinbound or
outbound, you need to define the LS and LE segments for the loops you are using in the
map in one of two different ways.

A set of instructions you define in the Application Integration subsystem that indicates the
corresponding relationship between your application file and the EDI standards, and
defines how the system should trand ate data.

Also known as a Third Party Network or VValue-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for a trading partner to accept
them.

Thistype of field or element contains either an integer or real number. If you specify that a
field or element isanumber type, you must designate the format by specifying aformat of
either “N” (integer) or “R” (real) and the number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.
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Glossary

This Sterling Gentran: Server browser contains alist of documents that are ready to be
sent. After the documents are successfully sent, they are automatically transferred to the
Out Drawer.

The system trandlates your application file format to EDI standard formats, so you can
send documentsto your partners. To translate outbound data, you need to create an import
map and a system import map in the Application Integration subsystem.

This Sterling Gentran: Server browser contains alist of documents that were successfully
sent out by the system.

Another firm with which your company trades documents. Also referred to as atrading
partner.

This Sterling Gentran: Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file.

This Sterling Gentran: Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On adataentry translation object, adefault value for aparticular element. You can change
the value as necessary.

Thisis produced when data received from atrading partner passes through a print
trand ation object. You do not have to actually print the data. The printout could beto afile
on your hard disk.

A print trandation object organizes and formats the printout of EDI documents that are
received from or sent to the trading partners for which you have established a trading
relationship (inbound or outbound) that utilizes that print translation object. The print
tranglation object enables you to view the EDI document in an easily readable format.

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran: Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.
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qualifier

Thisisan element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01" isformatted as “2.01"), and
truncates trailing zeroes.

This Sterling Gentran: Server function enables you to manually initiate a communications
session to receive data from a network through an invocation of the Connection Manager.

Contains agroup of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A isinvalid unless Field B is present. Therefore, if you set up a condition
that pairs Fields A and B, the system generates a compliance error if one of thosefieldsis
not present.

This Sterling Gentran: Server function enables you to create a turnaround document (using
the Turn Around translation object in the partner relationship) in response to one or more
selected documents in the In Drawer.

An organization that develops and updates standards for EDI communications. These
organizationsinclude ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

A screen entry trandation object provides a standardized format for keying an EDI
document into the Document Editor, for translation and transmission to your trading
partners, for which you have established an outbound trading relationship that utilizes that
screen entry translation object. The screen entry translation object ensures that your users
key all the data necessary to create the required EDI document.

A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someoneto tell if theitem iswhat is desired, whether the priceis reasonable, etc. A
number of segments together form a transaction set.
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Glossary

This standard rule enables you to select entries from alocation table, cross-reference table,
partner table, or lookup table (all tables created in the Sterling Gentran: Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the value of the current field to perform the selection.

This Sterling Gentran: Server function enables you to manually start a communications
session to send data to a network through an invocation of Connection Manager. Only
selected documents are enveloped and sent. If no documents are selected, ALL documents
are sent. Successfully sent documents are moved to the Out Drawer.

See Transaction Set.

Seelink.

This function enables you to split (break) a group or repeating segment into two loops.
You typically use this function when you need more than one instance of the same map
component that still occurs multiple times.

These rules give you access to functions that are necessary for mapping operationsthat are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

Static text istext that is alwaysincluded in the screen entry or print trandation object.
Examples of static text include legends and column headings. Field labels, which usually
accompany fields to identify the contents of the fields, are not considered static text.

The status bar of an application window defines information about a sel ection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “ Caps Lock” key or NUM
for the “Num Lock” key, etc.).

Thistype of field or element contains one or more printable characters. If you specify that
afield or element isastring type, you must designate the format by specifying a syntax
token.
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syntax token

This function enables you to designate a“token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format lists located on the Validation tab of the Element
Properties dialog. This enables you to define what type of characters should be used while
compliance checking each element/field (i.e., al phanumeric within a certain range,
numeric within a certain range).

The tranglator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document. You need a system import map that is
defined in EDIMGRL.INI to translate outbound data.

See system import map.

These trandl ation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Sterling Gentran: Server system.

See EDIA.

TDF isthe Transaction Data File. Thisfile serves as afilter between your document files
and the Sterling Gentran: Server trand ator. For outbound processing, dataisimported from
aTDFfileand translated to EDI format using a TDF Import translation object. The datais
then ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Sterling Gentran:Server can be exported to a TDF-
formatted file using a TDF Export translation object. This datafileisthen ready to be
processed or converted to your internal application files.

See Network.

The U.K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

Another firm with which you company trades documents. Also referred to as a partner.
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transaction set (document) Glossary

transaction set A business form as defined by the standards. Examples include an ANSI 850 purchase
(document)  order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and el ements that make up the form, the order in which they appear, and the

relationships among them. Thisis also known as “message” in Europe.

trandation object A predesigned layout set up to ensure that input or output for a particular transaction set
existsand is presented in a usable fashion. You must specify which trand ation objects are
used by each partner relationship.

Inbound Translation Objects:

Turn Around: Thistranslation object is used when adocument is received, to create the
natural response document that contains as many el ements from the received document as
possible.

Export File: Thistranslation object indicates that when a document isreceived, it is
exported to a specified file format.

Print: Thistrandation object is used to print documents.

Outbound Translation Objects:

Import: Thistranslation object is used to import data from an application file.
Print: Thistrandation object isused to print documents.

Data Entry: Thistranslation object is used to enter datainto the Document Editor facility.

trangdator Thisisthe engine that processes data for the Sterling Gentran: Server, Application
Integration subsystem and Forms Integration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

turnaround A document into which data elements from the source document have been automatically
document  transferred using aturnaround map.

turnaround map A seriesof instructions that the system uses to create a turnaround document (alogical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elementsin the target document (translation object).

UCS  The Uniform Communications Standard is the standard used by the grocery industry.
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Glossary update

update  Thisstandard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format typeis
EDI), with the contents of the element or field.

Note

Please note that this function updates the internal Sterling Gentran: Server database tables.
We recommend that you use this function only if you are sure you really want to update
the internal database tables.

Typically, you only use this function if you want to update the document name and
reference in the document table. Any other use of this function could have disastrous
consequences!

use accum This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

usecode  Thisstandard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error is generated if the element or field does
not contain one of the values in the code table, and store a code's description in another
element or field.

user trandation These trandlation objects control data entry, importing, exporting, document turnaround,
object and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.

version Each standards-setting body updatesits standards on aregular basis. Each formal updateis
referred to asaversion.

VICS  TheVoluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

Workspace  This Sterling Gentran: Server browser contains alist of outbound “Work in Progress”
documents. It also contains recently imported or data entry documents.

X12  The ANSI committee that sets and publishes standards for EDI.
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